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12	Understanding 
Usability and 
Accessibility

In this chapter, you will learn how to
✔✔ Implement a user-centered design methodology.
✔✔ Establish user and compatibility requirements.
✔✔ Design a prototype.
✔✔ Define accessible branding.
✔✔ Test for usability.
✔✔ Understand accessibility legislation and testing.
✔✔ Maintain legislation compliance.

Most companies today consider usability and accessibility to be essential ingredients in a 
successful SharePoint project. Of course, a chapter of this size cannot go into great depth 
about either of these subject areas, but it will provide you with information about what 
you need to consider. Each project and SharePoint site is different, and you will need to 
research and decide on policies that suit your situation.

In this chapter, you first explore how to implement a user-centered design methodology 
and learn about the benefits of implementing usability and accessibility best practices. 
The rest of the chapter demonstrates how you can apply a user-centered design life 
cycle to your project. You will learn how to translate and apply usability and accessibil-
ity methods to the Microsoft SharePoint environment and how Microsoft SharePoint 
Designer 2010 can help you. You will learn how to establish user and compatibility re-
quirements, design a prototype, define accessible branding, and test for usability. You 
will then learn about accessibility legislation and how to test for accessibility, and finally, 
you will learn how to maintain your compliance with legislation.

You should apply the methods described in this chapter throughout the lifetime of any 
customizations or modifications you make to your site. Usability and accessibility are 
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very important to the success of your customizations, and conforming to accessibility 
legislation could save you or the company owners from being sued.

Practice Files  Before you can use the practice file in this chapter, you need to copy 
the book’s practice files to your computer. The practice file you will use to complete 
the exercises in this chapter is in the Chapter12 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.

Implementing a User-Centered Design Methodology
At the center of usability and accessibility considerations are people, the prospective 
users. A growing number of companies now implement a user-centered design (UCD) 
methodology within a SharePoint project’s life cycle to ensure that the site’s design and 
development are focused on the end users throughout.

UCD methodology ensures that a site meets all user requirements by engaging users at 
every stage in its life cycle. The four stages of the life cycle are:

●● Researching, conceptualizing, and planning (establishing user and compatibility 
requirements)

●● Designing a prototype

●● Defining the branding (with accessibility in mind)

●● Developing, launching, and testing (testing for usability and accessibility)

The figure below shows that feedback from users should be gathered at all four stages. The 
more often you obtain and integrate user feedback into your project life cycle, the better.
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There is a strong overlap between usability and accessibility, and while many of the is-
sues that users might encounter in using and accessing your Web site efficiently and 
effectively can be addressed by implementing a user-centered design methodology, leg-
islation related to the accessibility of Web sites needs to be met and taken seriously.

In a number of court cases worldwide, companies and organizations have been sued for 
producing inaccessible Web sites. One of the most prominent cases involved the Web 
site for the 2000 Summer Olympics in Sydney, Australia. A site’s conformance to relevant 
accessibility guidelines is commonly deemed to be a measure of the site’s accessibility. 
The message from governments worldwide, however, is that ultimately, disability leg-
islation is in place to protect the individual. Therefore, best practice dictates that a site 
should not only conform to accessibility guidelines, but also that disabled users should 
be included in the site’s development life cycle and, at the very least, in the testing 
processes.

Implementing usability and accessibility best practices primarily ensures that any mem-
ber of your audience—regardless of disability, age, software, and device—can efficiently 
and effectively use your Web site. However, provisioning usable and accessible solutions 
has a wealth of additional benefits as well.

If you do not have any internal policies with regard to usability and accessibility, a num-
ber of online resources are available that can help you develop them. At a minimum, you 
should start to document any procedures you carry out and then further develop your 
policies over time.

Tip  Two useful resources detailing the wide range of benefits to both business and society 
of investing in usable and accessible technology solutions are the online report “Accessible 
Information and Communication Technologies, Benefits to Business and Society,” from 
the U.K.’s OneVoice for Accessible ICT Coalition (published in 2010 and available at www.
onevoiceict.org) and “Developing a Web Accessibility Business Case for Your Organization,” 
from the World Wide Web Consortium (W3C), at www.w3.org/WAI/bcase/.

The rest of this chapter demonstrates how SharePoint Designer 2010 can help you apply 
a UCD methodology and usability and accessibility methods to your SharePoint project.
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Establishing User and Compatibility Requirements 
The first stage in the user-centered design life cycle is researching, conceptualizing, and 
planning. In essence, this means establishing the requirements for your Web site and all 
its prospective users. User requirements is a broad term, and it should initially include 
research to determine any accessibility requirements and the platforms, browsers, and 
devices that you want your Web site to be compatible with.

User requirements should then be established in line with business requirements so that 
you can conceptualize and plan your Web site and determine the scope of its usage and 
the functionality required. User-requirement documents generally involve the use of 
personas, usage scenarios, or use cases.

To take one example, personas can be as detailed as you like, but generally, when creat-
ing a persona, you should look to include the following information about a user:

●● Name, age, and role within a company (if applicable); for example, team leader

●● Level of IT competence; for example, ten years of experience with IT/Web sites

●● IT requirements; for example, uses a PC with the Internet Explorer 8 browser

●● Specific requirements; for example, visually impaired and uses browser zoom 
functionality

●● Usage scenario(s) for the system; for example, a team site contributor who produc-
es content on a weekly basis

Tip  A number of useful resources about creating personas are available on the Internet. Two 
good articles can be found at www.nytimes.com/2009/07/19/automobiles/19design.html?_r=2 
and www.themonitor.eu/content/?p=33.

The step of producing a persona can be carried out on paper or in relevant modeling 
tools, such as Microsoft Word, Microsoft Visio, or Microsoft PowerPoint. You can create 
one or numerous personas. An example is shown in the following illustration.
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SharePoint Designer can assist you in determining which browsers your Web site should 
be compatible with. It provides several tools that can give you a better understanding of 
browser compatibility and the potential work involved in making your site accessible to 
users on a wide range of browsers.

On the Home tab, you can click the Preview In Browser down arrow in the Preview group 
at any stage in your development. SharePoint Designer provides you with a number of 
options for browsers and screen resolutions in which you can preview your Web site. This 
list of browsers can be expanded by clicking Edit Browser List. You can then add browsers 
and screen resolutions of your choice. Ideally, throughout the life cycle of development, 
you should test the compatibility of your Web site with the browsers and screen resolu-
tions used by your target users.



406    Chapter 12  Understanding Usability and Accessibility

The preview functionality in SharePoint Designer is a great mechanism for checking how 
your Web site will look in different browsers. However, SharePoint Designer also provides 
a mechanism by which you can check the compatibility of your code and/or your cascad-
ing style sheets (CSS) with the browsers, <!DOCTYPE>, or CSS standard of your choice. 

Like any browser, SharePoint Designer by default uses the HTML/XHTML and cascading 
style sheet (CSS) schemas defined in the <!DOCTYPE> tag on the first line of the master 
page when deciding how to render a page. When you edit or modify a page, SharePoint 
Designer flags code that is invalid or incompatible, depending on the schemas defined 
in the <!DOCTYPE> tag. If a page doesn’t contain a <!DOCTYPE> declaration, it uses the 
default schemas configured in the Page Editor Options dialog box.

When you use the compatibility checker, you can specify the same or a different schema 
to produce the compatibility reports.

In this exercise, you use the SharePoint Designer Compatibility task pane to help test the 
compatibility of your Web site.

SET UP  Using SharePoint Designer, open the team site you created and modified in 
earlier chapters. If you did not yet create a team site, follow the steps in Chapter 1.

1.	 In the Navigation pane, click Site Pages. Verify that Home.aspx is selected, and 
then on the Pages tab, click Edit File in the Edit group.

The home page opens in edit mode.

2.	 Click the View tab, click the Task Panes down arrow in the Workspace group, and 
then click Compatibility.

The Compatibility task pane opens at the bottom of the page.

3.	 In the Compatibility task pane, click the Run Compatibility Checker button.

The Compatibility Checker dialog box opens.

Edit File

Task Panes

Run 
Compatibility 

Checker
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Tip  The SharePoint Designer status bar displays the HTML/XHTML and cascading style 
sheet schemas it uses to flag code as invalid or incompatible for a page.

4.	 Under Check where, click Open page(s), and then click Check. 

The Compatibility Checker dialog box closes. The Compatibility task pane displays 
the results of the compatibility check.

5.	 In the workspace, click Code to display the Home.aspx page in Code view.

In the SharePoint Designer status bar, an “incompatibility code” icon appears.

Tip  The incompatibility code icon appears only if you have the page open in Split view 
or Code view. If the page also contains code errors, you will see the code error icon in 
the SharePoint Designer window.

CLEAN UP  Close the Compatibility task pane. Leave SharePoint Designer open if you 
are continuing with the other exercises in this chapter.  



408    Chapter 12  Understanding Usability and Accessibility

Designing a Prototype
Designing a prototype is the second stage in the user-centered design life cycle and 
involves defining a site’s information architecture (IA). The IA defines the relationships 
between individual pages—the navigation—and the relationships between internal page 
elements—the user interface (UI). At this stage, you should also start to consider which 
SharePoint templates to use for your content, such as a team site or a wiki page.

When organizing and structuring your Web site, consider carefully how to group the 
information in a logical fashion for your users. This helps you define the navigation struc-
ture, the page structures (UI), and the metadata taxonomy you need to create so that 
users can tag information. This step also assists in defining guidelines about where infor-
mation should be stored and how your search center should be structured. 

See Also  A detailed blog about organizing your information with SharePoint can be found 
at sharepoint.mindsharpblogs.com/Bill/archive/2010/04/02/Organizing-Information-in-
SharePoint-Server-2010.aspx.

The step of defining the relationships between individual pages (or navigation) can be 
carried out on paper or by using a modeling tool such as Microsoft Visio or Microsoft 
PowerPoint. You can create a navigation structure similar to the following.

Home Home

Company
Overview Executives Org Charts Press

Releases

Products

Product 1 Product 2 Product 3 Product 4

News and
Events

News Events Press
Releases

Support

Support
Request

Intranet
Login

Office
Hours Contact

Blog
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Tip  Card sorting is a powerful technique for assessing how people group related concepts. 
Card-sorting workshops are a great way to involve end users in designing the navigation for 
a site. There are numerous resources on card sorting on the Internet. These sessions are also a 
great way to perform housekeeping on content if your development involves migrating from 
another application.

When you are defining the relationship between internal page elements (the UI), estab-
lish those elements that will appear sitewide and be contained on a master page—such 
as the banner and navigation menus—and those that will occur within content areas and 
be contained in the layout, such as Web Parts. This step helps determine whether you 
need to customize or build any new master pages or layouts for your Web site.

You can carry out this step on paper or in tools such as Microsoft Visio or Microsoft 
PowerPoint. You can create a number of screen designs, such as the wireframe example 
shown here.

After the IA is established and designed, you can easily build a concept prototype. The 
concept prototype might be as simple as a low-fidelity paper-based version, or you can 
create a more advanced interactive version using wireframe production software or de-
velop a version in SharePoint.
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Tip  Ideally, user testing should be carried out at all stages of production. You can test using 
early paper-based prototypes and early developed prototypes, with feedback influencing 
further design and development. It is much easier to rectify problems with the design early on 
than after the site is well along in development.

Ten-Point Usability Checklist

It is a good idea to keep a ten-point usability checklist handy when you develop 
early prototype designs. SharePoint inherently considers standard usability heuris-
tics such as the following, which were defined by Jakob Nielsen. However, it is also 
a good idea to bear these in mind when you are customizing your development.

	 1.	 Visibility of system status  On every page, inform users of what is happen-
ing at any given point within a reasonable time. For example, include a bread-
crumb to show where a user is on the site, or show a progress bar to indicate 
what action is taking place.

	 2.	 Match between system and the real world  Use words, phrases, and con-
cepts that are familiar to users. For example, the terms home and sitemap 
have a direct relationship to real-world concepts.

	 3.	 User control and freedom  Allow users to change their mind or easily exit 
any functionality they have accessed by mistake.

	 4.	 Consistency and standards  Use master pages, layouts, and CSS correctly to 
ensure that your Web site has a consistent look and feel and a consistent place-
ment of elements. Be sure that words and actions always mean the same thing, 
and that the site conforms to accessibility and other compliance standards.

	 5.	 Error prevention  Design carefully to prevent an error from occurring in the 
first place. Early user testing can establish any potential errors and point to 
how to prevent them.

	 6.	 Recognition rather than recall  Minimize the user’s memory load by making 
as many elements, actions, and options as possible visible without cluttering the 
screen. Make sure that any instructions or guidelines for use are obvious.

	 7.	 Flexibility and efficiency of use  Cater to both novice and experienced us-
ers. Give experienced users the option to complete tasks more efficiently; for 
example, provide them with keyboard shortcuts.

	 8.	 Aesthetic and minimalist design  Keep page design clean and content un-
cluttered. Users tend to scan online material, and certain users (such as peo-
ple with dyslexia) require paragraphs to be kept to a minimum length, with 
plentiful space between lines and paragraphs.
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	 9.	 Help users recognize, diagnose, and recover from errors  Express error 
messages in plain language, precisely indicate the problem, and construc-
tively propose a solution. 

	 10.	 Help and documentation  Make sure any Help system and documentation 
are easily available, focus on user tasks, offer steps as a solution, and are not 
too lengthy. In addition to the standard SharePoint Help text and documen-
tation, you might consider providing more contextual help on your Web site 
screens.

Defining Accessible Branding
The third stage in the user-centered design life cycle is defining your branding, ensuring 
that it is accessible. As mentioned in Chapter 10, “Branding SharePoint Sites,” the extent 
to which you brand your SharePoint development will vary depending on the size of 
your project. A simple branding exercise can take as little as two days; extensive brand-
ing to comply with accessibility and company guidelines can take months and lead to 
alternative Web site versions branded specifically for dyslexics and/or for high contrast.

Regardless of the extent of your branding, there are some basic exercises you can carry 
out to ensure that your branding is accessible. Primarily you need to make certain that 
your branding is accessible to those with a visual impairment—be that poor vision or 
color blindness. Most countries have laws similar to the U.K.’s Disability Discrimination 
Act (DDA) 1995, that state that companies that provide services must make a reasonable 
adjustment for people with disabilities. Companies are used to meeting these obligations 
by providing correspondence in Braille, large print, or other formats. However, many for-
get about their Web sites. Although SharePoint Designer does not provide a mechanism 
that lets you check whether branding is accessible to those with a visual impairment, the 
Internet can assist with sites such as Vischeck (www.vischeck.com/vischeck/ ).

When you brand your Web site, you’ll find that certain color schemes work better to-
gether than others. Just as you would take care to color-coordinate the rooms in your 
house, so you should choose colors for your Web site carefully. SharePoint Designer pro-
vides you with a color wheel similar to the one that you might have used in home deco-
ration. Colors opposite each other on the wheel work better together than those that 
are next to each other. This is known as the complementary color scheme. Similarly, colors 
from points of an equilateral triangle—the triadic color scheme—are also a good choice. 
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However, the computer color wheel is different from the home decoration color wheel. 
Web colors viewed on monitors and flat screens are defined in hexadecimal notation 
combining red, green, and blue (RGB) color values. The World Wide Web Consortium 
(W3C) provides 16 standard color names to refer to certain hexadecimal values.

In the past, not all browsers or screen devices produced the same color when render-
ing these hexadecimal values or color names. Therefore, a cross-browser color palette 
with 216 colors was produced, known as the Web-safe color palette. The color wheel 
you see in SharePoint Designer is based on this color palette. When you click the color 
wheel in SharePoint Designer, look at the hexadecimal values it produces. You will see 
hexadecimal values of only 00, 33, 66, 99, CC, and FF. In other words, you will see values 
of #CCFF00, #669900, and #00FFFF—not #887722, #FD3798, and #4400FF. Technology 
has improved, however, and now you can choose colors that are not from the Web-safe 
color palette, which means that SharePoint Designer provides you with an alternative 
method of choosing colors from the whole hexadecimal range.

In this exercise, you identify colors on the SharePoint Designer Web-safe color palette 
and check the suitability of a color scheme.

SET UP  Using SharePoint Designer, open the site you used previously in this chapter 
if it is not already open. The Home.aspx page should be shown in edit mode in 
Design view.

1.	 On the View tab, click Task Panes, and then click CSS Properties.

The CSS Properties task pane opens.

2.	 In the workspace, click some text within the PlaceHolderMain region, and in the 
CSS Properties task pane, under CSS Properties, click the cell to the right of 
background-color. Then click the arrow that appears, and click More Colors.

The More Colors dialog box opens, displaying a Web-safe color wheel. The color 
selected for the background color is bordered in white on the wheel, and the Value 
text box contains Automatic or the hex values of the background color’s red, green, 
and blue color coordinates.

Task Panes



	 Defining Accessible Branding    413

3.	 In the More Colors dialog box, click Custom.

The Color dialog box opens. The hue, saturation, and luminance color coordinates 
are displayed, together with the red, green, and blue coordinates.

4.	 Click Cancel twice to close the Color and More Colors dialog boxes.
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5.	 Open a browser, and in the Address bar, type http://gmazzocato.altervista.org/
colorwheel/wheel.php to open the Accessibility Color Wheel page.

6.	 Under the Normal section, in the 1* box, type #0000ff, and in the 2* box, type 
#ff33cc. Click Update.

The text and background colors of the Normal, Deuteranope, Protanope, and 
Tritanope text areas change to reflect how the color scheme looks to people who 
have visual impairments. The contrast ratio in each area is updated, which you can 
check to see whether it meets relevant accessibility guidelines.

CLEAN UP  Close the browser. Close the CSS Properties task pane. Leave SharePoint 
Designer open if you are continuing to the next exercise.

Testing for Usability
Developing, launching, and testing is the fourth and final stage in the user-centered 
design life cycle. At this stage you might already have a fully functioning prototype de-
veloped using SharePoint. If your prototype is a low-fidelity paper-based version or a 
more advanced interactive version using wireframe production software, you will need 
to translate your information architecture and branding into the SharePoint environment 
of master pages, layouts, CSS files, and imagery.



	 Testing for Usability    415

At this stage, this conversion should be relatively easy because you have already estab-
lished the IA, including the navigation structure and the UI design for the elements to 
be used (their placement within master pages and layouts). You will, however, need to 
decide whether the out-of-the-box master pages, page layouts, and CSS files meet your 
requirements or whether you need to customize these elements or build your own. 

See Also  Information on how to customize or change a master page is described in Chapter 
11, “Working with Master Pages,” and information on how to brand your SharePoint site is 
described in Chapter 10, “Branding SharePoint Sites.”

Once your Web site is developed and launched, it needs to be tested for usability and 
accessibility. Usability testing is a key step in ensuring that your users can successfully use 
your SharePoint Web site. Accessibility testing should be taken seriously given that your 
company could be sued for presenting an inaccessible Web site. More information and 
methods for addressing these processes are covered in detail in the next sections.

Depending on the size of your project, you can carry out usability testing in a number of 
ways:

●● Study users who perform tasks based on usage scenarios or use cases developed 
in stage 1 of the UCD life cycle, and then document any issues the users have using 
the Web site.

●● Use in-house/expert testers who test sample parts of the system and document any 
issues. Normally these parts are the most frequently used or are critical to the suc-
cess of a project. Distribute your budget for user testing across as many small tests 
as you can afford, with no more than five users per test.

●● Test a representative page from each SharePoint template. 

Usability testing will highlight any usability problems with your site, such as broken links; 
poor navigation design; problems with rendering in different browsers, at different 
screen resolutions, or with devices such as smart phones; and forced scrolling (the user 
should never be forced to scroll right). Ideally, usability testing should be carried out dur-
ing the life cycle of your development.

In this exercise, you use the SharePoint Designer Hyperlinks task pane to help test the 
usability of your Web site. In particular, you’ll test whether the information architecture 
has any broken links.
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SET UP  Using SharePoint Designer, open the site you used in the previous exercise if 
it is not already open. To complete this exercise, you need the practice file Index.aspx 
in the Chapter12 practice file folder.

1.	 In the Navigation pane, click Site Pages, and then on the Pages tab, click Import 
Files in the Manage group.

The Import dialog box opens.

2.	 Click Add File. In the Add File to Import List dialog box, select the practice file 
Index.aspx, and click Open.

The Add File To Import List dialog box closes, and Index.aspx is listed in the Import 
dialog box, with a URL of SitePages/Index.aspx.

3.	 Click OK. The Import dialog box closes.

4.	 With Index.aspx selected, on the Pages tab, click Edit File. On the View tab, click 
Task Panes, and then click Hyperlinks.

The Hyperlinks task pane opens at the bottom of the page. A list of any broken 
links appears in the task pane. 

Tip  At the bottom of the task pane you can see how many of these broken links are 
internal links and how many are external links.

5.	 Double-click (or right-click and click Edit Hyperlink) any of the broken links listed 
within the task pane, such as http://spfbroken.wideworldimporters.com in the 
page SitePages/Index.aspx.

The Edit Hyperlink dialog box opens. 

Import Files

Edit File
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6.	 In the Replace hyperlink with box, type http://www.microsoft.com. If you do 
not have Internet access, type a valid internal URL for your organization.

Tip  You can change the location of the hyperlink in all pages or just selected pages.

7.	 Click Replace. The Edit Hyperlink dialog box closes.

8.	 Click the red tick and link symbol in the left pane with the ScreenTip Verifies hy-
perlinks in the current web.

The Verify Hyperlinks dialog box opens.

9.	 With Verify only unknown hyperlinks selected, click Start.

The Verify Hyperlinks dialog box closes. A green check mark appears to the left of 
the hyperlink http://www.microsoft.com.

Verify 
Hyperlinks
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Tip  The hyperlinks do not have to be broken for you to use the Hyperlinks task pane to 
replace hyperlinks. This can be a very useful method of completing a global change of 
one URL address with another.

CLEAN UP  Close the Hyperlinks task pane. Close Index.aspx, and leave SharePoint 
Designer open if you are continuing to the next exercise.

Understanding Accessibility Legislation and Testing
Most of the world’s countries have accessibility legislation, which you need to meet 
if you publish public Web sites and/or internal Web sites, especially for government 
departments and educational institutions. Two examples of such legislation are the 
U.K.’s Disability Discrimination Act (DDA) 1995 and Section 508 of the United State’s 
Rehabilitation Act.

In many situations, should a court case take place, the level of conformance to relevant 
accessibility guidelines will be taken into consideration. Two of the most prominent 
guideline documents are the Web Content Accessibility Guidelines (WCAG) from 
the W3C (now version 2.0) and the U.S. government’s Section 508, Voluntary Product 
Accessibility Templates (VPATs). 

Microsoft is active in producing VPATs to show how its software products meet key regu-
lations of Section 508 and also encourages harmonization of Section 508 with WCAG 
2.0. Microsoft joins the European Commission in the view that only common accessibility 
standards will ensure compatibility and interoperability of technologies.

Most importantly, SharePoint 2010 now has a prime focus on meeting European guide-
lines and makes it far easier than previous versions of SharePoint for you to meet WCAG 
version 2.0 A, AA, and even AAA guidelines. The improvements in SharePoint 2010 
include: 

●● A W3C XHTML <!DOCTYPE> reference.

●● Use of <div> tags for page construction rather than tables.

●● Correct heading hierarchy—that is, H1, H2, H3.

●● The UseSimpleRendering property for the <SharePoint:AspMenu> control, which is 
used in SharePoint to dynamically create the navigational elements on a page, such 
as the top navigation tabs. When UseSimpleRendering is set to True, the SharePoint 
navigation menu is rendered in the browser using a cleaner, unordered XHTML list.
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See Also   Microsoft’s conformance statement to WCAG 2.0 for SharePoint Server 2010 can be 
found at technet.microsoft.com/en-us/library/ff852108.aspx.

Conformance to accessibility guidelines, in turn, helps ensure that your Web site will be 
compatible and interoperable with any assistive technologies that your prospective audi-
ence might use. Still, when testing for accessibility, you should ideally test against acces-
sibility guidelines and with the assistance of disabled users. 

See Also  The W3C’s Web Accessibility Initiative (WAI) provides a great resource for all 
applicable laws and policies regarding Web accessibility for 20 or so countries. See www.
w3.org/WAI/Policy/. The W3C also provides a free online markup validation service, currently 
residing at validator.w3.org.

From stage 1 of the UCD life cycle, any accessibility requirements for users should be 
known. Testing against guidelines and these requirements alone is ample provided that 
you are confident you have covered your target audience. For example, if your Web site 
is on an intranet, you should have recognized any accessibility requirements for users in 
your company. Ideally, it is individuals like these, with specific accessibility requirements, 
that should be included in the user group that tests your Web site.

However, in addition to conforming to accessibility guidelines, any public Web site needs to 
take into consideration the wide range of potential accessibility requirements from its pro-
spective audience. The real test of the accessibility of your Web site will always be to have 
as many people as possible test the site—those with different platforms, browsers, and de-
vices, and those with varying disabilities using assistive technologies such as the following:

●● Mouth sticks 

●● Specialist keyboards or the keyboard only 

●● Screen readers 

●● Voice recognition software

To better understand the experience of users making use of these assistive technologies, 
you can carry out the following steps:

●● Utilize SharePoint’s more-accessible mode by pressing the Tab key immediately 
after placing focus on the page in a browser. More-accessible mode is particularly 
beneficial for users of mouth sticks. Dynamic menus are converted to static menus 
that make the links much easier to locate with the end of the stick. 

●● Use your Web site with the keyboard only. This highlights for you any areas that 
are inaccessible, problematic, or create a keyboard trap where the user is unable to 
proceed.
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●● Download a trial version of screen-reader software and use it with your Web site. 
Freedom Scientific always offers a download of the widely utilized screen reader 
JAWS in a 40-minute demo mode, and many modern platforms have screen reader 
software incorporated. Turn off your monitor while using it to truly understand 
how a user who is blind would use your Web site.

●● Download a trial version of voice recognition software, and use it with your Web 
site. One of the most popular is Dragon voice recognition software. 

There are many ways you can assist disabled users in using your Web site with assistive 
technologies. Good practice is to start by creating a prominent accessibility statement 
on your Web site (you’ll find many examples on the Internet) that explains to users the 
accessibility considerations you have made. Include the advantages of more-accessible 
mode, and describe any issues you are aware of. Always provide users with contact infor-
mation in case they have any problems accessing or using your site in any way.

Ten-Point Accessibility Checklist

It is a good idea to keep a ten-point accessibility checklist handy when you are 
developing your Web site. The ten points below are based on W3C Web Content 
Accessibility Guidelines version 2 and will go a long way in making your Web site 
accessible to as many people as possible. Ideally, all checkpoints within W3C WCAG 
version 2 should be met during development.

When developing your Web site be sure of the following:

	 1.	 Font sizes are set to ems in the CSS  Users who need to can change the text 
size in a browser. Fixed pixels and points will not allow this, but many modern 
browsers allow users to take advantage of zoom functionality.

	 2.	 All images have alt text  Users who have images turned off or users of 
screen readers will be able to understand the image purpose and description.

	 3.	 Font size/spacing is easy to read  Users want to digest information quickly 
and easily. Keep sentences, line length, and paragraphs short and well spaced.

	 4.	 Adequate text to background contrast  Users with different vision levels, in-
cluding color blindness, and users with different monitors with varying graph-
ics cards will be able to read your Web site easily.

	 5.	 Pages are well structured  Users who turn off CSS or who use screen readers 
or mobile devices will have content presented in the correct sequence.
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	 6.	 A sensible tab index and access keys  Users using only the keyboard will be 
able to access all functionality through a keyboard efficiently. Custom-built 
access keys (such as those recommended by governments worldwide) will 
greatly assist keyboard users with shortcuts to information on a page.

	 7.	 An ability to bypass blocks  Out of the box, SharePoint provides users with 
the ability to use Skip To Main Content, allowing keyboard or screen reader 
users to bypass any navigation elements.

	 8.	 Link purpose is clearly defined  Screen-reader users especially will find the 
site easier to use if the purpose of each link can be determined from the link 
text alone. Also, keep the number of links on the page to a minimum to fur-
ther assist users working with voice recognition software.

	 9.	 Clear titles, headings, and labels  All users will better understand the con-
tent structure.

	 10.	 Valid code  All users will find the site more usable and accessible if the 
HTML/XHTML is valid against W3C standards.

In this exercise, you use the SharePoint Designer Accessibility task pane to help test the 
accessibility of your Web site.

SET UP  Using SharePoint Designer, open the site you used in the previous exercise if 
it is not already open. Open Index.aspx in edit mode. (You imported Index.aspx into 
Site Pages in the previous exercise.)

1.	 On the View tab, click Task Panes, and then click Accessibility.

The Accessibility task pane opens at the bottom of the workspace.

2.	 Click the green arrow at the top of the left pane, which reads Run Accessibility 
Checker.

The Accessibility Checker dialog box opens.
Run Accessibility 

Checker
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3.	 Under Check where, click All pages. Under Check for, ensure that WCAG Priority 
1 is selected, and clear the WCAG Priority 2 check box. Under Show, leave the 
Errors check box selected. 

Tip  You can carry out the accessibility check for all pages, open pages, or the current 
page and check against WCAG Priority 1 or 2 or Access Board Section 508. You can also 
choose to show errors, a warning, or a manual checklist.

4.	 Click Check.

The Accessibility task pane displays the results of the accessibility check. 

5.	 In the Accessibility task pane, right-click the first line if it is not already selected, 
and then click the blue circle icon in the left bar with the ScreenTip Show Problem 
Details.

The Problem Details dialog box opens, stating that the image is missing a text 
equivalent, with details on how to correct this error.

6.	 Click Close. The Problem Details dialog box closes.

7.	 In the Accessibility task pane, double-click the first line.

8.	 If Index.aspx is not displayed in Split view, press CTRL+Page Up to display the page 
in both Code view and Design view.

In Design view, the offending image is selected.

Show Problem 
Details
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9.	 Right-click the offending image, and then click Picture Properties.

The Picture Properties dialog box opens.

10.	 Under Accessibility, select the check box, and in the Alternate Text box, type 
Microsoft SharePoint Foundation logo, and then click OK.

The Picture Properties dialog box closes.

11.	 In the Accessibility task pane, right-click the first line, and then click Refresh 
Changed Results.

Tip  You can refresh the changed results by clicking the Refresh icon on the vertical pane 
to the left of the results.

The Accessibility task pane contains one fewer error.

Warning  Any usability or accessibility checker will not find all errors. For example, in 
the Index.aspx page there is white text displayed on a white background. This was not 
highlighted in any of the reports run in this chapter.

Maintaining Legislation Compliance
Creating a usable and accessible Web site is a great start, but it will only remain so if it 
is well maintained. You must always remember that the accessibility improvements in 
SharePoint 2010 are focused on out-of-the-box SharePoint components. If you custom-
ize your environment, the changes you make create the possibility of accessibility errors. 
Furthermore, any content that goes into SharePoint has the ability to create accessibility 
errors—for example, a blog could have images missing alternative text. 

You should take the following actions to maintain the accessibility of your Web site:

●● Carry out periodic checks against accessibility guidelines such as WCAG version 2 
or Section 508 VPATs.

●● Carry out periodic disabled-user testing or use an expert who tests with a wide 
range of assistive technologies.

●● Provide your company’s content editors with guidelines and training about pro-
ducing accessible Web content for blogs and wikis and especially with the Content 
Editor Web Part and rich text editors.

●● Update your accessibility statement as the accessibility of your site improves.

Refresh Changed 
Results



424    Chapter 12  Understanding Usability and Accessibility

In addition to complying with accessibility legislation, you may need to ensure that your 
Web site always conforms to other legislation and regulations. Here are some examples:

●● Copyright  Most Web sites include a copyright notice to prove, if necessary, when 
the material was produced. Web sites might also contain guidelines about the use 
and reproduction of material exposed on their pages.

●● Privacy  Different countries have their own privacy laws, such as the U.K. Data 
Protection Act, the European Commission Directive on Data Protection, and 
Canada’s Personal Information Protection and Electronic Documents Act (PIPEDA). 
Many of these laws can be divided into two types of privacy policies: those con-
cerning data that is readable by humans and those that pertain to machine-
readable data. The W3C has produced some guidelines in this area as part of the 
Platform for Privacy Preferences (P3P) Project.

●● Licensing  Both SharePoint Foundation and SharePoint Server have licensing impli-
cations, which are different if you create intranet, extranet, and Internet Web sites. 
And even though you do not need to purchase SharePoint Foundation, you still 
need to verify that you have the correct licenses in place for Microsoft SQL Server, 
Windows Server, FAST Search Server for SharePoint 2010 (if necessary), and Office 
client software.

See Also  More information on SharePoint 2010 licensing can be found at sharepoint.
microsoft.com/en-us/buy/Pages/Licensing-Details.aspx.

●● Other  You may need to consider other legislation and regulations. For example, 
companies based in the U.K. must include certain regulatory information on their 
Web sites and in their e-mail footers or they breach the Companies Act and risk a 
fine.

See Also  Microsoft InfoPath 2010 browser forms are now compliant with Web Content 
Accessibility Guidelines (WCAG) 2.0 AA and Web Accessibility Initiative—Accessible Rich 
Internet Applications (WAI-ARIA). In addition, InfoPath 2010 browser forms are now fully 
XHTML 1.0 compliant. See office.microsoft.com/en-us/infopath-help/design-an-accessible-
form-template-HA010381869.aspx for more information on designing an accessible form 
template.
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Third-Party Accessibility and Compliance Tools

A number of organizations provide tools to assist with creating and maintaining an 
accessible SharePoint Web site. For example, to assist content editors in creating 
accessible content, HiSoftware and Telerik provide accessible rich-text editors to 
replace the out-of-the-box editor. 

See Also  A useful resource for maintenance is the Web Accessibility Toolbar (WAT) 
found at www.visionaustralia.org.au/ais/toolbar/.

HiSoftware is a Microsoft Gold partner that provides Compliance Sheriff, a product 
that includes a workflow integrated into SharePoint, which you can use to verify 
content as it goes in the system. Business decisions can be made with this work-
flow, such as rejecting noncompliant content or passing the content to a person in 
the organization who is focused on remediating content so that compliant content 
can be posted.

Compliance Sheriff also allows organizations to develop, implement, and monitor a 
proactive strategy for compliance with accessibility guidelines and for preventing, 
detecting, and/or managing inappropriate content, such as personally identifiable 
information (PII), personal health information (PHI), and secure sensitive informa-
tion (SSI or OPSEC), that flows through the system.  

In addition, the company provides the Accessibility Foundation Module (AFM) to 
assist with the creation and maintenance of an accessible Web site infrastructure 
(including Web Parts and custom code). The most significant advantage of AFM is 
the enterprise-friendly installation method that allows a SharePoint server admin-
istrator to easily apply a master configuration to multiple SharePoint applications. 
AFM allows you to build a SharePoint environment that meets WCAG version 2.0 
guidelines and can also be used to address Section 508 VPATs.

AFM uses techniques that are part of the Accessible Rich Internet Applications 
(ARIA) specification to make SharePoint even easier to use for users of assistive 
technologies. It can be integrated with Compliance Sheriff for SharePoint to allow 
users to create reports before and after its application to demonstrate that content 
has actually improved in compliance. 

By using Compliance Sheriff in combination with AFM to evaluate SharePoint Web 
sites with custom code or custom Web Parts, you have a way to assess and remediate 
your SharePoint infrastructure no matter what configurations have been applied.
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Creating periodic accessibility reports is a great way to keep a record of how the accessi-
bility of your Web site has improved. SharePoint Designer can assist with monitoring and 
recording the accessibility of your Web site.

In this exercise, you use the SharePoint Designer Accessibility task pane to create an ac-
cessibility report.

SET UP  Using SharePoint Designer, open the site you used in the previous exercise if 
it is not already open. Open Index.aspx in edit mode (You imported index.aspx into 
Site Pages in a previous exercise.) Open the Accessibility task pane.

1.	 In the Accessibility task pane, click the Generate HTML Report button.

The Accessibility Report.htm file opens in the document window.

2.	 Close the Accessibility task pane, and then click Design so that the accessibility 
report is displayed the full length of the document window.

3.	 Close Accessibility Report.htm, and if prompted to save changes, click No.

4.	 Right-click the index.aspx tab, and then click Save.

Generate HTML 
Report
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Key Points
●● Be sure that your Web site is both usable and accessible. This not only ensures that 

as many people as possible can use and access your Web site, but also may stop 
your company from being sued. It also offers a wealth of other business benefits.

●● Follow a user-centered design methodology for the design and development of 
your Web site to best ensure that your site is usable and accessible.

●● Keep handy the ten-point usability and accessibility checklists when you are de-
signing and developing your Web site.

●● Generate or enhance in-house policies with regard to usability and accessibility of 
any Web site you produce.

●● Ensure that there is an accessibility statement on your Web site that highlights the 
considerations you have made and provides tips and contact information so that 
anyone who has problems accessing or using the site can get in touch with you.

●● Make use of the tools available to assist you in making your site more usable and 
accessible, from those that assist you with an accessible framework to those that as-
sist you with accessible content.

●● Be sure that all your content editors have guidelines and training with regard to 
creating usable and accessible content.

●● Maintain the usability and accessibility of your Web site by carrying out periodic 
usability and accessibility tests.
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13	Managing Web 
Content in the 
SharePoint Server 
Environment

In this chapter, you will learn how to
✔✔ Create a publishing site.
✔✔ Understand Web content management in SharePoint Server 2010.
✔✔ Understand the page model.
✔✔ Create and modify a page layout.
✔✔ Allow users to rate Web content.
✔✔ Approve a page layout.
✔✔ Restore an earlier version of a page layout.
✔✔ Detach and reattach a page layout.

Web Content Management (WCM) is just one of the features included in the SharePoint 
Server Enterprise Content Management (ECM) area. The WCM feature uses document-
management capabilities to manage pages. This places content pages in a source control 
system so that you can check pages in and out, as well as use the Approval workflow. 
WCM pages are known as publishing pages, which are created from publishing tem-
plates, known as page layouts. SharePoint Server provides a number of publishing 
templates.

In Microsoft Office SharePoint Server 2007, WCM was used to create public-facing 
Web sites and to host companies’ internal sites, also known as portals. However, WCM 
comes in many shapes, from a very structured Web site with strict governance rules to 
sites whose contributors define the structure as the content grows. In SharePoint Server 
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2010, a new publishing site template is available: the Enterprise Wiki site. This template 
is aimed at sites that do not require an approval mechanism, contain many authors, and 
are lightweight publishing sites that are lightly branded.

SharePoint Server’s WCM feature provides mechanisms for authoring, branding, and 
controlled publishing. These mechanisms are linked to the SharePoint Server Publishing 
features, which provide a number of additional capabilities not available on team sites, 
such as the use of variations to support the creation and management of multilingual 
sites and additional Web Parts—for example, the Content Query Web Part (CQWP)—that 
you can use to aggregate data from multiple data sources. The Content Query Web Part 
is greatly improved in SharePoint Server 2010 when compared with the version of that 
Web Part in SharePoint Server 2007.

One of the key constructs of publishing sites is the ability to control the strict layout of 
content on a page, known as the page layout. Each Web content management page, 
also known as a publishing page, is based on a page layout. Each page layout is associ-
ated with a master page so that the branding and navigation are the same on Web 
content management pages as on ordinary content pages. However, on a publishing 
page, you are not modifying a live page, where your changes are immediately visible to 
visitors. You can restrict the content shown in different areas of the page to be only text 
or to not include images. These features are available because a publishing page is asso-
ciated with a page control, and it is the page control that dictates the content rules and 
the look and feel in the content portion of the page. 

Important  In this chapter, you concentrate on how to use SharePoint Designer with the Web 
Content Management feature of SharePoint Server, in particular the page layouts. If you do 
not have SharePoint Server installed on your computer, you will not be able to complete the 
exercises in this chapter.

In this chapter, you will explore the Web content management functionality in 
SharePoint Server and the publishing page model. You will create a publishing site and a 
new page layout, which you will modify and then restore to a previous version. You will 
add new field controls to an existing page layout and approve a page layout. Finally, you 
will detach a page from its page layout and then reattach the page layout to the page.

Practice Files  You do not need any practice files to complete the exercises in this 
chapter. For more information about practice file requirements, see “Using the Practice 
Files” at the beginning of this book.
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Creating a Publishing Site
A publishing site is a site that uses the SharePoint Server Web content management 
functionality; that is, pages require content approval before they are generally available.

Publishing functionality is enabled on SharePoint Server sites when the SharePoint Server 
Publishing feature is activated. A feature allows you to activate or deactivate func-
tionality at the level of a site, site collection, Web application, or SharePoint farm. The 
SharePoint Server Publishing feature depends on the activation of the SharePoint Server 
Publishing Infrastructure feature at the site-collection level. Microsoft developed both 
these features, which are installed when SharePoint Server is installed on each Web front 
end. Site owners can activate features to extend the functionality of their sites. Therefore, 
it is possible to turn a SharePoint site based on the team site definition into a publishing 
site by activating the SharePoint Server Publishing feature.

Note  The SharePoint Server Publishing Infrastructure feature adds a number of objects to the 
top-level site of your site collections. These objects include the SharePoint groups Approvers, 
Designers, Hierarchy Managers, Restricted Readers, and Style Resource Readers; and several 
new libraries: Pages, Site Collection Documents, Style Library, and Site Collection Images. 
They also include the Content And Structure Reports and Reusable Content lists. In addition, 
the Publishing Infrastructure feature adds new Web Parts, site columns, content pages, and 
the NightandDay.master publishing master page; replaces the top link bar with a global 
navigation menu; and adds a number of new links to the site settings page.

Typically, publishing sites are created as subsites (or child sites) in a site collection in 
which the site collection was created, for example, by using the Publishing Portal or 
Enterprise Search Center site template. Typically, you use the Publishing Portal site tem-
plate to create intranet or public-facing sites. These templates can only be used to create 
the root site of a site collection and have the SharePoint Server Publishing Infrastructure 
feature automatically activated. When you create a site based on the site definitions 
Publishing Portal, Enterprise Wiki, Publishing Site, Publishing Site With Workflow, 
Enterprise Search Center, FAST Search Center, or Business Intelligence Center, you can 
create publishing pages.

Note  The following publishing sites are deprecated in SharePoint Server 2010: Report 
Center, Site Directory, Collaboration Portal, and Search Center With Tabs. If you want 
functionality provided by the Site Directory template in SharePoint Server 2007, you can 
use a community-created Site Directory template for SharePoint 2010 on the CodePlex Web 
site (spsitedirectory2010.codeplex.com/ ), with a write-up on the U.K. SharePoint team blog 
site at blogs.msdn.com/b/uksharepoint/archive/2010/04/05/introducing-site-directory-for-
sharepoint-2010.aspx.

In this exercise, you create a subsite by using the Publishing site template.
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Important  This exercise requires SharePoint Server 2010 functionality. You will not be able to 
complete this exercise if you are using a SharePoint Foundation installation.

SET UP  You need the URL of a SharePoint site on which you can create the new 
publishing site as a subsite. Open SharePoint Designer, and display Backstage view.

1.	 On Backstage view, with the Sites tab selected, under Site Templates, click More 
Templates.

The Site To Load Templates From dialog box opens.

2.	 In the Site name text box, type the URL of the SharePoint site on which you want 
to create the subsite.

3.	 Click Open.

SharePoint Designer communicates with the SharePoint site and retrieves a list 
of SharePoint site templates that can be used as a basis for the new SharePoint 
subsite. These are displayed on Backstage view. The SharePoint templates listed 
depend on the configuration or your site collection or whether your organization 
has created any new site definitions. When you connect to another SharePoint site, 
different SharePoint templates might be displayed.

4.	 Click Publishing Site under Site Templates. 

Tip  You might need to scroll down to find the template.

The New Publishing Site dialog box appears.
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5.	 In the Specify the location of the New Web site text box, delete subsite, and 
type JobVacancies. Click OK.

The Please Wait dialog box opens.

The dialog box closes, and the publishing site settings page is displayed.

CLEAN UP  Close SharePoint Designer.

Understanding Web Content Management in 
SharePoint Server 2010

As with any other Web content management program, with SharePoint Server you can 
create and manage Web content from its creation to live publication. The process is 
iterative to account for periodic modifications. Using the Web content management 
functionality in SharePoint Server, a content approval process could look similar to the 
following:
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●● Step 1, Content creation  The content creator creates a page from a page layout, 
which is the blueprint for how a page looks without any content. Pages created 
from page layouts are known as publishing pages. On a live Internet site, each 
page layout might have dozens or hundreds of publishing pages associated with 
it. Each page layout contains a number of field controls that the content creator 
can use to enter data, and the page layout can optionally contain one or more 
Web Part zones. Each field control can provide a number of tools that the content 
creator can use to choose fonts, links, images, and other resources to make con-
tent creation as simple as possible, including a spelling checker. Each site collection 
contains a Site Collection Images library that the content creator can use to store 
images that are used through the site collection. Page layouts are stored in the 
Master Page gallery.

●● Step 2, Approval process  After a publishing page is formatted, including with any 
scheduling properties, the content creator submits it for approval. The approver 
can edit, reject, or approve the page.

●● Step 3, Scheduled  After approval, the publishing page is either published or 
scheduled for publication.

●● Step 4, Published  The publishing page is visible to all visitors to the site.

●● Step 5, Expiration  When the publishing page reaches the end of its life, the con-
tent is no longer visible on the site and can be archived.

When you use the Publishing Site template or the Enterprise Wiki template, the default 
content approval process contains only steps 1 and 4. The Publishing Site template does 
not have content approval enabled, but the template is enabled for major and minor 
versioning. As the content creator amends the page, draft copies of the page are stored 
as a minor version. Only when a content creator has completed the page to his or her 
liking and then clicked Publish will the page move from step 1 to step 4. The page is then 
converted to a major version. The page moves from step 4 to step 1 whenever a content 
creator decides to amend it.

On a site based on the Publishing Site With Workflow template, both content approval 
and the Approval workflow are enabled so that a page moves from step 1 to step 2 be-
fore moving to either step 3 or step 4. Also, by configuring the page’s schedule settings, 
the content creator can place the page in a scheduled state (step 3), whereby the page 
will not be visible until the specified date. The content creator can also configure an end 
date with the option to automatically send the page’s contact an e-mail message when 
the page expires.
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To maintain a large Internet or intranet site, you need a number of people who have the 
following roles:

●● Site owners  For a large site that contains many child sites, this might be a team 
of people who determine the site structure and governance and also manage 
centrally stored resources such as images. For each child site, another person or 
team might decide on the list and libraries the site contains or specify the pages 
required. Such a team would produce wireframe diagrams that represent how each 
component on the page should be laid out.

●● Page layout designer  This person uses SharePoint Designer to create and maintain 
page layouts. You might need a developer if the requirements are complex.

●● Content creator  These users create and modify publishing pages based on page 
layouts. Users who are placed in the Members SharePoint group can amend items, 
documents, and publishing pages. On most installations, administrators will create 
an additional SharePoint group so that they can differentiate between users who 
can edit and modify publishing pages and those, for example, who can upload and 
approve files in other document libraries.

●● Approver  These users moderate, edit, and approve publishing pages. This spe-
cial SharePoint group is created automatically and, on a site created from the 
Publishing Site With Workflow template, is linked to the Page Approval workflow 
on the Pages library. Users in this group can approve any item or document in any 
list or library that has content approval enabled.

●● Visitor  These users have read-only access to pages.

In this exercise, you create and explore a publishing page.

SET UP  Using the browser, open the publishing site you created in the previous 
exercise.

1.	 Click Site Actions, and then click New Page.

The New Page dialog box opens.

2.	 In the New page name box, type Welcome.
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3.	 Click Create.

The page is displayed in edit mode with the Editing Tools tabs visible on the ribbon. 
The status is Checked Out And Editable. Within the content portion of the page, 
three controls are displayed: Title, Page Content, and Rollup Image, which is used in 
conjunction with the Content Query Web Part.

4.	 On the Page tab, click Page Layout in the Page Actions group.

Under Article Page, an orange rectangle surrounds the Body Only page layout.

5.	 Scroll down, and under Welcome Page, click Summary Links.

A dialog box is briefly displayed and indicates that the page layout is changing. 
The page refreshes, and within the content portion of the page, five controls are 

Page Layout



	 Understanding Web Content Management in SharePoint Server 2010    437

displayed—Title, Page Image, Page Content, Summary Links, and Summary Links 2—
as well as three Web Part zones—Top, Left Column, and Right Column.

6.	 Place the insertion point in the Page Content field control, and type Welcome to 
the Wide World Importers internal Job Vacancies site.

7.	 Scroll down the page, and in the Summary Links field control, click New Link.

The New Link—Webpage Dialog dialog box opens.

8.	 In the Title box, type Wide World Importers Internet Site, and in the Link URL 
box, type http://www.wideworldimporters.com. Click OK.

The New Link—Webpage Dialog dialog box closes, and Wide World Wide Internet 
Site appears in the Summary Links field control.

Tip   The Summary Links field control offers similar features to the Summary Links Web 
Part and allows content creators to create a list of hyperlinks grouped as required.

9.	 In the Top Web Part zone, click Add a Web Part to open the Web Parts panel. 

10.	 Under Categories, verify that Lists and Libraries is selected, and then under Web 
Parts, click Pages. Click Add.

The Web Parts panel disappears, and the ribbon is displayed. The Pages XLV Web 
part appears in the Top Web Part zone.

11.	 On the Editing Tools, Format Text tab, click Save & Close.

The page is taken out of editing mode but is still checked out to you. The field con-
trols and Web Part zones that do not contain information are not displayed.

CLEAN UP  Leave the browser open if you are continuing to the next exercise.
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Understanding the Page Model
When you create a publishing site, an ASP.NET page is created in the Pages library. On a 
publishing site, even the home page, Default.aspx, is stored in this library. If you look at 
the Address box in a browser when you have this page open, you will see that the URL 
ends with Pages/default.aspx.

The field controls on a page map to columns within the Pages library. When a content 
creator enters data in a field control—for example, in the Page Content field control on 
the Welcome.aspx page—the creator is actually entering data in the Page Content col-
umn in the Pages library. Using terminology from earlier in this book, by entering data 
into field controls, you associate metadata with the Welcome.aspx file.

When you look at the column types used within the Pages library, they do not look dif-
ferent from the column types you use to create columns on a team site. However, there 
is a difference; the Pages library is associated with the Page content type, which uses 
column types that are associated with field controls. Only if a column is associated with 
a field control can the column data be displayed on a publishing page. When you delete 
a column from the Pages library, you delete the data held in that column for all publish-
ing pages; therefore, if page layouts reference that column, no pages display that data. 
When you remove a field control from a page layout, any pages based on that page 
layout do not display information from that column. However, you have not deleted any 
information by removing field controls. When you place the field control back on the 
page layout, the data is again displayed.

The benefit of this method is that you have all the power of saving information in a li-
brary, yet you can display the data as you would on a traditional site. You can create 
page layouts to display and edit a subset of column values. Content creators then know 
that by creating a page based on that page layout, the page will contain all the fields 
needed and that it’s laid out for a particular purpose. 

Say, for example, that you need to create a solution for maintaining job vacancy details 
in one location. You create one content type for job vacancies, from which you create 
multiple page layouts. Job vacancies that need to specify security levels use one page 
layout, those that have no security clearance use another page layout, and both page 
layouts have the job title, job description, and date posted fields. Similarly, a vehicle 
manufacturer can store all of its publishing pages in one Pages library. It can use dif-
ferent layouts for cars and for trucks, but both layouts have the same field controls to 
display information such as the model name; a picture; and the vehicle’s top speed, fuel 
consumption, and carbon dioxide (CO2) emissions.
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Each page layout is based on a content type, which in turn specifies the field controls 
(columns) the layout can use. Field controls not only have the responsibility of display-
ing the contents of a column, but when they are used for data entry purposes, they also 
have the responsibility of writing content back to the column. Because field controls 
represent the data that is held in columns in the Pages library, if you place the same field 
control twice on a page, you will show the same data twice. If a user then uses both field 
controls to enter data, the data is saved to the same column, and the field control that 
saved its data last overrides the data of the other field control. Placing multiple copies of 
a field control on a page layout is not similar to placing multiple copies of an XLV Web 
Part or the Content Editor Web Part on a page. The Web Parts in the Web Part panel are 
templates that you can use repeatedly, whereas field controls in the Toolbox task pane 
represent a specific column in the Pages library and should be placed only once on the 
page layout.

See Also  For detail about content types, see Chapter 3, “Working with Lists and Libraries.”

In Chapter 4, “Customizing and Modifying Web Pages,” I detailed what happens when a 
user requests the home page of a team site. When you request a publishing page, such 
as Welcome.aspx, the following events occur:

●● The master page, the Welcome.aspx page, and the site properties are retrieved. The 
properties include the site title, permissions, and the links that should be shown on 
the Quick Launch bar.

●● The Welcome.aspx page properties are retrieved, including its title and the page 
layout it is using.

●● The page layout file and its properties are retrieved, including the field controls and 
Web Part zones it contains.

●● The Welcome.aspx properties associated with the page layout are retrieved, such 
as the values from the columns that map to the field controls and whether the Web 
Part zones contain any Web Parts.

●● The Web Parts data that populates the Web Part zones is retrieved.

●● The master page, the page layout, the Welcome.aspx page, the information from 
the field control about how the column data should be displayed, and all the data 
retrieved (taking into account the security settings of the user) are merged to form 
one HTML page that is sent to the browser to be rendered.

In this exercise, you explore page layouts and the Pages library.

SET UP  Open the Welcome.aspx page in the browser if it is not already open.
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1.	 On the Page tab, click Edit in the Edit group, and then click Page Layout in the 
Page Actions group.

2.	 Scroll down, and under Welcome Page, an orange rectangle surrounds Summary 
Links. Click Splash.

Tip  In the Page Layout list, the page layouts are grouped by content type. In the Create 
Page Web page, the content type is displayed in brackets, and the names of the page 
layouts are to the right of the bracket. 

The Welcome page is displayed, with no Page Content field and the Pages XLV Web 
Part in the Bottom Right Web Part zone. Web Parts are placed in the Web Part 
zone that was last added to the page layout. When there are no Web Part zones on 
a page layout, the Web Parts are saved in the Closed Web Part gallery.

3.	 On the Page tab, click Page Layout, and then under Welcome, click Summary 
Links.

The Welcome page is redisplayed. The Page Content field appears with the text you 
entered in the previous exercise.

4.	 On the Page tab, click View All Pages in the Page Library group.

The All Documents view of the Pages library is displayed. Two files are listed, Default 
and Welcome. The Welcome page is checked out to you.

5.	 Click Site Actions, and then click Edit in SharePoint Designer.

The site opens in SharePoint Designer.

6.	 On the Navigation pane, click Lists and Libraries, and then under Document 
Libraries, click Pages.

The list settings page is displayed in the workspace. In the Content Types area the 
Article Page, Folder, Page, and Welcome Page content types are displayed.

7.	 In the Content Types area, click Page, and then on the Content Type Settings 
tab, click Edit content type columns.

The Columns editor page is displayed with the following columns listed: Name, 
Title, Comments, Scheduling Start Date, Scheduling End Date, Contact, Contact 
E-mail Address, Contact Name, Contact Picture, Variation Group ID, Variation 
Relationship Link, Rollup Image, and Target Audiences.

Page Layout

View All Pages

Edit Columns
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8.	 On the workspace breadcrumb, click the arrow to the right of Content Types, and 
click Welcome Page.

9.	 On the Content Type Settings tab, click Edit content type columns.

The Columns editor page is displayed, and the same columns from the Page 
content type are listed in addition to the following columns: Page Image, Page 
Content, Summary Links, and Summary Links 2.

10.	 Return to the browser, where the All Documents view of the Pages library is dis-
played. Rest the mouse pointer over Welcome, and click the check box that ap-
pears. On the Documents tab, click Edit Properties in the Manage group.

The Pages - Welcome.aspx page is displayed. Toward the bottom of the page, the 
Page Image, Page Content, and Summary Links fields are displayed. The contents of 
Web Part zones are not displayed.

Edit Properties
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11.	 In the Page Content field, place the insertion point at the end of the sentence, af-
ter site, and type On this site, you will find information on job vacancies.

Note  You cannot edit a publishing page in SharePoint Designer or modify the 
properties of a publishing page. You can, however, create and modify content types and 
page layouts in SharePoint Designer.

12.	 Click Save, and then in the All Documents view of the Pages library, click 
Welcome to view the page.

CLEAN UP  Close the browser. Leave SharePoint Designer open if you are continuing 
to the next exercise.

Creating a Page Layout
You can create a page layout by using a browser and SharePoint Designer. To create 
a page layout, you need to specify a page layout content type, which in turn specifies 
which field controls (columns) you can place on your page layout.

SharePoint comes with a set of default content types that are installed when you create a 
site collection (from the Publishing Portal site template, for example). Root-level content 
types are used to create all the default lists, libraries, and page layouts. SharePoint Server 
comes with the following built-in page layout content types:

●● Page  Use this content type when you want to create your own page layout.

●● Article Page  This content type is based on the Page content type and is used to 
create the Article Page page layouts. SharePoint Server provides four Article Page 
page layouts  For example, Image On The Right is used for presenting an article 
(as in a magazine article) on a Web site. It contains a Page Image field control and 
a Page Content field control to capture data, as well as a few other simple field 
controls.

●● Enterprise Wiki Page  This is the default content type for the Enterprise Wiki site 
template. It provides a basic content area as well as ratings and categories.

●● Project Page  This is a content type included with the Enterprise Wiki site. It pro-
vides some basic information to describe a project by using Project Status and 
Contact Name field controls.

●● Redirect Page  This content type is used to create a variations page layout to direct 
users to the variations home page when the variations settings are configured. 
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●● Welcome Page  This content type is based on the Page content type and is used to 
create Welcome Page page layouts. A site created from the Publishing Portal site 
template contains 13 Welcome Page page layouts.

All page layouts are stored in the Master Page gallery for the top-level site of a site col-
lection. Although the Master Page gallery has all the features of a normal document 
library, because of its importance for the whole site collection, it is secured to limit the 
rights of most users. As a page layout designer, you must have at least the Design per-
mission levels or higher to work with the files in this library. Such permission levels are 
automatically assigned to you if you are a member of the Designers SharePoint group. 
To protect the contents of the Master Page gallery further, content approval and minor 
and major versioning are enabled by default. For users to see pages based on your page 
layouts, the page layouts must be published as a major version and approved. To fa-
cilitate this process, you might consider enabling the Approval workflow for the Master 
Page gallery.

By using a browser, you can configure each site within a site collection to display all or 
some of the page layouts. Therefore, if you create page layouts that are specifically for the 
Human Resources department, you can limit the Human Resources site to use only 
the Human Resources page layouts, and any child site of the Human Resources site can 
be configured to inherit the preferred layouts from its parent site.

To display new data on a page layout, you must first add a site column to the content 
type used to create the page layout. The site column then exposes a new field control for 
you to use on your page layout. Microsoft has provided a number of column types spe-
cifically for publishing sites—that is, those that have the Formatting And Constraints For 
Publishing capability and the Summary Links data field controls. 

In this exercise, you create a page layout and then create a publishing page from your 
page layout.

SET UP  Using SharePoint Designer, open the publishing site you created earlier in 
this chapter if not already open.

1.	 In the Navigation pane, click Page Layouts, and then on the Page Layouts tab, 
click New Page Layout in the New group.

The New dialog box opens.

2.	 In the Content Type Name list, select Welcome Page. Then, in the URL Name 
box, type JobVacancies, and in the Title box, type Job Vacancies Page Layout.

New Page Layout
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3.	 Click OK to close the New dialog box.

If you were working on a subsite of a site collection, a new SharePoint Designer 
window opens at the site-collection level. The JobVacancies.aspx page opens as a 
new workspace tab at the site-collection level.

Troubleshooting  When you open a subsite of a site collection in SharePoint Designer, 
the Page Layouts gallery page might look empty. The Page Layout gallery page shows 
page layouts only when you open the top-level site in a site collection. You can use the 
New Page Layout command on a subsite; however, the name of your page layout must 
be unique at the site-collection level. Therefore, when you save your page layout, a 
Microsoft SharePoint Designer dialog box might open and indicate that the file might 
already exist, even though your view of the Page Layout gallery looks empty on your 
subsite.

4.	 On the workspace status bar, click Split. In Design view, scroll up and place the in-
sertion point in PlaceHolderMain, if necessary.

Code view contains two content placeholders, PlaceHolderPageTitle and 
PlaceHolderMain.

5.	 On the View tab, click Zoom to Contents, and then press Enter four times.

Zoom to 
Contents
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6.	 On the Insert tab, click SharePoint in the Controls group, and then click Show 
Toolbox. In the Toolbox task pane that opens, scroll down to view the SharePoint 
Controls.

The Page Fields section lists field types (columns) from the content type(s) inherited 
by the associated content type, which although not shown in the task pane, is in 
this case the Page content type. The Content Fields section lists field types from the 
associated content type, which is the Welcome Page content type.

7.	 Place the insertion point on the first line inside the PlaceHolderMain control. Type 
Job Title, and then in the Toolbox task pane, under Page Fields, double-click 
Title.

In the Advanced Editor window, the publishing Title field control appears with the 
text Title, and the Job Vacancies page layout appears.

8.	 Place the insertion point below the Title field control. Type Closing date:, and 
then in the Toolbox task pane, under Page Fields, double-click Scheduling End 
Date.

In the Advanced Editor window, the publishing Schedule End Date field control 
appears.

SharePoint
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9.	 On the Quick Access Toolbar, click Save, and then click the Page Layouts work-
space tab.

A green check mark is displayed to the left of JobVacancies.aspx.

10.	 Click the icon to the left of JobVacancies.aspx, and then on the Page Layouts 
tab, click Check In. When the Check In dialog box opens, click OK.

The file JobVacancies.aspx is checked in as a minor (draft) version and will be visible 
only to other page layout designers.

11.	 In the browser, click Site Actions, All Site Content, and then on the All Site 
Content page, under Document Libraries, click Pages.

12.	 On the Documents tab, click New Document to display the Create Page page. In 
the Title box, type HR Manager EMEA, and then press TAB.

HR-Manager-EMEA appears in the URL Name box.

13.	 In the Page Layout section, scroll down the list, and click (Welcome Page) Job 
Vacancies Page Layout. Click Create to display the All Documents view of the 
Pages library.

14.	 Click HR-Manager-EMEA, to display the page in the browser, and then on the 
Page tab, click Edit.

Two field controls are listed: Title and Scheduling End Date. The Title box does not 
provide you with the ability to modify the look and feel of the text, such as the 
font, font size, or color.

Check In
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CLEAN UP  Leave the browser open if you are continuing to the next exercise. Close 
all SharePoint Designer windows.

Modifying a Page Layout
As with any other component you use to develop your solution, you need to modify 
page layouts by adding, removing, and configuring field controls, Web Part zones, and 
Web Parts. Field controls, like Web Parts, can have a number of properties. Field con-
trols that are created from some of the basic column types might not have any proper-
ties. Others, like the Full HTML Content With Formatting And Constraint For Publishing 
column type, has nearly 50 properties, as well as its own cascading style sheet. Because 
a field control is an ASP.NET control, its properties can be configured by using the Tag 
Properties task pane. A developer can also create additional field controls.

Tip  You cannot delete a page layout if you have created publishing pages based on that page 
layout.

In this exercise, you add and delete field controls for a page layout and configure the 
properties of a field control.

SET UP  In the browser, open the site you used in the previous exercise if it is not 
already open.

1.	 Click Site Actions, and then click Site Settings.
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2.	 When the site settings page is displayed, under Galleries, click Master pages and 
page layouts.

The Master Page gallery page is displayed. Notice that you are at the top-level site 
of the site collection.

3.	 Scroll down the page, and click to the left of JobVacancies.aspx to select 
the check box that appears. On the Library Tools, Documents tab, click Edit 
Document in the Open & Check Out group.

A Message From Webpage dialog box appears, asking if you want to check out the 
item.

4.	 Click OK to check out the page layout, and then click OK in the Open Document 
dialog box that appears, warning you that some files can harm your computer.

SharePoint Designer opens, and then a Microsoft SharePoint Designer dialog box 
opens, stating that the page does not contain any regions that are editable in safe 
mode.

5.	 Click Yes to open the page in advanced edit mode.

The JobVacancies.aspx page opens in the workspace.

6.	 On the View tab, click Design, and then click Zoom to Contents.

7.	 Within JobVacancies.aspx, click Scheduling End Date, and then press Delete.

The Scheduling End Date field control is deleted.

8.	 In the Toolbox task pane, scroll down in the SharePoint Controls header section. 
Under Content Fields, double-click Page Content.

The Page Content field control is added to the JobVacancies.aspx page.

9.	 On the View tab, click Task Panes, and then click Tag Properties.

The Tag Properties task pane opens.

10.	 In the Tag Properties task pane, under Misc, click in the cell to the right of 
AllowImages, click the arrow that appears, and then click False.

11.	 Press CTRL+S to save the page layout.

Zoom to 
Contents

Task Panes
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12.	 In the browser, open the publishing page you created at the start of this chapter. 
On the Quick Launch bar, click Libraries, and then on the All Site Content page, 
under Document Libraries, click Pages.

The All Documents view of the Pages library is displayed.

13.	 Click HR-Manager-EMEA, and then on the Page tab, click Edit. 

The Scheduling End Date field control is no longer on the page. The Editing Tools 
tabs (Format Text and Insert) are visible.

Tip  If the Editing Tools tabs are not visible, place the insertion point under Page 
Content.

CLEAN UP  Close the browser. Close the Tag Properties task pane. Leave SharePoint 
Designer open if you are continuing to the next exercise. 

Allowing Users to Rate Web Content
In SharePoint Server 2010, rating functionality has been introduced for all lists. This func-
tionality can be used on publishing pages to allow users to rate the content on the page 
by using a 0-to-5-star rating scale. To add this functionality to publishing pages, you 
must enable the rating settings in the Pages library. With these settings enabled, you can 
add the Rating site column to the content type that the page layout for the publishing 
pages use.

In this exercise, you add a new site column to a page layout content type and then add 
the corresponding field control to a page layout.

SET UP  Open the top-level site of your site collection in SharePoint Designer.
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1.	 In the Navigation pane, click Content Types, and then under Page Layout 
Content Types, click Welcome Page.

The Welcome Page settings page is displayed.

2.	 On the Content Type Settings tab, click Edit Columns, and then on the Columns 
tab, click Add Existing Site Column.

The Site Columns Picker dialog box opens, with Enter Search Keywords highlighted.

3.	 Type rat.

The Site Columns Picker dialog box displays two Ratings site columns: Number Of 
Ratings and Rating (0-5).

4.	 Click Rating (0-5), and then click OK. 

The Site Columns Picker dialog box closes, and the Rating (0-5) site column appears 
at the bottom of the Welcome Page settings page.

5.	 On the Quick Access Toolbar, click Save.

6.	 In the Navigation pane, click Page Layouts. Click the icon to the left of 
JobVacancies.aspx, and then on the Page Layouts tab, click Edit File.

In the Toolbox task pane, under Content Fields, Rating (0-5) is displayed.

7.	 In the Advanced Editor window, place the insertion point below the Page 
Content field control. In the Toolbox task pane, under Content Fields, double-
click Rating (0-5).

The Rating field control is added to the page layout.

Add Existing 
Site Column

Save

Edit File
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8.	 On the Quick Access Toolbar, click Save.

9.	 In the browser, open the publishing page you created at the start of this chapter. 
On the Quick Launch bar, click Libraries, and then on the All Site Content page, 
under Document Libraries, click Pages.

The All Documents view of the Pages library is displayed.

10.	 Click HR-Manager-EMEA. 

Five rating stars appear on the page.

Troubleshooting  If you hover the mouse pointer over the rating stars and they do not 
change color, you need to enable rating settings on the Pages library. Navigate to the 
Administration Web Page for the Pages library, and then under General Settings, click 
Rating Settings. On the Rating Settings page, select Yes to allow items in this list to be 
rated, and then click OK.

CLEAN UP  Close the browser and SharePoint Designer.

Approving a Page Layout
For visitors to your publishing site to view pages, the page layout and the pages must 
be checked in as a major version and approved. This is particularly true for the home 
page, Default.aspx, which in a newly created publishing site is checked in only as a draft 
version. If page layouts and pages are not checked in and approved, the Error: Access 
Denied page is displayed to visitors to your site. Also, any components you use on your 
page layout or page must be checked in and approved as a major version. These compo-
nents include images in the Site Collection Images library or reusable content stored in 
the Reusable Content list at the top-level site of a site collection.

Tip  When a publishing page is approved, its content is automatically checked for spelling and 
components that are not approved are surrounded with a red border.

You can check in a page layout as a major version by using SharePoint Designer. 
However, you must use the browser to approve the page layout.

In this exercise, you check in a page layout as a major version and then approve it.

SET UP  Open the top-level site of your site collection in SharePoint Designer.

Save
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1.	 In the Navigation pane, click Page Layouts, and then click JobVacancies.aspx.

The page settings page for JobVacancies.aspx opens.

2.	 On the Page tab, click Check In.

The Check In dialog box opens.

3.	 Click OK.

The Check In dialog box closes.

4.	 In the Customization area, click Manage all file properties in the browser.

The browser opens and displays the properties of the page layout. It has an ap-
proval status of Pending.

5.	 On the View tab, click Approve/Reject.

The Approve page is displayed.

6.	 In the Approval Status section, select Approved, and then click OK.

The All Master Pages view of the Master Page gallery is displayed.

CLEAN UP  Close the browser and SharePoint Designer.

Check In
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Restoring an Earlier Version of a Page Layout
All page layouts are stored in the Master Page gallery at the top-level site of a site col-
lection. This library has versioning enabled, which means you can restore a previous 
version of a page layout if you decide that your current modifications do not meet your 
business needs or you want to start modifying your page layout by using a previous 
version.

In this exercise, you restore an earlier version of a page layout.

SET UP  In SharePoint Designer, open the publishing site you created at the start of 
this chapter if it is not already open.

1.	 On the Navigation pane, click All Files, and then click Pages.

The All Files gallery page for the Pages library is displayed in the workspace.

2.	 Click the icon to the left of HR-Manager-EMEA.aspx, and on the All Files tab, 
click Open in the Edit group.

A Microsoft SharePoint Designer dialog box opens, stating that you cannot edit the 
page in SharePoint Designer but that you can edit the corresponding page layout.

3.	 Click Edit Page Layout.

4.	 If your page layout is checked in, a Microsoft SharePoint Designer dialog box 
opens stating that the file is under source control. Click Yes to check it out.

The Microsoft SharePoint Designer dialog box closes. A Microsoft SharePoint 
Designer dialog box opens, stating that the page does not contain any regions that 
are editable in safe mode.

5.	 Click Yes to open the page in advanced edit mode. 

If you are working on a subsite of a site collection, a new SharePoint Designer win-
dow opens at the site-collection level. The JobVacancies.aspx page opens in a sepa-
rate workspace tab.

6.	 In the workspace breadcrumb, click the arrow to the right of JobVacancies.aspx, 
and click Version History.

The version history for JobVacancies.aspx is displayed.

Open
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7.	 Click the icon to the left of 0.1. On the Version History tab in the Manage group, 
click Restore Previous Version.

Tip  The page layout must be checked out before you can restore a previous version. 
If your page layout is checked in, a Microsoft SharePoint Designer dialog box opens, 
stating that the file must be checked out before a previous version of the file can be 
restored. Clicking OK in the dialog box does not check the file out. You need to navigate 
back to the page layout settings page or to the Advanced Editor window to check it out.

The workspace refreshes.

8.	 On the workspace breadcrumb, click the arrow to the right of JobVacancies.aspx, 
and then click Editor.

A Microsoft SharePoint Designer dialog box opens, stating that the page does not 
contain any regions that are editable in safe mode.

9.	 Click Yes to open the page in advanced edit mode. 

The page layout does not contain any field controls.

Tip  If you restore version 0.1, you have not gained anything more than you would by 
re-creating a page layout—that is, restoring version 0.1 results in page layout with no 
field controls.

CLEAN UP  Close the browser and all SharePoint Designer windows.

Detaching and Reattaching a Page Layout
If you do want to edit a page associated with a page layout, you can use SharePoint 
Designer to detach the page from the page layout. This turns the page into an ordinary 
content page, similar to the Home.aspx page of a team site. The page is associated with a 
master page and contains a PlaceHolderMain (Custom) control. With SharePoint Designer, 
you can reattach the page to its original page layout. However, when you reattach the 
page to the original page layout, you lose any customizations you completed on the page.

Tip  You cannot attach a page layout to a page that was not originally associated with the 
page layout.

The detach and reattach methods for page layouts are the reverse of one another, unlike 
detaching and attaching master pages. When you detach a page from its master page, 
all the controls and tags are copied from the master page to the content page. When 
you then attach a master page back to the content page, the original controls from 
the master page remain on the content page, with the effect that controls are applied 
twice—once from the original master page that was detached and also by attaching the 
master page again. You will have two Site Actions menus, two Navigation panes, two 

Restore 
Previous 
Version
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Quick Launch bars, and other duplicates. Detaching and reattaching page layouts does 
not suffer from this effect, but you should think carefully about what you are trying to 
achieve, because an undo mechanism might not be readily available to you.

In this exercise, you detach and reattach a page layout.

SET UP  In SharePoint Designer, open the publishing site you created at the start of 
this chapter.

1.	 On the Navigation pane, click All Files, and then click Pages.

The All Files gallery page for the Pages library is displayed in the workspace.

2.	 Click the icon to the left of HR-Manager-EMEA.aspx, and then on the All Files 
tab, click Detach from Page Layout in the Actions group.

A Microsoft SharePoint Designer dialog box opens, warning you that detaching the 
page from the page layout will copy the page layout’s markup to the page, and any 
changes to the page layout will not affect the page.

3.	 Click Yes to close the Microsoft SharePoint Designer dialog box.

Another Microsoft SharePoint Designer dialog box opens, stating that the detach-
ment was successful.

4.	 Click OK to close the Microsoft SharePoint Designer dialog box.

5.	 On the All Files tab, click Open in the Edit group.

A Microsoft SharePoint Designer dialog box opens, stating that the page does not 
contain any regions that are editable in safe mode.

6.	 Click Yes to open the page in advanced edit mode.

The HR-Manager-EMEA.aspx page opens in the workspace in advanced edit mode.

7.	 On the workspace breadcrumb, click Pages.

8.	 Right-click the icon to the left of HR-Manager-EMEA.aspx, and then click 
Reattach to Page Layout.

A Microsoft SharePoint Designer dialog box opens, warning you that by reattach-
ing the page, any customizations will be lost, except for changes to Web Parts in 
Web Part zones.

Detach from 
Page Layout

Open
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9.	 Click Yes to close the dialog box.

The dialog box closes, and a Microsoft SharePoint Designer dialog box opens stat-
ing that the reattachment was successful.

10.	 Click OK to close the dialog box.

CLEAN UP  Close SharePoint Designer.

Key Points
●● Web content management is just one of the functions included in the ECM feature 

of SharePoint Server.

●● Both the Publishing Site and the Publishing Site With Workflow site definitions en-
able the SharePoint Server Publishing feature, which provides a number of features 
not available on team sites.

●● The key concept of publishing sites is page layouts. A master page controls the look 
and feel of the branding and navigation, whereas the page layout controls the look 
and feel of the content portion of the page.

●● Page layouts are stored in the Master Page gallery in the top-level site of a site col-
lection. Content approval, minor versioning, and major versioning are enabled on 
this library, which means that you must publish a page layout as a major version 
and approve it before pages based on it can be viewed by visitors to your site.

●● Page layouts are created from page layout content types and publishing pages are 
created from a page layout.

●● Page layouts use field controls and Web Part zones to control where content can 
be placed on a publishing page.

●● Content creators using a browser manage publishing pages, which are stored at the 
site level in the Pages library.

●● Field controls map to columns in the Pages library and are responsible for display-
ing and modifying column values.

●● Microsoft has provided a number of new column types specifically for publishing 
sites, such as those that have Formatting And Constraints For Publishing features.





Chapter at a Glance
Use the ribbon to insert 
standard ASP.NET controls, 
page 460

Modify control properties, 
page 468

Use SharePoint Data View controls,
 page 472



	     459

14	Using Controls in 
Web Pages

In this chapter, you will learn how to
✔✔ Work with the ribbon and Tag Properties task pane.
✔✔ Use a standard ASP.NET server control.
✔✔ Validate user data entry.
✔✔ Use ASP.NET validation and SharePoint Data View controls.
✔✔ Test an ASP.NET form.
✔✔ Use SharePoint server controls.

Microsoft SharePoint Foundation 2010 and Microsoft SharePoint Server 2010 are in-
stalled on top of Microsoft .NET Framework 3.5. ASP.NET is part of the .NET Framework 
and enables you to separate user interface declarations from application logic. User 
interface declarations are typically HTML and include other client-side scripting mecha-
nisms, such as JavaScript, AJAX, and Silverlight. Application logic is precompiled into 
dynamic-link libraries (DLLs) that reside on Web servers and are fast to load when 
a Web server needs to respond to a Web page request. These DLLs contain code for 
common tasks, such as displaying a calendar, and are exposed in the user interface as 
controls. 

Microsoft SharePoint Designer 2010 categorizes controls into four groups: HTML, ASP.NET, 
SharePoint, and data source. Controls are very similar to Web Parts; you place them on a 
Web page and customize their properties to meet your needs.

See Also  For more information about controls, read the article at msdn.microsoft.com/en-us/
library/bb386416(VS.90).aspx and visit www.w3schools.com/aspnet/.

In this chapter, you will first insert ASP.NET and HTML controls on a Web page. You then 
create Web pages that use standard ASP.NET controls, ASP.NET validation controls, a 
SharePoint Data View, and data source controls. You will also review SharePoint server 
controls.
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Practice Files  Before you can use the practice files for this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete 
the exercises in this chapter are in the Chapter14 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.

Working with the Ribbon and Tag Properties 	
Task Pane

The Controls group on the ribbon’s Insert tab and the Tag Properties task pane allow 
easy access to a large number of controls and their properties. In SharePoint Designer 
2007, you insert controls by using the Toolbox task pane. This method is still available in 
SharePoint Designer 2010, however, the Controls group provides a quick way to insert on 
a page any of the following types of controls:

●● HTML  This type is further categorized into Tags (such as <div>, <br>, and <hr>) for 
static display and Form controls for user input.

●● ASP.NET server controls  SharePoint Designer 2010 includes ASP.NET controls 
similar to those exposed by the Microsoft Visual Studio Toolbox task pane. In both 
products, the controls are classified into the groups Standard, Data, Validation, 
Navigation, and Login. The big difference is that when you use ASP.NET controls 
in Visual Studio, you can write and compile code into an assembly that can be de-
ployed on each Web server, which you cannot do with SharePoint Designer.

●● SharePoint controls  These controls are ASP.NET server controls specific to 
SharePoint Foundation 2010 and SharePoint Server 2010 installations.

●● Data source controls  These controls include the connection information for data 
sources such as lists, libraries, SQL Server databases, and XML files. Almost any ASP.
NET control can be bound to a data source control, thereby allowing you to create 
pages to access data without needing to write code.

With SharePoint Designer, you create the presentation layer of a page. On the page, 
you place HTML tags, XSLT, client-side scripts, and controls that can be interpreted by 
SharePoint or the browser. You do not specify any server-side code that needs to be 
compiled, such as code written in a programming language like C# (pronounced C 
sharp), Visual Basic (commonly abbreviated as VB), or Visual J# (pronounced J sharp). 
However, each page does have a language associated with it.
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SharePoint and ASP.NET controls are server-side controls—that is, they execute code 
on the Web servers. SharePoint controls are prefixed by a set of characters that point 
to DLLs, also known as assemblies. The entry points within an assembly are known as 
namespaces. All similar controls are placed in the same namespace. The prefix characters 
are used throughout the Web page to reference the controls in the assembly so that 
using the full name of the namespace is not necessary. The controls contain a number 
of attributes (such as the runat=“server” attribute) that identify them as server controls. 
They contain an id attribute that allows you to identify controls by name and also allows 
the code on the Web servers to manipulate the controls so that the correct tags and 
data are sent back to render a page correctly in the browser.

A control’s attributes are known as properties. You can alter the behavior and appearance 
of a control by modifying its properties in the Tag Properties task pane or in Code view 
(in which case, SharePoint Designer provides Microsoft IntelliSense to help you).

In this exercise, you insert controls using the ribbon and set control properties in the Tag 
Properties task pane.

SET UP  Using SharePoint Designer, open the team site you created and modified in 
earlier chapters. If you did not yet create a team site, follow the steps in Chapter 1.

1.	 In the Navigation pane, click Site Pages. On the Site Pages tab, click Page in the 
New group, and then click ASPX.

A file named Untitled_1.aspx is displayed in the Site Pages gallery page.

2.	 Select Untitled_1, type ASPControls, and then press Enter.

A Windows dialog box is displayed, stating that the file is being renamed.

3.	 On the Pages tab, click the Edit File down arrow in the Edit group, and then click 
Edit File in Advanced Mode.

4.	 On the View tab, click Split in the Page Views group.

The workspace divides horizontally and displays Code view in the upper pane and 
Design view in the lower pane. Code view reveals an @Page directive that sets the 
language for the page and one <form> element containing a runat attribute with a 
value of server.

5.	 On the Insert tab, click ASP.NET in the Controls group, and then under Standard, 
click Label.

Page

Edit File

Split

ASP.NET
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SharePoint Designer adds the Label control inside the <form> element. The 
<asp:label#Label1> tag is active on the Quick Tag Selector at the bottom of the 
workspace.

6.	 On the View tab, click the Task Panes down arrow in the Workspace group, and 
then click Tag Properties.

The Tag Properties task pane opens.Task Panes
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7.	 In the Misc section of the Tag Properties task pane, click the cell to the right of ID, 
and type lblWelcome. Press Enter.

In the Design portion of the workspace, the tag control is named 
asp:label#lblWelcome, where lblWelcome is the ID of the ASP.NET label control. This 
tag is active on the Quick Tag Selector. In the Code view portion of the window, the 
ID of the label control is set to lblWelcome.

8.	 In the Appearance section of the Tag Properties task pane, click the cell to the 
right of Text, type Welcome to the Wide World Importers Web site, and then press 
ENTER.

In Code view, the Text attribute is set to Welcome to the Wild World Importers Web 
site, and in Design view, the text appears within the asp:label control.

9.	 In the workspace, place the insertion point to the right of the word site. On the 
Insert tab, click HTML in the Controls group, and then under Tags, click Break to 
insert a line break.

10.	 On the View tab, click Design in the Page Views group, and then on the Quick 
Access Toolbar, click Save.

CLEAN UP  Leave SharePoint Designer open if you are continuing to the next 
exercise.

Design
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Using a Standard ASP.NET Server Control
Although you can use HTML controls on all types of Web pages, the real power comes 
when you use ASP.NET server controls. ASP.NET server controls appear as ASP.NET op-
tions in the Controls group on the Insert tab and in the Toolbox task pane in the following 
groups:

●● Standard  Contains a standard set of controls, such as buttons, check boxes, drop-
down lists, image maps, and calendar and wizard controls.

●● Data  Contains two types of controls: view controls and data source controls.

❍❍ View controls allow you to view the content from data sources in sophisti-
cated grids and lists, very similar to XSLT List View Web Parts (XLVs) and Data 
Views. 

❍❍ Data source controls allow you to define a data source. 

Before you use a view control, you must insert a data source control on the page. 
You then bind the data source control to the view control. You can create a data 
source control from a data source in the Data Sources library or use one of the data 
source controls in the Data group. 

●● Validation  Controls that allow you to validate data entered in a Web form.

●● Navigation  The Menu, SiteMapPath, and TreeView controls in this group allow you 
to navigate between pages in a Web site.

●● Login  Controls that support form authentication and allow you to create a mem-
bership system.

In this exercise, you add one of the standard ASP.NET controls, the AdRotator control, 
to a Web page. The AdRotator control displays a sequence of images chosen randomly 
from a set of images specified in an XML file known as the advertisement file.

SET UP  Use the site you modified in the previous exercise. Copy the practice files 
in the Chapter14 practice file folder—ADRotator.xml, LucernePublishing.png, 
WideWorldImporter.png, and ConsolidatedMessenger.png—to the Site Assets library. 
Open the Toolbox and Tag Properties task panes and the ASPControls.aspx page in 
the workspace.
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1.	 In the Navigation pane, click Site Assets. Click the icon to the left of AdRotator.
xml, and then on the Assets tab, click Edit File in the Edit group.

The AdRotator.xml file opens in the workspace, displaying the XML data needed by 
the AdRotator ASP.NET control.

2.	 Click the Close button, and then click the ASPControls.aspx page tab if the page 
is not the active file in the workspace.

3.	 In the workspace, click the line of text under Welcome to the Wide World 
Importers Web site.

4.	 Select the Insert tab on the ribbon, click ASP.NET in the Controls group, and then 
under Standard, click AdRotator.

The AdRotator control is added to the page inside the <form> tags. The On Object 
User Interface (OOUI), which is represented by a small arrow, floats just outside the 
control, and the Common AdRotator Tasks panel appears.

Note  ASP.NET controls must be placed inside a form. SharePoint Designer will 
automatically insert ASP.NET controls within <form> tags.

5.	 In the Tag Properties task pane, scroll to the Behavior section, and click the plus 
sign (+) to expand it if necessary. Click the cell to the right of AdvertisementFile, 
and then click the ellipsis button.

6.	 In the Select XML File dialog box, within your team site, navigate to the Site 
Assets library, click AdRotator.xml, and then click Open.

Note   If the Select XML File dialog box does not automatically open showing the 
contents of your team site, under Microsoft SharePoint Designer, click your team site.

7.	 In the Tag Properties task pane, click the cell to the right of AlternateTextField, 
and type Welcome Advertisements.

8.	 In the Tag Properties task pane, click the cell to the right of KeywordFilter, type 
Shipping, and then press Enter.

Only advertisement images associated with that keyword are displayed.

Edit File

Close

ASP.NET

Ellipsis
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9.	 On the Quick Access Toolbar, click Save, and then press the F12 key to preview 
ASPControls.aspx in your default browser.

10.	 Click the Refresh button several times to see the advertisement image change 
from Consolidated Messenger to Wide World Importers.

The third image specified in AdRotator.xml is not associated with the keyword 
shipping and should not appear.

CLEAN UP  Leave SharePoint Designer open if you are continuing to the next 
exercise. Close any open pages and browser windows.

Validating User Data Entry
You can validate the data that users type into controls by using a validation control. The 
input controls can be HTML input tags or standard ASP.NET controls. 

In this exercise, you create a data entry form and use the RequiredFieldValidator control 
to identify to the user that input is mandatory.

SET UP  Use the site you modified in the previous exercise.

1.	 On the Navigation pane, click Site Pages. On the Pages tab, click Page in the 
New group, and then click ASPX.

A file named Untitled_1.aspx is displayed in the Site Pages gallery page.

Save

Refresh

Page
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2.	 On the Pages tab, click Edit File, and then click Edit File in Advanced Mode.

A Microsoft SharePoint Designer dialog box opens.

3.	 Click Yes to open the new page in advanced edit mode.

4.	 On the Insert tab, click the New Item Form down arrow in the Data Views & 
Forms group, and then under XML Files, click ADRotator.xml.

A DataFormWebPart control is added to the new page, and the Data Source Details 
task pane opens.

5.	 Click the box to the right of ImageUrl, and then click the arrow (OOUI) that 
appears.

The Common TextBox Tasks panel opens, showing that the text box is bound to the 
ImageUrl data field and that the Data View XSLT will format the field as a text box. 
Similarly, all the text boxes on this page are bound to elements within the XML file.

The tag name of the ImageUrl text box is <asp:textbox#ff1_new>, which means 
that the ID of this control must be set to ff1_new.

Warning  If you change the IDs of these ASP.NET controls, the data bindings to the 
XML fields in the AdRotator.xml file will be lost, and your new form will not function 
correctly.

Edit File

New Item Form
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6.	 On the Insert tab, click ASP.NET in the Controls group, and then under 
Validation, click RequiredFieldValidator.

The RequiredFieldValidator control appears to the right of the ImageUrl text box.

7.	 In the Tag Properties task pane, under Appearance, type Enter the URL of an 
Advertisement image in the cell to the right of ErrorMessage.

Note   If the Tag Properties task pane is not open, select the View tab on the ribbon, 
click the Task Panes down arrow in the Workspace group, and then click Tag Properties.

8.	 In the Tag Properties task pane, under Behavior, click the cell to the right of 
ControlToValidate, click the arrow that appears, and then click ff1_new.

CLEAN UP  Save Untitled_1.aspx. Leave SharePoint Designer open if you are 
continuing to the next exercise. Close any open browser windows. 

Using ASP.NET Validation Controls
ASP.NET includes six validation controls that solve the common validation scenarios en-
countered in many Web development projects:

●● CompareValidator  Compares the data entered in one field with the data entered 
in another field to see whether the data matches.

ASP.NET
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●● CustomValidator  Allows you to write your own validation code. This code could be 
server-side code or client-side code, such as code written in JavaScript or Microsoft 
Visual Basic Scripting Edition (VBScript). If server-side code is required, you need to 
involve a developer.

●● RangeValidator  Ensures that the value entered by a user falls within a certain 
range.

●● RegularExpressionValidator  Validates the data against a specific pattern.

●● RequiredFieldValidator  Checks that a user enters data in a field.

●● ValidationSummary  Displays a summary of validation errors for a page.

These server-side controls can be configured by using the EnableClientScript property 
to complete the validation process on either the client or the server. The controls gen-
erating JavaScript are run on a user’s computer when the user browses to the page. The 
ASP.NET controls link to a JavaScript file, WebUIValidation.js, which is sent down to the 
browser when the user requests the page. By supporting client-side validation, there is 
no round trip to the server to validate the user’s input: As the user tabs between input 
fields, the error message is displayed. After the page is validated, it is posted back to the 
server, where the validation process is repeated to guard against a security breach at the 
network level.

Tip  SharePoint includes validation controls based on these ASP.NET controls. They are not 
visible either on the ribbon or on the Toolbox task pane, but you can use them by editing 
the page in Code view. More information can be found at karinebosch.wordpress.com/
sharepoint-controls/sharepoint-validation-controls/.

In this exercise, you create a data entry form and use the validation controls to verify 
data input. You then configure the validation controls to associate them with input con-
trols and to define error messages.

SET UP  Use the site you modified in the previous exercise. Open the page Untitled_1.
aspx that you created in the previous exercise.

1.	 On the View tab, click the Task Panes down arrow in the Workspace group, and 
then click Toolbox.

The Toolbox task pane opens.

2.	 In the workspace, click the text box to the right of NavigateUrl.

The tag <asp:textbox#ff2_new> appears above the text box.
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3.	 In the Toolbox task pane, under Validation, double-click RequiredFieldValidator, 
and then double-click RegularExpressionValidator.

The two ASP.NET validation controls appear to the right of the NavigateUrl text 
box.

4.	 To the right of the NavigateUrl text box, click RequiredFieldValidator. In the 
Toolbox task pane, click the Tag Properties tab to bring the Tag Properties task 
pane to the front. Under Behavior, click the cell to the right of ControlToValidate, 
click the arrow that appears, and then click ff2_new.

5.	 To the right of the NavigateUrl text box, click RegularExpressionValidator 
to show the control’s properties in the Tag Properties task pane. In the Tag 
Properties task pane, under Appearance, in the cell to the right of ErrorMessage, 
type Enter the valid URL for the Advertiser’s Web site.

6.	 Under Behavior, click the cell to the right of ControlToValidate, click the arrow 
that appears, and then click ff2_new.

7.	 Under Behavior, click the cell to the right of ValidationExpression, and then click 
the ellipsis button that appears. In the Regular Expression Editor dialog box, un-
der Standard expressions, click Internet URL.

A regular expression appears in the Validation Expression text box.

Tip  If the standard expressions do not meet your needs, you can enter a custom regular 
expression, such as for U.S. phone numbers, as described at msdn.microsoft.com/en-us/
library/ms998267.aspx and blog.shkedy.com/2007/01/improving-on-aspnet-regular-
expression.html.

8.	 Click OK to close the Regular Expression Editor dialog box.

9.	 In the workspace, click the text box to the right of Impressions.

The tag <asp:textbox#ff5_new> appears above the text box.

Ellipsis
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10.	 In the Toolbox task pane, double-click RangeValidator.

The ASP.NET validation control appears to the right of the Impressions text box.

11.	 Click RangeValidator to show the control’s properties in the Tag Properties task 
pane. In the Tag Properties task pane, under Appearance, in the cell to the right 
of ErrorMessage, type Enter a value from 1 to 100 that represents how likely it is 
that this advertisement logo will display in relation to other ads.

12.	 Under Behavior, in the ControlToValidate list, click ff5_new. Enter 100 in the 
MaximumValue cell, enter 1 in the MinimumValue cell, and then select Integer 
from the Type list.

13.	 On the Quick Access Toolbar, click Save. In the Navigation pane, under Site 
Pages, right-click Untitled_1.aspx, click Rename, type NewAd.aspx, and then 
press Enter.

14.	 Press F12 to preview NewAd.aspx in the browser.

15.	 In the NavigateUrl text box, type www.nosite, and then click TAB.

The insertion point moves to the Keyword text box, and the message Enter the 
valid URL for the Advertiser’s Web site appears.

16.	 In the Impressions text box, type none, and then click Save.

Two other error messages appear.

Tip  The space to the left of the Enter the valid URL error message is for the error 
message associated with the NavigateUrl RequiredFieldValidator control. You can hide 
the space by setting the Display property of the RequiredFieldValidator control to 
Dynamic.

CLEAN UP  Leave SharePoint Designer open if you are continuing to the next 
exercise. Close any open pages and browser windows.

Save



472    Chapter 14  Using Controls in Web Pages

Using SharePoint Data View Controls
The Toolbox task pane categorizes SharePoint controls in four groups: Data View, Server 
Controls, Page Fields, and Content Fields. The first two control groups can also be cho-
sen from the SharePoint button in the Controls group on the Insert tab and require only 
SharePoint Foundation or SharePoint Server. The other two control groups list controls 
only if you have a SharePoint Server publishing page layout page open. In this chapter, 
you will use the Data View controls and server controls.

See Also  For information about Page Field and Content Field controls, see Chapter 13, 
“Managing Web Content in the SharePoint Server Environment.” SharePoint controls and 
their properties are described in the SharePoint Foundation and SharePoint Server Software 
Development Kits.

By using SharePoint Data View controls, you can expose data from one of the data 
sources you have defined. One of the best methods of data entry validation is to allow 
users to choose from a set of options. In lists and libraries, when one list contains data 
that you want to use in another list, you can use a lookup column. For data that is not 
stored in lists or libraries, the Data View controls enable you to bind to one data source 
and expose the data using check boxes, radio buttons, or drop-down lists from which 
the user can choose. The selected input is then used in a different data source.

In this exercise, you insert a Data View control so that a user can choose data from one 
data source as input to another data source.

SET UP  Use the site you modified in the previous exercise. Open the NewAd.aspx 
page in the workspace.

1.	 In the workspace, click the text box to the right of ImageUrl, and then press 
Delete. Click Enter the URL of an Advertisement image, and then press Delete.

The td.ms-vb HTML cell should now be empty.

2.	 On the Insert tab, click Data Source in the Controls group, and then click Site 
Assets.

A SPDataSource control appears to the right of ImageUrl.

Tip  If the SPDataSource control is not visible on the page, click the View tab on the 
ribbon, click Visual Aids, and then click ASP.NET Non-Visual Controls.

3.	 Click the SPDataSource control to show the control’s properties in the Tag 
Properties task pane.

Data Source
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Note   If the Tag Properties task pane is not open, click the View tab on the ribbon, click 
the Task Panes down arrow in the Workspace group, and then click Tag Properties.

4.	 In the Tag Properties task pane, under Misc, click the cell to the right of ID, type 
SPSiteAssets, and then press ENTER.

The tag above the SPDataSource control changes to <SharePoint:SPDataSource#SP
SiteAssets>.

5.	 On the Insert tab, click SharePoint in the Controls group, and then click Data 
View DropDownList.

In the workspace, a drop-down list control appears on the page, displaying the 
OOUI, the Common DVDropDownList Tasks panel, and the tag name <sharepoint:d
vdropdownlist#DVDropDownList1> above it. The text Unbound appears within the 
control.

6.	 In the Common DVDropDownList Tasks panel, click Data Fields.

The Change Data Bindings dialog box opens. In the Select A Data Source list, 
SPSiteAssets is already selected because the page has only one data source control.

7.	 In the Select a data field to save values to list, click ImageUrl. In the Select a 
data field for the display text list, click Title. In the Select a data field for the 
value list, click URL Path.
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8.	 In the Change Data Bindings dialog box, click OK.

The sharepoint:dvdropdownlist#DVDropDownList1 control contains the word 
Databound.

9.	 Right-click the Save button, and then click Form Actions.

The Form Actions dialog box opens.
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10.	 Under Actions List, select Navigate to page, and then click Add.

The Navigate To Page action is moved under Current Actions (Run In Order Shown).

11.	 With Navigate to page selected, click Settings.

The Form Actions Settings dialog box opens.

12.	 Click Browse, and in the Edit Hyperlink dialog box, click default.aspx. Click OK 
to close the Edit Hyperlink dialog box, and then click OK twice to close the Form 
Action Settings and Form Actions dialog boxes.

13.	 On the Quick Access Toolbar, click Save. 

CLEAN UP  Leave SharePoint Designer open if you are continuing to the next exercise.

Testing an ASP.NET Form
After you create your ASP.NET form and before you allow other users to enter data using 
the form, you should test that it meets your business needs.

In this exercise, you test the form you created in the previous exercises.

SET UP  Open SharePoint Designer if it is not already open. Open the site you 
modified in the previous exercise.

1.	 In the Navigation pane, click Site Assets. Click the icon to the left of 
ConsolidatedMessenger.png, and then on the Assets tab, click Administration 
Web Page in the Manage group.

The Item view of the file is opened in the browser.

2.	 On the View tab, click Edit Item in the Manage group.

The Edit Item form opens.

3.	 In the Title box, type Consolidated Messenger logo, and then click Save.

The All Items view of the Site Assets library is displayed.

4.	 Edit the properties of the image files LucernePublishing and WideWorldImports, 
and set their Title properties to Lucerne Publishing logo and Wide World 
Importers logo, respectively.

5.	 In the Quick Launch bar, click Site Pages to display the All Pages view, and then 
click NewAd.aspx to open the page in the browser.

6.	 In the ImageUrl list, click Wide World Importers logo.

Save

Administration 
Web Page
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7.	 Press TAB to move to the NavigateUrl text box, and type http://intranet.
wideworldimporters.com.

8.	 Click TAB three times to move to the Impressions text box, and type 30.

9.	 Click Save.

The page refreshes and displays the home page of your site.

10.	 In SharePoint Designer, in the Navigation pane, click Site Assets. 

The Site Assets gallery page is displayed.

11.	 Click the icon to the left of AdRotator.xml, and then click Edit File in the Edit 
group to display the file in the workspace.

The last Ad element in the file should contain the URL for the image file 
WideWorldImporters.png, the Wide World Importers portal URL, and an 
Impressions value of 30.

CLEAN UP  Leave SharePoint Designer open if you are continuing to the next 
exercise. Turn ASP.NET Non-Visual Controls off, and close any open pages and 
browser windows.

Using SharePoint Server Controls
All controls prefixed with SharePoint or WebPartPages are part of the SharePoint frame-
work and can be found on the Web server in the assembly Microsoft.SharePoint.dll. All 
SharePoint pages contain SharePoint Server controls, some of which are shown in the 
SharePoint option in the Controls group on the Insert tab and in the Toolbox task pane 
as follows:
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●● CssLink  Links to CSS files. By default, this control is placed on master pages and is 
linked to a file stored on each Web server so that all pages associated with a master 
page have the same look and feel. When the control is used with no file specified, it 
defaults to corev4.css.

●● Theme  Adds a reference to the site’s current theme CSS file, if one is configured.

●● ScriptLink  Links to JavaScript files. This control is placed on master pages and is 
linked to a file (core.js) stored on the Web server so that all pages associated with a 
master page have access to the same set of JavaScript functions.

●● AspMenu  An ASP.NET navigation control to display sites and pages within a site 
collection. By default, the control is placed on master pages so that all pages asso-
ciated with the master page share the same navigation.

●● RSSLink  On lists and libraries that are enabled as RSS feeds, this control exposes 
the URL that RSS aggregators can use to view list items.

●● SPCalendarNavigation  On list views, displays a calendar control that is used to 
navigate to specific list items. You can find examples of pages with this control in 
the All Items views of the Announcements and Calendar lists.

In this exercise, you review the SharePoint controls in the Toolbox task pane and investi-
gate their use on pages within a site.

SET UP  Use the site you modified in the previous exercise. Open the NewAd.aspx 
page in the workspace.

1.	 On the View tab, click Task Panes in the Workspace group, and then click 
Toolbox.

The Toolbox task pane opens.

2.	 Scroll down to SharePoint Controls, expand it if necessary, and under Server 
Controls (SharePoint), point to CSSLink.

The ScreenTip that appears references the SharePoint namespace, Microsoft.
SharePoint.WebControl.CssLink, in which the code-behind logic for this control can 
be found.
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Note  The controls visible on the Toolbox task pane will be different if your site was 
created on a Microsoft SharePoint Foundation installation.

3.	 In the Toolbox task pane, expand the Page Fields and Content Fields control 
groups.

No controls are displayed in these two groups.

4.	 On the workspace status bar, click Split, and then in the Navigation pane, click 
Master Pages.

The Master Page gallery opens.

5.	 Click the icon to the left of v4.master, and on the Master Pages tab, click Edit File 
in the Edit group.

The page opens in the workspace. In the <head> tag are a number of SharePoint 
controls, such as CssLink, Theme, ScriptLink, and CustomJSUrl.

6.	 Click the NewAd.aspx page tab to display the page, and in the Code view portion 
of the workspace, scroll to the top of the page.

Immediately after the opening <form> tag is a WebPartPages:DataFormWebPart 
control.

7.	 On the Style tab, click Attach in the Master Page group, and under Default 
Master Page, click v4.master.

The Match Content Regions dialog box opens.

Split

Edit File

Attach
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8.	 Click OK to close the Match Content Regions dialog box.

The NewAd.aspx page is redisplayed in the Design view portion of the workspace 
and has the same look and feel and navigation as other pages on the site. In the 
Code view portion of the workspace, there are no <head>, <body>, or <form> tags 
because these are now provided by the master page.

9.	 In the Code view portion of NewAd.aspx, scroll to the top of the page so that you 
see the @Page directive, and then scroll to the right until you see the masterpage-
file attribute on the first line of the page.

CLEAN UP  Close any open browser windows and exit SharePoint Designer.

Key Points
●● With ASP.NET, you can separate user interface declarations from application logic.

●● Application logic is precompiled into DLLs that reside on the Web servers.

●● There are four groups of controls: HTML controls, ASP.NET controls, SharePoint 
controls, and data source controls. 

●● Controls are similar to Web Parts. You place them on a Web page and customize 
their properties to meet your needs.

●● ASP.NET Data controls allow you to define data sources and view the contents of 
data sources. View controls must be bound to a data source. 

●● ASP.NET validation controls use JavaScript by default to validate data entry on the 
client, thereby reducing network traffic when an input form is processed. They can 
be configured so that only server-side logic is used to validate data entry.

●● SharePoint Data View controls expose data as check boxes, radio buttons, or drop-
down lists from which the user can choose. Data View controls are inserted into a 
Data View Web Part and must be bound to a data source. 

●● All built-in SharePoint pages contain SharePoint Server controls.
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A	SharePoint Designer 
Workflow Conditions 
and Actions

SharePoint Designer 2010 includes workflow conditions and workflow actions. Actions 
occur as part of a workflow step and are associated with a condition. The actions and 
conditions listed in this appendix are those you see if you are working on sites in a 
SharePoint Server 2010 installation. For sites created with SharePoint Foundation 2010, 
you see only a subset of these actions.

Conditions
A condition is a filter that can be used to determine which actions run. The following 
table provides an overview of the default conditions you can use in SharePoint Designer. 
Although actions are divided into a number of groups, there are only two relatively small 
groups of conditions. Table A-1 provides an overview of the default conditions you can 
use in SharePoint Designer.

Table A-1  Conditions

Condition Group Description
Common Conditions
If Any Value Equals Value* Creates a filter that lets you compare two values from any 

data source. This condition replaces the Compare Any Data 
Source condition available in SharePoint 2007.

If Current Item Field Equals 
Value*

Creates a filter that lets you compare the current item’s 
field value with a value from any data source. This condition 
replaces the Compare [List or Library] Field condition avail-
able in SharePoint 2007.
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Other Conditions
Created By a Specific Person Creates a filter that lets you specify the user who created 

the list item.
Created in a Specific Date Span Creates a filter that lets you specify the start and end dates 

between which the list item must be created. These dates 
can also be lookup values that are retrieved from a data 
source such as another list on the same SharePoint site or 
from a previously created workflow variable.

If Task Outcome Equals Value** Allows you to undertake actions based on the number or 
percentage of task approvals and rejections. The value in 
this condition can also be a lookup value that is retrieved 
from a data source such as another list on the same 
SharePoint site or from a previously created workflow 
variable.

Modified by a Specific Person Creates a filter that lets you specify the user who last modi-
fied the list item.

Modified in a Specific Date 
Span

Creates a filter that lets you specify the start and end dates 
between which the list item must be modified. These dates 
can also be lookup values that are retrieved from a data 
source such as another list on the same SharePoint site or 
from a previously created workflow variable.

Person Is a Valid SharePoint 
User*

Creates a filter that lets you check whether or not the user is 
anonymous.

The File Size in a Specific 
Range Kilobytes

Creates a filter that lets you specify the minimum and 
maximum file size of a list item. These file sizes can also be 
lookup values that are retrieved from a data source such 
as another list on the same SharePoint site or from a previ-
ously created workflow variable. This condition is available 
only for libraries.

The File Type Is a Specific Type Creates a filter that lets you specify the file type of the 
list item. This value can also be a lookup value that is re-
trieved from a data source such as another list on the same 
SharePoint site or from a previously created workflow vari-
able. This condition is available only for libraries.

Title Field Contains Keywords Creates a filter that lets you specify a value for the Title col-
umn of the list or library the workflow is attached to.

* New in SharePoint 2010.
** New in SharePoint 2010 and available only within Approval workflow tasks by specifying the behavior of a single task. 

See Appendix B, “Creating a New Approval Process,” for more information.
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Core Actions
The core actions are 11 common activities that you use in many of your workflows. They 
allow you to manipulate dates and times, to build a form to collect information from 
users, and to write information to the history list. The default core actions are listed in 
Table A-2.

Table A-2  Core Actions

Action Description
Add a Comment* Allows you to write a string value as an informative comment. This 

value can also be a lookup value that is retrieved from a data source 
such as another list on the same SharePoint site or from a previously 
created workflow variable (defined by you). Comments can be viewed 
in Microsoft Visio Premium 2010.
Every well-designed workflow should provide a generous number of 
comments and logging information. This facilitates the maintenance 
of custom workflows.

Add Time to Date Allows you to add or subtract minutes, hours, days, months, or years 
in a date value. The date is commonly a lookup value that is retrieved 
from a data source such as another list on the same SharePoint site or 
from a previously created workflow variable. 
The output of this action can be saved to a new or existing workflow 
variable. This allows you to reuse the outcome at a later stage of the 
workflow’s life cycle. 

Do Calculation Allows you to add, subtract, multiply, divide, or calculate the modulus 
of two numeric values. These values can also be lookup values that 
are retrieved from a data source such as another list on the same 
SharePoint site or from a previously created workflow variable. 
The output of this action can be saved to a new or existing workflow 
variable.

Log to History List Allows you to write a string value to the workflow history list. This val-
ue can be a lookup value that is retrieved from a data source such as 
another list on the same SharePoint site or from a previously created 
workflow variable. Use this action to write a summary of the workflow 
or information concerning a significant event or for troubleshooting 
purposes.



484    Appendix A  SharePoint Designer Workflow Conditions and Actions

Pause for Duration Allows you to specify in days, hours, and minutes the amount of time 
you want to pause the execution of the workflow. These time values 
can also be lookup values that are retrieved from a data source such 
as another list on the same SharePoint site or from a previously cre-
ated workflow variable.

Pause Until Date Allows you to pause the execution of the workflow and specify the 
date when the workflow needs to be continued. This date can also be 
a lookup value that is retrieved from a data source such as another 
list on the same SharePoint site or from a previously created workflow 
variable.

Send an Email Allows you to create an e-mail message containing string values, look-
up values, formulas, and workflow variables. The action also allows 
you to specify the To, CC, and Subject fields of the e-mail message.

Send Document to 
Repository**

Allows you to copy, move, or move and leave a link referring to a 
document in a record repository.

Set Time Portion of 
Date/Time Field

Allows you to set a specific time in hours and minutes and add this to 
a date. This date can also be a lookup value that is retrieved from a 
data source such as another list on the same SharePoint site or from a 
previously created workflow variable. The output of this action can be 
saved to a new or existing workflow variable.

Set Workflow 
Status*

Allows you to set a custom workflow status to a value other than In 
Progress or Complete. The addition of this action might seem like only 
a minor enhancement of the workflow framework, but this action is 
extremely valuable because your customers probably don't think in 
terms of In Progress and Complete, and you will find that you use this 
action many times when you create workflows. 

Set Workflow 
Variable

Allows you to set the value of a new or existing workflow variable. This 
value can also be a lookup value that is retrieved from a data source 
such as another list on the same SharePoint site or from a previously 
created workflow variable.

Stop Workflow Allows you to stop the workflow. Also allows you to write a string 
value to the workflow history list that is retrieved from a data source 
such as another list on the same SharePoint site or from a previously 
created workflow variable.

* New in SharePoint 2010.
** New in SharePoint 2010 and available only on document libraries.
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Document Set Actions
The actions listed in the Document Set category are completely new. They work on sites 
created on SharePoint Server 2010, which introduced the concept of document sets. 
Document sets are groups of documents that have a specific meaning as a group and 
share a specific life cycle. For instance, all documents related to a certain legal mat-
ter can be grouped as a document set. You will not find these actions on a SharePoint 
Foundation installation. The default document set actions are listed in Table A-3.

Table A-3  Document Set Actions

Action Description
Capture a Version of the 
Document Set*

Allows you to capture the last major or the latest minor ver-
sion of a document set.

Send Document Set to 
Repository*

Allows you to copy, move, or move and leave a link referring 
to a document set in a repository. The output of this action 
can be saved to a new or existing workflow variable.

Set Content Approval Status 
for the Document Set*

Allows you to set the current status of the document set. You 
can also add comments to the document set in the form of 
a string value or a lookup value that is retrieved from a data 
source such as another list on the same SharePoint site or 
from a previously created workflow variable.

Start Document Set Approval 
Process*

Allows you to start a custom approval process for an entire 
document set at once.

* New in SharePoint 2010.

List Actions
This category contains a number of new actions as well as an extensive set of actions 
you might have worked with in SharePoint Designer 2007. List actions allow you to ma-
nipulate list items, including creating, copying, and deleting list items. These actions can 
be applied to documents within libraries as well as to list items because libraries are just 
special lists. This group also includes specific document-related actions, such as undoing 
a check out. The default list actions are shown in Table A-4.
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Table A-4  List Actions

Action Description
Add List Item Permissions** Allows you to grant additional list item permissions to a selec-

tion of SharePoint users.
Check In Item Allows you to check in the current item or specify a column 

name and value that indicate the item that must be checked in. 
This action requires you to specify a check-in comment that is 
either a string value or a lookup value that is retrieved from a 
data source such as another list on the same SharePoint site or 
from a previously created workflow variable. This action can be 
used only with libraries.

Check Out Item Complements the Check In Item action. This action allows you 
to check out the current item or specify a column name and 
value that indicate which item must be checked out.

Copy List Item Allows you to copy an existing list item to another list on the 
SharePoint site. The list item can be the current list item or you 
can select a column and value to indicate which list item you 
want to copy. There must be at least one column that is com-
mon to both lists.

Create List Item Allows you to create a new list item in a list on the SharePoint 
site. You can choose any list you want, but you must specify 
values for all required fields. These values can also be lookup 
values that are retrieved from a data source such as another list 
on the same SharePoint site or from a previously created work-
flow variable.
The list item ID of this action can be saved to a new or existing 
workflow variable.

Declare Record* Allows you to declare an item as a record for records manage-
ment. SharePoint records management functionality allows 
organizations, using some advanced tools, to manage records 
from the time the records are created up to their eventual dis-
posal. Usually, records are managed to adhere to specific com-
pliance regulations.

Delete Drafts* Allows you to delete a draft version of an item. Major and mi-
nor versioning need to be enabled to use this action.

Delete Item Allows you to delete the current item or specify a column name 
and value that indicate which item must be deleted.

Delete Previous Versions Allows you to delete all but the current version of an item. 
Versioning needs to be enabled to use this action.

Discard Check Out Item Allows you to discard the check out of the current item or 
specify a column name and value that indicate for which item 
the check out must be discarded.
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Inherit List Item Parent 
Permissions**

Allows you to specify a list item from which the current list item 
will inherit permissions. Please note that you cannot use this 
action to inherit from list permissions. If you want a list item 
to inherit list permissions, you should not use a workflow ac-
tion; you can configure this via the SharePoint list management 
pages instead. 

Remove List Item 
Permissions**

Allows you to select the list item permissions that will be re-
moved from the current set of permissions for a selection of 
SharePoint users.

Replace List Item 
Permissions**

Allows you to select a set of list item permissions that will 
replace the current permission settings for a selection of 
SharePoint users.

Set Content Approval 
Status*

Allows you to set the current status of the list item. You can 
also add comments in the form of a string value or a lookup 
value that is retrieved from a data source such as another list 
on the same SharePoint site or from a previously created work-
flow variable.

Set Field in Current Item Allows you to specify the value of a selected column of a list 
item. This value can also be a lookup value that is retrieved 
from a data source such as another list on the same SharePoint 
site or from a previously created workflow variable.

Undeclare Record* Complements the Declare Record action. This action allows you 
to roll back the declaration of an item as a record for record 
management.

Update List Item Allows you to update a list item in a list on the SharePoint site. 
You can choose any list you want and specify the values for the 
required fields. This value can also be a lookup value that is 
retrieved from a data source such as another list on the same 
SharePoint site or from a previously created workflow variable.

Wait for Change in 
Document Check-Out 
Status*

Allows you to pause the execution of the workflow until the 
current document check-out status is changed.

Wait for Field Change in 
Current Item

Allows you to pause the execution of the workflow until the 
value of a column in the list or library the workflow is at-
tached to is equal or not equal to the value specified in this 
action. This specified value can also be a lookup value that is 
retrieved from a data source such as another list on the same 
SharePoint site or from a previously created workflow variable. 
In SharePoint Designer 2007, this action was listed in the Core 
Actions category.

* New in SharePoint Designer 2010.
** New in SharePoint 2010 and available only within an impersonation operation.
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Relational Actions
A new category that is available on SharePoint Server 2010 installations. This group con-
tains a single action that helps gather information about the social surroundings of a 
SharePoint user. The default relational action is listed in Table A-5.

Table A-5  Relational Action

Action Description
Lookup Manager of a User* Allows you to look at a SharePoint user's profile and return 

the user's manager specified in the profile. The output of this 
action can be saved to a new or existing workflow variable.

* New in SharePoint 2010.

Task Actions
The task actions manipulate task items. The default task actions are listed in Table A-6.

Table A-6  Task Actions

Action Description
Assign a Form to a Group Allows you to build a custom survey to collect information from 

one or more users. The workflow is paused until all users have 
completed the survey.

Assign a To-do Item Allows you to assign a to-do item in the tasks list to one or 
more users. The workflow is paused until all users have com-
pleted the to-do item.

Collect Data from a User Allows you to create and assign a task to a specified user or 
group. This task can contain custom form fields. The output of 
this action can be saved to a new or existing workflow variable.

Start Approval Process* Allows you to start a custom approval process.
Start Custom Task Process* Allows you to start a custom task process.
Start Feedback Process* Allows you to start a custom feedback process.

* New in SharePoint 2010.

Task Behavior Actions
This is a special group of actions that are available only within approval workflows, such as 
Start Approval Process and Start Feedback Process, described in Appendix B. In such work-
flows, you can add task actions that let you modify the behavior of the task or task process. 
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When the task action is added, a new category, called Task Behavior Actions, is visible. 
The task behavior actions are listed in Table A-7. Depending on the context in a work-
flow, only a subset may be available at any one time.

Table A-7  Task Behavior Actions

Action Description
Append Task** Appends a new task and assigns it to a user. 
Delegate Task** Rescinds a task assigned to the current user and then assigns the 

task to a new user, which could be a single user or a group.
End Task Process* Allows you to end the task process from within the workflow.
Escalate Task** Allows you to assign a task to the manager of the user who is cur-

rently assigned the task.
Forward Task** Similar to the Delegate Task. If the new user is a group, a task is 

created for each member in the group.
Insert Task** Allows you to insert a new stage where the user specified in the 

action is the only participant.
Reassign Task** Reassigns the task to another user.
Request a Change** Allows you to request a change and assign a new task to the cur-

rent user when the change is completed.
Rescind Task** Completes the task without an outcome.
Send a Task Notification 
Email**

Allows you to include the Edit Task button in the e-mail message 
that is sent to specific users.

Set Content Approval 
Status (as author)*

Allows you to set the approval status to Approved, Rejected, or 
Pending. This action runs under the identity of the workflow au-
thor. Use this action if the person who starts the workflow instance 
does not have permissions to approve a document.

Set Task Field** Allows you to set a field within a task item to a value. This value 
can also be a lookup value that is retrieved from a data source 
such as another list on the same SharePoint site or from a previ-
ously created workflow variable. 

Wait for Change in Task 
Process Item*

Waits for any change in the item the task process is running on.

Wait for Deletion in Task 
Process Item*

Waits for the deletion of the item the task process is running on.

* New in SharePoint 2010.
** New in SharePoint 2010 and available only when customizing the Start Approval Process.
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Utility Actions
A new category in SharePoint 2010. It is available on sites created using SharePoint 
Server and SharePoint Foundation. The extract substring actions replace the SharePoint 
Designer 2007 Build Dynamic String core action. The default utility actions are listed in 
Table A-8.

Table A-8  Utility Actions

Action Description
Extract Substring from End 
of String*

Allows you to retrieve a part of a string, starting at the end.

Extract Substring from Index 
of String*

Allows you to retrieve a part of a string, starting at a specific 
position. 

Extract Substring from Start 
of String*

Allows you to retrieve a part of a string, starting at the 
beginning. 

Extract Substring of String 
from Index with Length*

Allows you to retrieve a part of a string of limited length, 
starting at a specific position. 

Find Interval Between Dates* Allows you to find an interval consisting of minutes, hours, or 
days between two dates.

* New in SharePoint 2010.
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B	Creating a New 
Approval Process

Thanks to the new Start Approval Process and Start Document Set Approval Process 
actions provided with Microsoft SharePoint Server 2010, you can now create your own 
approval process. These two actions are similar to the Approval workflow template that 
is available out of the box with SharePoint Server 2010, and they represent generic ap-
proval workflows that can be incorporated into your own custom workflow or amended 
to meet your needs. Prior to using these actions, you must be familiar with how to use 
the Approval workflow template in the browser. Additionally, it is important that you un-
derstand what these actions do and how you can modify them. I’ll cover these topics in 
this appendix. 

These actions are subworkflows—that is, workflow logic is already defined in the ac-
tions, and they use task items that are assigned to one or more users, known as task 
participants. The approval task item contains the fields Status, Due Date, Requested By, 
and Consolidated Comments and also a number of task buttons that depend on the 
configuration of the approval action. The form Approval.xsn is automatically created as 
a Microsoft InfoPath form with four views—Main, ChangeRequest, ChangeView, and 
ReassignTask.
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See Also  For more information about customizing InfoPath forms, see Chapter 9, “Using 
Reusable Workflows and Workflow Forms.”

To explore these actions in SharePoint Designer, create a new workflow (for exam-
ple, a list workflow), and then add either of the aforementioned actions, such as the 
Start Approval Process action, to a step in the workflow, as described in Chapter 8, 
“Understanding Workflows.”
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The Start Approval Process action presents three links that you can use to customize 
the workflow: Approval, Current Item, and These Users. The Current Item link opens the 
Choose List Item dialog box, which you use to assign an object to the approval action.

No initiation form variables are created for these actions. You need to provide the infor-
mation you find on the initiation form for the Approval workflow templates you use in 
the browser as configuration settings on the approval actions. Use the These Users link 
to open the Select Task Process Participants dialog box. The dialog box allows you to 
configure task participants, assignment stages, the task title, the duration per task, and 
the due date for the task process.
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Tip  If you want to mimic the Approval workflow templates in the browser, you need to create 
your own initiation form variables and pass them to the approval action. 

The approval actions create a number of local variables, such as NotificationMessage, 
DueDateforAllTasks, Approvers, and CancelonChange to pass information between the 
different steps. These variables can then be used by subsequent conditions or actions 
that you add to the workflow.

Tip  You can find a list of the local variables by clicking Local Variables on the Workflow tab.

The Approval link is quite different from other workflow action and condition links you 
have seen in this book. This link does not display a dialog box, but instead displays a 
page—the Approval page—that details the approval subworkflow. You can use the links 
on the Approval page to customize the subworkflow. The Start Feedback Process action 
can be similarly configured.

Local Variables
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●● The Approval page contains the following areas: Task Information  Use to specify 
the name of the new approval process, which should be descriptive of the type of 
approval process you are creating and meaningful to users of this workflow. The 
Task Information area also allows you to specify the owner of the task process, 
which can be a user or a SharePoint group. Additional information about owners is 
described in the section about the Settings area of the page later in this appendix.

●● Task Form Fields  Use to collect information via a task form. You can add more cus-
tom data fields by clicking New in the title bar of the Task Form Fields area or by 
using the Form Fields tab and clicking New Site Column in the New group. The Add 
Field dialog box opens. You use this dialog box to create a site column.

Tip  Before you create a site column, check whether that site column already exists. By 
avoiding duplication, you prevent confusion about having a large number of similar site 
columns. When you create a site column, use a meaningful name so that other users who 
are creating solutions can easily identify the purpose and use of the site column.

You can also create custom data fields from an existing site column by clicking 
Choose Existing Field in the title bar of the Task Form Fields area or by using the 
Form Fields tab and clicking Add Existing Site Column in the New group. The Site 
Columns Picker dialog box opens.

Add Existing 
Site Column
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Tip  To activate the Form Fields tab on the ribbon, click Column Name in the Task Form 
Fields area. 

●● Task Outcomes  Use to define the various outcomes for the approval process. By 
default, the outcomes Approved and Rejected are created. Outcomes are dis-
played as separate buttons on the task completion form in sequence order. You can 
add more outcomes by clicking New in the title bar of the Task Outcomes area or 
by using the Outcomes tab and clicking Outcome in the New group. The Outcomes 
tab also allows you to rename or delete an outcome or to move an outcome up or 
down to change the sequence order.

Tip  To activate the Outcomes tab on the ribbon, click one of the outcomes in the Task 
Outcomes area. 

●● Settings  Contains the following three options:

❍❍ Only Allow Task Recipients And Process Owners To Read And Edit 
Workflow Tasks  Select this option if you want only the task recipients and 
the process owner specified in the Task Information area to have read and 
edit access to workflow tasks.

Outcome

New Site Column
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❍❍ Reassignment  Select this option to display an extra button on the task form 
that allows the task recipient to reassign the task to somebody else.

❍❍ Change Request  Select this option to display an extra button on the task 
form that allows the task recipient to change the request itself.

●● Customization area  Contains four links:

❍❍ Return To The Workflow  Use this link to display the workflow editor.

❍❍ Change The Completion Conditions For This Task Process  Select this link 
to display the Completion Conditions page. This page shows the actions that 
run every time a task is completed. You can add more conditions, actions, and 
steps and modify the completion conditions as needed.

❍❍ Change The Behavior Of A Single Task  Select this link to display the Task 
Behaviors page. This page contains five steps that are triggered by the follow-
ing events:

The On Task Assigning event triggers the Before A Task Is Assigned step. This 
step is executed before individual task items are created.
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The On Task Pending event triggers the When A Task Is Pending step. This 
step is executed after an individual task item is created. The default configura-
tion of this step adds history items to the workflow history list and sends task 
notifications via e-mail.

The On Task Expired event triggers the When A Task Expires step. This step 
runs when a task item does not have a Completed status after the task’s due 
date has expired. It sends an e-mail task notification to the participant(s) the 
task is assigned to.

The On Task Deleted event triggers the When A Task Is Deleted step. This step 
runs when a task item is deleted. Two history log items are created, noting 
who deleted the task item and that the task item was automatically rejected 
because it was deleted. An e-mail notification is then sent to the participant(s) 
the task is assigned to.
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The On Task Completed event triggers the When A Task Completes step. This 
step is run every time a task is completed. It adds history workflow items and 
sets a local variable, CompletionReason, if the task item was rejected and the 
approval process is configured to cancel the workflow instance if a task item 
is rejected.

❍❍ Change The Behavior Of The Overall Task Process  Select this link to display 
the Task Process Behaviors page. Most of the steps on this page set values 
to many of the local variables, depending on the event that is triggered. This 
page contains four steps that are triggered by the following events:

On Approval Started  This event runs when an approval workflow instance 
starts.
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On Approval Running  This event runs before an approval workflow instance 
assigns its first task item. It consists of two nested steps that run in parallel.

On Approval Canceled  This event runs when a task process is canceled.
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On Approval Completed  This event runs when the last individual task is 
completed or when the End Task Process action is run.





	     503

C	Administrative Tasks 
Using SharePoint 
2010

This appendix details tasks that you might find you need to complete. Explanations of 
these tasks are outside the scope of this book, but they can be found in the following 
resources:

●● Microsoft SharePoint Foundation 2010 Step by Step, by Olga Londer and Penelope 
Coventry (Microsoft Press, 2011). Print ISBN: 978-0-7356-2726-0, ISBN 10: 0-7356-2726-6.

●● Microsoft SharePoint 2010 Administrator’s Companion, by Bill English, Brian 
Alderman, and Mark Ferraz (Microsoft Press, 2011). Print ISBN: 978-0-7356-2720-8, ISBN 
10: 0-7356-2720-7.

●● Microsoft SharePoint 2010 Administrator’s Pocket Consultant, by Ben Curry (Microsoft 
Press, 2010). Print ISBN: 978-0-7356-2722-2, ISBN 10: 0-7356-2722-3.

SharePoint 2010 products on Microsoft’s TechNet site, at technet.microsoft.com/en-us / li-
brary/ee428287(office.14).aspx.

This appendix describes the following administrative tasks:

●● Downloading, installing, and configuring SharePoint Foundation 2010 on a single 
server with a built-in database.

●● Creating a site collection.

●● Enabling all site templates on a SharePoint Server site.

●● Restricting the use of SharePoint Designer 2010 at the Web-application level.

●● Configuring permissions on external content types.

●● Configuring the external content type profile page host.

●● Enabling or disabling user-defined workflows.

http://technet.microsoft.com/en-us/library/ee428287(office.14).aspx
http://technet.microsoft.com/en-us/library/ee428287(office.14).aspx
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Installing SharePoint Foundation 2010
This section details how to download, install, and configure SharePoint Foundation 
2010 on a single server with a built-in database. This server can be used as a temporary 
SharePoint environment. More information about server computer requirements can be 
found in “Using the Practice Files” at the beginning of this book.

See Also  For more information on deploying a single server with a built-in database, see 
technet.microsoft.com/en-us/library/cc288005(office.14).aspx.

Important  You need to follow these steps only if you do not already have access to a 
SharePoint environment.

SET UP  Open your browser on the computer where you want to install SharePoint 
Foundation 2010 before beginning this exercise.

1.	 Browse to www.microsoft.com/downloads/ and search for SharePoint 
Foundation 2010.

2.	 In the list of results, click the most recent copy of SharePoint Foundation 2010—
that is, the download with the title Microsoft SharePoint Foundation 2010 with 
SPx, where x is the number of the latest service pack. If no service pack has been 
released, click Microsoft SharePoint Foundation 2010.

Tip  At the time of writing, the link that points to the most recent copy of 
SharePoint Foundation 2010 is www.microsoft.com/downloads/en/details.
aspx?FamilyID=49c79a8a-4612-4e7d-a0b4-3bb429b46595.

3.	 Click Download. Click Save, and save the file to your computer’s Desktop.

4.	 Double-click the file you downloaded.

5.	 On the Microsoft SharePoint Foundation 2010 start page, below Install, click 
Install software prerequisites.
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6.	 On the Welcome to the Microsoft SharePoint 2010 Products Preparation Tool 
page, click Next.

7.	 If you agree with the Microsoft Software License Terms, select the I accept the 
terms of the License Agreement(s) check box, and click Next.

The prerequisites are downloaded from the Internet and installed. This step can 
take some time; please be patient.

8.	 On the Your system needs to restart to continue. Press Finish to restart your 
system page, click Finish.
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9.	 After the computer has rebooted, log on as an administrator to complete the in-
stallation of the software prerequisites, and then on the Installation Complete 
page, click Finish.

10.	 Double-click the file that you saved on your computer’s Desktop.

11.	 On the Microsoft SharePoint Foundation 2010 start page, below Install, click 
Install SharePoint Foundation. If you agree with the Microsoft Software 
License Terms, select the I accept the terms of this agreement check box, and 
click Continue.

12.	 Click Standalone to begin the installation.

Important  You should use a stand-alone installation only for a developer or evaluation 
SharePoint installation.

13.	 On the Run Configuration Wizard page, leave the Run the SharePoint Products 
Configuration Wizard now check box selected, and click Close.

The SharePoint Products Configuration Wizard launches automatically.

14.	 On the Welcome to SharePoint Products page, click Next. In the warning box 
that appears, click Yes to acknowledge that some services need to be stopped dur-
ing configuration.

SharePoint Foundation is installed and configured. This step can take some time; 
please be patient.

15.	 On the Configuration Successful page, click Finish.

The browser will open the home page of the top level of a site collection. This top-
level site is created using the Team Site template.

Troublshooting  Depending on how your server is configured, you might be prompted 
to log on. Enter the administrator’s user name and password.

CLEAN UP  Close the browser.

Creating a Site Collection
If you have been given total control of a SharePoint environment for the purpose of 
completing the exercises in this book and need to create a site collection, complete the 
following steps.

SET UP  Log on with sufficient rights to use the SharePoint 2010 Central 
Administration Web site.
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16.	 On the Windows taskbar, click the Start, point to All Programs, click Microsoft 
SharePoint 2010 Products, and then click SharePoint 2010 Central 
Administration.

17.	 If the User Account Control dialog box appears, click Yes, or if prompted, type 
your user name and password, and then click OK.

18.	 In the Application Management section, click Create site collections.

The Create Site Collection page is displayed.

Tip  In the Web Application section, if the Web application in which you want to create 
the site collection is not selected, click the arrow to the right of the Web application 
name, and then click Change Web Application. On the Select Web Application page, 
click the Web application in which you want to create the site collection.

19.	 In the Title and Description section, type the title and description for the site 
collection.

20.	 In the Web Site Address section, under URL, select the path to use for your URL 
(for example, an included path such as /sites/, or the root directory, /).

21.	 In the Template Selection section, in the Select a template list, select the tem-
plate that you want to use for the top-level site in the site collection. For the 
purposes of this book, choose Team Site from the Collaboration tab if you 
are working with SharePoint Foundation. Choose Publishing Portal from the 
Publishing tab if you are using SharePoint Server.

22.	 In the Primary Site Collection Administrator section, enter the user name (in the 
form DOMAIN\username) for the user who will be the site collection administrator.

23.	 Click OK.

CLEAN UP  Close the browser.

Enabling All Site Templates on a 	
SharePoint Server Site

In a SharePoint Server environment, when you want to create a new site, you might find 
that the site template you want to use in the browser is not listed on the Create page.

Troubleshooting  If you want to base the new site on one of the practice solution .wsp files, 
be sure you have first uploaded the file to the Solutions gallery. See “Using the Practice Files” 
section at the start of the book.
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To make the site template visible in the site template list, complete the following 
steps. These steps can be completed only on publishing sites or on sites on which the 
SharePoint Server Publishing Infrastructure site-collection feature and the SharePoint 
Server Publishing site feature are enabled.

SET UP  In your browser, display the home page of the SharePoint site where you 
want to create the new site as a subsite. You must be logged on as a member of the 
Site Owners group.

24.	 On the Site Actions menu, click Site Settings.

The site settings page is displayed.

25.	 In the Look and Feel section, click Page layouts and site templates.

The Page Layout And Site Template Settings page is displayed.

26.	 In the Subsite Templates section, select Subsites can use any site template, and 
then click OK.

The site settings page is displayed.

CLEAN UP  Close the browser.

Note  These steps affect the visiblity of site templates when you are using the browser. This 
procedure does not restrict the site templates available when you use SharePoint Designer.

Restricting the Use of SharePoint Designer 2010 at 
the Web-Application Level

SharePoint Designer 2010 is a powerful tool that you can use to create robust, business-
focused solutions that require little if any knowledge of the code that is needed to make 
them work. This does not mean that SharePoint Designer should be used by everyone in 
an organization. The use of SharePoint Designer can be restricted in many ways. Perhaps 
the easiest is for the site owner to give users of the site only the minimum permission 
rights they need to complete their tasks. However, a SharePoint server administrator can 
restrict at the Web-application level what site collection administrators can and cannot 
do with SharePoint Designer. 
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Note  The SharePoint Designer settings at the Web-application level are the same as those 
available at the site-collection level, which are detailed in Chapter 1, “Exploring SharePoint 
Designer.” However, when configured at the Web-application level, these settings affect all 
site collection administrators, site collections, and sites within the Web application. When they 
are configured at the site-collection level, they apply only to site owners and designers and 
sites within that site collection.

To apply restrictions at the Web-application level, complete the following steps.

SET UP  Log on with sufficient rights to use the SharePoint 2010 Central 
Administration Web site.

27.	 On the Windows taskbar, click Start, point to All Programs, click Microsoft 
SharePoint 2010 Products, and then click SharePoint 2010 Central 
Administration.

28.	 If the User Account Control dialog box appears, click Yes. If prompted, type your 
user name and password, and then click OK.

29.	 In the Application Management section, click Manage web applications.

The Web Applications page is displayed.

30.	 Click the Web application for which you want to restrict the use of SharePoint 
Designer. On the ribbon, in the Manage group on the Web Applications tab, click 
General Settings, and then click SharePoint Designer.

The SharePoint Designer Settings dialog box is displayed.

31.	 Clear or select the check boxes as needed, and then click OK.

CLEAN UP  Close the browser.
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Configuring Permissions on External Content Types
When an external content type (ECT) is created by SharePoint Designer, by default no 
permissions are configured to allow users to see the data in external lists created from 
the ECT. 

To set permissions on an ECT, your SharePoint server administration needs to take the 
following steps on the SharePoint 2010 Central Administration Web site.

SET UP  Log on with sufficient rights to use the SharePoint 2010 Central 
Administration Web site.

32.	 On the Windows taskbar, click Start, point to All Programs, click Microsoft 
SharePoint 2010 Products, and then click SharePoint 2010 Central 
Administration.

33.	 If the User Account Control dialog box appears, click Yes, or if prompted, type 
your user name and password, and then click OK.

34.	 In the Application Management section, click Manage service applications.

The Service Applications page is displayed.

35.	 Click the name of the Business Data Connectivity service for which you want to 
manage permissions.

36.	 On the Service Application Information page, on the Edit tab, check that 
External Content Types is selected in the View group, and then select the check 
box to the left of the ECT for which you want to configure permissions, such as SPD 
SBS Customers.

37.	 On the Edit tab, click Set Object Permissions in the Permissions group.

38.	 In the Set Object Permissions dialog box, enter the appropriate users or groups 
and assign the appropriate permissions.

CLEAN UP  Close the browser.
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Configuring the External Content Type 	
Profile Page Host

The Business Data Connectivity service profile pages are used to display the details of an 
instance of an ECT. In SharePoint Foundation, you must build these profile pages yourself 
and place controls or Web Parts to display the data. In SharePoint Server, once the pro-
file page hosted location is configured, you can create profile pages with one click of a 
button by using the Central Administration Web site or SharePoint Designer.

To configure the profile page host use the following steps.

39.	 Open a browser, and go to the SharePoint 2010 Central Administration Web 
site.

40.	 Under Application Management, click Manage Service Applications.

41.	 On the Service Applications page, click the name of the Business Data 
Connectivity service that you want to configure.

42.	 On the Edit tab, click Configure in the Profile Pages group.

The Configure External Content Type Profile Page Host dialog box is displayed.

43.	 Select the Enable Profile Page Creation option, and type the URL of the site 
where the profile page will be hosted.

44.	 Click OK. The Configure External Content Type Profile Page Host dialog box closes.

CLEAN UP  Close the browser.

Enabling or Disabling User-Defined Workflows
At the Web-application level, SharePoint server administrators can control the ability 
of users to use, create, modify, and publish SharePoint 2010 declarative workflows, such 
as those created using SharePoint Designer and some of the out-of-the-box work-
flows, such as Collect Feedback—SharePoint 2010, Approval—SharePoint 2010, Collect 
Signatures—SharePoint 2010, and Publishing Approval. By default, user-defined workflows 
are enabled whenever a Web application is created.
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Tip  The Disposition Approval, Three-State, Schedule Web Analytics Alert, and Schedule Web 
Analytics Reports workflow templates are not user-defined workflows. When user-defined 
workflows are disabled at the Web-application level, you can still create, modify, and use 
workflows that have been created from these workflow templates.

When you disable user-defined workflows and then try to create a workflow in 
SharePoint Designer, a dialog box opens explaining that user-defined workflows have 
been disabled by the SharePoint administrator, and you will not be able to create any 
new workflows.

When user-defined workflows are disabled, existing user-defined workflows are not de-
leted. You can modify existing user-defined workflows and save them. However, when 
you try to publish a modified workflow, a Workflow Error dialog box appears, stating 
that the workflow files were saved but cannot be run.

To enable or disable user-defined workflows, complete the following steps.

SET UP  Log on with sufficient rights to use the SharePoint 2010 Central 
Administration Web site.

45.	 On the Windows taskbar, click Start, point to All Programs, click Microsoft 
SharePoint 2010 Products, and then click SharePoint 2010 Central 
Administration.

46.	 If the User Account Control dialog box appears, click Yes, or if prompted, type 
your user name and password, and then click OK.
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47.	 In the Application Management section, click Manage web applications.

The Web Applications page is displayed.

48.	 Click the Web application for which you want to restrict the use of SharePoint 
Designer. On the ribbon, in the Manage group, click General Settings, and then 
click Workflow.

The Workflow Settings dialog box is displayed.

49.	 In the User-Defined Workflows section, select the Yes or No option as needed, and 
then click OK.

CLEAN UP  Close the browser.
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Glossary
association  A relationship between two external 

content types (ECTs).

BCS  See Business Connectivity Services (BCS).

BDC  See Business Data Connectivity (BDC).

breadcrumb  A sequence of links that allows us-
ers to navigate or keep track of their location. 
See global navigation breadcrumb and local 
breadcrumb.

Business Connectivity Services (BCS)  Enables 
users to read and write data from external 
systems through Web services, databases, and 
Microsoft .NET Framework assemblies.

Business Data Catalog  A SharePoint Server 
2007 feature that provides connectivity to 
back-end business systems and data sources. 
Renamed Business Connectivity Services (BCS) 
in SharePoint 2010.

Business Data Connectivity (BDC)  The BDC pro-
vides the BCS connectivity component. It uses 
the declarative model that you can create us-
ing SharePoint Designer.

cascading style sheet (CSS)  A style sheet lan-
guage interpreted by a browser that describes 
the presentation of a Web page.

child site  A site within a site collection, where 
there is a hierarchy of a top-level site and one 
or more child sites, also called subsites.

Code view  Displays the code that a page con-
tains, showing the HTML tags, client-side script 
(such as JavaScript), and controls. The code ele-
ments are color-coded to make it easier to dis-
tinguish the text that users see in their browser 
from the code surrounding the text. Each line 
of code is numbered so that error messages 
can reference them, and you can quickly iden-
tify problems.

column  A SharePoint list or library contains col-
umns or fields that define the kind of data that 
is collected for each list item or document. The 
values that each column contains are referred 
to as metadata.

composite key  A primary key that is made from 
multiple columns.

content page  An ASP.NET page that is combined 
with a master page on the Web server to pro-
duce an HTML page that is sent to the client to 
be rendered in the browser. An example of a 
content page is the home page of a SharePoint 
site, Home.aspx

content placeholder  Placed on a ASP.NET master 
page; it defines a region for content and ren-
ders all text, markup, and server controls from 
the related content control found on a content 
page.

content region  An alternative name for a content 
placeholder.

content types  Content types define a reusable 
collection of settings that can include columns, 
workflows, and other attributes.

contributor settings  Settings that control how 
SharePoint Designer 2007 can be used to mod-
ify a SharePoint site. This feature was removed 
in SharePoint Designer 2010 and replaced with 
advanced edit mode and restrictions that can 
be placed on SharePoint Designer 2010 at the 
Web-application and site-collection levels.

controls  Components that are commonly used 
on Web sites. Controls are defined to display a 
calendar, change a password, or validate entry 
in an input form, for example.

CSS specificity   Determines which CSS style is ap-
plied by a browser.

custom actions  Define an extension to the user 
interface, such as a command on the server 
ribbon, a link on the site settings page, or a 
command on the list item menu.
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customized Web page  A Web page that is stored 
in the SQL Server content database. Previously 
known as an unghosted Web page in Windows 
SharePoint Services 2.0, where they caused 
significant performance implications. These 
performance implications have mostly been 
removed from Windows SharePoint Services 
3.0 and Microsoft SharePoint Foundation 2010 
with the use of ASP.NET 2.0, master pages, and 
SharePoint features. Web pages cannot be 
customized using the browser, but they can be 
customized by using SharePoint Designer.

custom master page  This is a site property, rep-
resented by the token ~masterurl/customer.
master, that is used by publishing pages in a 
publishing site.

Data Form Web Part (DFWP)  A Web Part that 
reads data from and writes data to a data 
source in the form of XML and applies XSLT to 
it. SharePoint Designer allows you to add Data 
Form Web Parts to a Web Part page and has 
a WYSIWYG XSLT editor, so you don’t need to 
know XSLT to customize a Data Form Web Part.

Data View Web Part (DVWP)  A Web Part that 
allows you to view and manage data coming 
from different data sources. See Data Form 
Web Part (DFWP).

default master  This is a site property, repre-
sented by the token ~masterurl/default.master, 
that points to a master page that is used by all 
pages in your site.

Design view  Displays the page in the SharePoint 
Designer workspace as it would appear in a 
browser and provides a WYSIWYG editing 
environment.

dirty page  A page that you have changed us-
ing SharePoint Designer but have not saved. 
Denoted by an asterisk on the page tab.

dynamic-link library (DLL)  A shared program li-
brary, also known as an assembly. For example, 
when you create a solution for SharePoint in 
Visual Studio 2010 that includes several class 
or program files and then build that solution, 

Visual Studio generates a file name with the 
extension .dll.

ECT  See external content type.

Extensible Application Markup Language 
(XAML)  A language used by the Windows 
Workflow Foundation (WF) to describe 
workflows.

eXtensible Markup Language (XML)  A defined 
markup language for documents that describes 
document content and structure rather than 
appearance. An XML document has to be for-
matted before it can be read, and the format-
ting is usually accomplished by using an XSL 
template file.

eXtensible Stylesheet Language (XSL)  A lan-
guage used to create stylesheets for XML, 
similar to CSS (cascading style sheets) used for 
HTML. XSL Transformations (XSLT) can be used 
to transform XML to HTML or to another type 
of XML.

eXtensible Stylesheet Language Transformation 
(XSLT)  A language for transforming XML doc-
uments into other XML documents.

external content type (ECT)  Represents data 
that is stored in an external data source, such 
as a SQL Server or other relational database, 
SharePoint, and Web services. ECTs are cre-
ated using SharePoint Designer 2010 or Visual 
Studio 2010.

external data column  A column in a list or library 
that stores data that originally existed outside 
SharePoint.

external list  Used to present data that is stored 
outside SharePoint.

feature  Allows you to activate/deactivate func-
tionality in a site, site collection, Web applica-
tion, or farm.

field controls  Used on page layouts to define 
the strict layout and data entry constraints of 
content. They bind to columns in the Pages 
publishing library.
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File Transfer Protocol (FTP)  Protocol used for 
copying files to and from remote computer 
systems on a network using TCP/IP. The mech-
anism cannot be used on SharePoint sites, and 
the FTP client was removed from SharePoint 
Designer 2010.

foreign key  A column that points to the primary 
key of another list or database table. This es-
tablishes a relationship between the two lists 
or between two database tables.

formula column  Additional columns that can be 
created using the XPath Expression Builder.

ghosted Web pages  The same as uncustomized 
Web pages.

globally reusable workflow  A workflow that 
can be used as a workflow template that is 
reusable for all sites within a site collection. 
SharePoint Server 2010 is shipped with three 
globally reusable workflows. Additional glob-
ally reusable workflows can be created using 
SharePoint Designer.

global master pages  Master pages defined cen-
trally and used by most sites, no matter which 
site definition the site is created from.

global meeting workspace master page  A 
Master page defined centrally and used by all 
sites created from a meeting workspace site 
definition.

global navigation breadcrumb  A navigation icon 
next to Site Actions that displays the ScreenTip 
“Navigate Up” and shows the path from the 
top-level site to the current site. See also local 
breadcrumb. Users can use a combination of 
the two breadcrumbs to navigate or keep track 
of their location.

HTTP GET method  Used to communicate with  
the Web server. The information is appended 
to the end of the URL. Usually used to retrieve 
data from the Web server.

HTTP POST method  Used to communicate with 
the Web server. The information is provided in 
the body of the request. Used to transmit data 
to the Web server, where the data is stored, 

updated, or deleted. The data could also in-
volve ordering a product or sending an e-mail 
message.

inline editing  A configured page that can be 
used to display, edit, insert, or delete list items, 
where links are added to every row so that 
in the browser you can edit items directly in 
place.

layer  An absolute positioned HTML division 
<div> tag. You use the <div> tag to group ele-
ments so that you can format them with styles 
or create animations or flyout menus.

library  A specialized list that contains files and 
metadata properties associated with those 
files. Microsoft SharePoint Foundation 2010 
has four types of libraries: Document, Form, 
Wiki Page, and Picture. SharePoint Server 2010 
contains additional libraries, such as Report, 
Translation Management, Data Connection, 
and Slide. See list.

list  A container that stores structured tabular 
data items that are related to one another 
through similar values, metadata, or security 
settings. Lists provide columns for storing 
metadata and a user interface for viewing and 
managing the items.

list template  A definition of a list that you can 
use as a blueprint to create a new list or library 
in the browser. List templates are stored in the 
SQL Server database and include information 
about the columns, list views, and forms to be 
created, plus general settings such as whether 
versioning or content approval is enabled 
when the list is created. Optionally, list tem-
plates can contain content—that is, list items 
or, if the list template is for a library, docu-
ments together with their metadata.

local breadcrumb  A sequence of links that shows 
the path from the home page of a site to the 
current page. See also global navigation bread-
crumb. Users can use a combination of the two 
breadcrumbs to navigate or keep track of their 
location.
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master page  A special ASP.NET 2.0 Web page 
that allows you to share code between pages. 
There primary use is to provide a Web site with 
a consistent look and feel and navigation for 
each page within a site

metadata  Data about data. For example, the 
metadata for a file can include the title, sub-
ject, author, and size of the file. In a document 
library, the metadata for a file is stored in the 
columns of the document library.

namespace  Defines an entry point within an as-
sembly. All controls that are similar are placed 
in the same namespace.

NaN  Not a Number; a label displayed when you 
use a presentation column in an XPath expres-
sion to complete mathematical computations.

node  An XPath reference to XML elements, attri-
butes, and content

On Object User Interface (OOUI)  A small arrow 
floating just outside a control that can be used 
to toggle the visibility of a task panel.

page layout  A page template that strictly controls 
the layout of content on a page. Publishing 
pages are based on a page layout.

personas  Characters created to represent differ-
ent user types within a targeted demographic 
or with a specific attitude and/or behavior set 
that might use a site, brand, or product in a 
similar way.

PlaceHolderMain  A SharePoint content place-
holder control that defines a region of a page 
that contains unique content on a per page 
basis.

primary key  A unique identifier for each row in a 
database table or for each list item in a list.

Publishing Portal  A site hierarchy for an Internet-
facing and intranet-facing Web site. It includes 
a home page and subsites. Most of these 
Web sites are based on the Publishing Site 
With Workflow template that uses SharePoint 
Server Web content management functionality. 
Typically, these Web sites have more readers 
than contributors.

Publishing site  A Web site that uses SharePoint 
Server Web content management functionality. 
Contributors can work on draft versions of a 
publishing page, which, once it is approved, is 
made visible to readers. The approval process 
is also known as publishing.

Recycle Bin  You can use the Recycle Bin to re-
store items that have been deleted from the 
Web site. It provides two-stage protection 
against accidental deletions. When you delete 
a document or other item from the SharePoint 
site, it is deleted from the Web site and moved 
to the Web site’s Recycle Bin, where it can be 
restored if needed. If you then delete this item 
from the Web site’s Recycle Bin, it is moved to 
the site collection’s Recycle Bin. From there, the 
document can be restored to its original loca-
tion or permanently deleted.

Representational State Transfer (REST)  Similar 
to a SOAP service in that it allows the trans-
port of XML data between computer systems. 
However, unlike a SOAP service, REST supports 
only the four basic application methods: GET, 
POST, PUT, and DELETE.

REST  See Representational State Transfer (REST).

Section 508  U.S. government accessibility 
guidelines.

SharePoint farm  One or more servers that are 
used in a SharePoint installation and share one 
SharePoint configuration database.

Simple Object Access Protocol (SOAP)  A protocol 
for transporting XML data between computer 
systems, normally using HTTP or HTTPS.

site collection  A set of Web sites in a Web appli-
cation that has the same owner and that share 
administrative settings. Each Web site collec-
tion contains a top-level Web site and can con-
tain one or more subsites, also known as child 
sites. You can have multiple site collections 
within each Web application.

site column  A reusable column that is created at 
the site collection or site level and can be used 
across multiple sites, lists, and libraries.
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site definition  A set of files that define the capa-
bilities of a SharePoint site. Site definition files 
include .xml, .aspx, .ascx, and .master page 
files, as well as document template files (for 
example, .dotx and .htm) and content files (for 
example, .gif and .docx). The files are located 
in the \\Program Files\Common Files\Microsoft 
Shared\web server extensions\14\TEMPLATE 
subdirectories of Web front-end servers that 
run SharePoint Foundation or SharePoint 
Server.

site template  A blueprint used to create a 
SharePoint site, which can automatically gener-
ate lists, libraries, Web Parts, and features. This 
term can refer to a site definition or to a file 
that captures the configuration and customiza-
tions of a Web site at a point in time.

Split view  Divides the SharePoint Designer work-
space horizontally and displays Code view at 
the top and Design view at the bottom.

subsite  See child site.

top-level site  A Web site that does not have a 
parent Web site. The top-level site in a site 
collection is created from the SharePoint 2010 
Central Administration Web site.

uncustomized Web page  A Web page that refer-
ences files on the file system of a SharePoint 
front-end server. In Windows SharePoint 
Services 2.0, these were known as ghosted 
Web pages. From a technical perspective, the 
SharePoint SQL Server content database con-
tains a row in one of its tables for each Web 
page on a SharePoint site. For an uncustomized 
Web page, this row contains a pointer to the 
file on the file system.

unghosted Web pages  The same as customized 
Web pages.

Universal Data Connection (UDC)  An XML file 
format that contains data connection infor-
mation; used when creating data sources in 
SharePoint Designer.

URL  An alphanumeric address that is used to lo-
cate a Web site.

variations  Part of the SharePoint Web content 
management functionality. Variations make 
content available to specific audiences on dif-
ferent sites by copying content from a source 
site to each target variation site. Often use to 
build multilingual sites.

view  A Web page that displays a subset of the 
contents of a list or library based on specific 
criteria defined by the metadata. Views allow 
you to find information easily.

Web application  Previously referred to as a vir-
tual server, a Web application hosts SharePoint 
site collections that users can access over the 
HTTP or HTTPS protocol. The clients may be 
browsers or other servers.

Web Content Accessibility Guidelines 
(WCAG)  Part of a series of Web accessibility 
guidelines published by the World Wide Web 
Consortium’s Web Accessibility Initiative.

Web Part  A modular unit of information that 
consists of a title bar, a frame, and content. 
Web Parts are the basic building blocks of a 
Web Part page.

Web Part zone  A rectangular region on a Web 
page that facilitates working with Web Parts.

Web Service Description Language (WSDL)  The 
description of the methods and parameters 
that a SOAP service supports. The service 
definition can be registered in a Universal 
Description Discovery and Integration (UDDI) 
registry.

workflow associator  The person who associates a 
workflow template with a list, library, content 
type, or site.

Workflow Interchange (.vwi) file  A Microsoft Visio 
2010 zip file that contains workflow files used 
to import the workflow design into SharePoint 
Designer.

XML  See eXtensible Markup Language (XML).

XML Path Language (XPath)  Provides a mecha-
nism to manipulate and navigate through 
XML data. XPath models XML data as a tree of 
nodes. See node.
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XML Web services  Computer systems that pro-
vide services to other computer systems. The 
data is transferred between computer systems 
formatted as XML and is transported using 
the Simple Object Access Protocol (SOAP). The 
computer system that requests data is called 
the XML Web Service Requester or client, and 
the computer system that provides XML data is 
called the XML Web Service Provider.

XPath  See XML Path Language (XPath).

XSL  See eXtensible Stylesheet Language (XSL).

XSLT  See eXtensible Stylesheet Language 
Transformation (XSLT).
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Index

A
Access

creating linked tables  231–234
accessibility  401

assistive technologies  419
best practices  403
colors  411

testing  412–414
legislation  418–423

maintaining compliance  423–426
testing  418–423

Accessibility task pane  421–423
checklist  420–421

third-party tools  425–426
UCD methodology

implementing  402–403
Accessibility Checker dialog box  421–422
Accessibility Foundation Module (AFM)  425
Accessibility Properties dialog box  157
Accessibility Report.htm file  426
Accessibility task pane  26

testing accessibility  421–423
Accessible Rich Internet Applications (ARIA)  425
accessing

sites  52
Action command  261
actions  258–264

Collect Data from a User  267
core  259, 483–484

Add a comment  483
Add Time to Date  483
Do Calculation  483
Log to History List  483
Pause for Duration  484
Pause Until Date  484
Send an Email  484
Send Document to Repository  484
Set Time Portion of Date/Time Field  484
Set Workflow Status  484
Set Workflow Variable  484
Stop Workflow  484

creating  260–262
document set  259

Capture a Version of the Document Set  485
Send Document Set to Repository  485

Set Content Approval Status for the Document 
Set  485

Start Document Set Approval Process  485, 491
list  259

Add List Item Permissions  486
Check In Item  486
Check Out Item  486
Copy List Item  486
Create List Item  486
Declare Record  486
Delete Drafts  486
Delete Item  486
Delete Previous Versions  486
Discard Check Out Item  486
Inherit List Item Parent Permissions  487
Replace List Item Permissions  487
Set Content Approval Status  487
Set Field in Current Item  487
Undeclare Record  487
Update List Item  487
Wait for Change in Document Check-Out 

Status  487
Wait for Field Change in Current Item  487

parallel blocks  259
creating  260–262

relational  260
Lookup Manager of a User  488

serial  259
Start Custom Task Process  260
task  260

Assign a Form to a Group  488
Assign a To-do Item  488
Collect Data from a User  488
Start Approval Process  488, 491, 493–494
Start Custom Task Process  488
Start Feedback Process  488, 494

task behavior
Append Task  489
Delegate Task  489
End Task Process  489
Escalate Task  489
Extract Substring from End of String  490
Extract Substring from Index of String  490
Extract Substring from Start of String  490
Extract Substring of String from Index with 

Length  490
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actions, task behavior (continued)
Find Interval Between Dates  490
Forward Task  489
Insert Task  489
Reassign Task  489
Request a Change  489
Rescind Task  489
Send a Task Notification Email  489
Set Content Approval Status (as author)  489
Set Task Field  489
Wait for Change in Task Process Item  489
Wait for Deletion in Task Process Item  489

utility  260
Visio Premium 2010  283

activities (workflows)  258
Add a comment action  483
Add a Comment category (core actions)  259
Add And Customize permission

creating profile pages  234
Add A Workflow page  299
Add Column dialog box  293
Add Field dialog box  265, 303, 495
Add File To Import List dialog box  102, 360
Add List Item Permissions action  486
Add Permissions dialog box  42
Add Time to Date action  483
administrative tasks  503

configuring SharePoint Foundation 2010  504–507
installing SharePoint Foundation 2010  504–507

administrators
site collections  32

ADO.NET Data Services  192
AdRotator control  464, 465
ADRotator.xml  464
Advanced Grouping dialog box  150
Advance Mode command  25
Advance Sort dialog box  161, 162
AFM (Accessibility Foundation Module)  425
AJAX (Asynchronous JavaScript and XML)  176
All Files gallery  121–123
All Files gallery page  74
All Files option  102, 137
All Items view

modifying  121–123
All Operations dialog box  218, 220, 224
All Pages view

Site Pages library  386
Announcements list  54
Announcements XLV

creating  84–86
Append Task action  489
Application Options dialog box  16

applications
InfoPath 2010  309
Web  9

Apply Styles task pane  26, 350, 357
Apply Themes and Borders rights  41
Approval link (Start Approval Process 

action)  493–494
Approval page

creating approval processes  495–496
approval processes

content  433
creating  491–501

Approval page  495–496
Customization area  497
Settings area  496–497
Task Form Fields area  495
Task Outcomes area  496

outcomes  496
Approval template  251
Approval workflow  296

content pages  429
Approval workflow template  491

variables  493–494
Approval.xsn  491
Approve level  41
approvers  435
Approvers sections  302
Approvers variable  494
approving

page layouts  451–452
ARIA (Accessible Rich Internet Applications)  425
Article Page content type  442
artifacts  14
AspMenu control  477
ASP.NET

controls
IDs  467
validating user data entry  466–468
validation  468–470

forms
testing  475–476

master pages  368
server controls  460, 464–466
validation controls  468–470

ASP.NET pages
attaching master pages  134–136
creating  130–132
creating from master pages  391–395
inserting Web Part zones  132–135

.aspx files  268
assemblies  461

namespaces  461
Assets tab  341
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Assign a Form to a Group action  488
Assign a To-do Item action  488
assignment sections  302
assistive technologies  419
associating

content types  103–104
reusable workflows with lists  290–292

Association And Initiation Form Parameters dialog 
box  304, 316, 320

Association columns
creating  293–294

Association Columns dialog box  293, 294
association fields

adding to initiation forms  319–322
association forms  301–305

modifying  318–319
associations  237–242

associating workflows with libraries  254–258
cascading  238
fields  237–238
Microsoft Business Connectivity Services team  238
referential integrity  238

Association Wizard  239–243
Asynchronous JavaScript and XML (AJAX)  176
attaching

CSS files  340–343
page layouts  454–456

authentication
external data sources  212
SQL Server  176

Authentication section
SharePoint Foundation 2010  195

Authoring tab (Page Editor Options dialog 
box)  330

Auto Thumbnail
creating thumbnails  110

B
Backstage view  2, 13–16
BCS  5, 7, 207

business objectives  208
central administration  209
components  210
Connectivity area  209
Presentation area  209
Tools area  209
Web services  212

BDC (Business Data Connectivity)  209
BDC Identity authenticaton mode (BCS)  212
BDC Metadata Store  210, 231
BDC models

exporting  230–233

Behaviors task pane  26
best practices

accessibility  403
naming URLs  11–13
usability  403

Blank Master Page command  377
Blank Site, Blog template  13
Borders And Shading dialog box  323
branding sites  327

adding CSS to Code view  359–362
attaching CSS files  340–343
creating CSS files  340–343
creating HTML pages  344–345
creating styles  346–349
CSS inheritance  356–360
CSS reports  362–364
deleting styles  349–353
designing for accessibility  411–414
identifying CSS styles  333–338
identifying styles on content pages  339–342
modifying styles  349–353
Style Application group commands  353–355
text  328

breadcrumbs  15
browsers  4

accessing sites  52
compatibility  405–406
deleting workflows  285–287
editing Web content  110
inline editing  152–154
Internet Explorer

security settings  18
library tasks  71–75
list definitions  70
list settings  75
list tasks  71–75
settings

Web Part zones  132
starting site workflows  276–277
testing pages  114

Business Connectivity Services. See BCS
Business Data Catalog. See BCS
business data columns. See external data columns
Business Data Connectivity (BDC)  209
Business Data Related List Web Part  237

associations  237
business objectives

BCS  208
business processes

custom actions  89–95
solutions  5

buttons
Site Actions

master pages  369
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C
calculated columns  80–81, 163–165

XPath expressions  165–168
Calculated Value dialog box  320
Calculated Value Properties dialog box  320
CAML (Collaborative Application Markup 

Language)  188–190
CancelonChange variable  494
Capture a Version of the Document Set action  485
card sorting  409
cascading associations  238
cascading style sheets. See CSS
central administration

BCS  209
Central Administration Web site  8
Change Data Bindings dialog box  473, 474
Change Request setting  497
Change The Behavior Of A Single Task link  497
Change The Behavior Of The Overall Task Process 

link  499
Change The Completion Conditions For This Task 

Process link  497
Channel 9 Web site  313
characters

components  11
Check For Errors command  267
Check In dialog box  139, 446, 452
checking in/out

files  138–140
Check In Item action  486
Check Names icon  42
Check Out Item action  486
Check Reports task pane  363
child sites  9, 431

creating  45–48
site columns  94
style inheritance  356

Choose File to Upload dialog box  76
classes

CSS  331
client computer

requirements  xxv
client software

licenses  424
requirements  xxvi

Clip Art task pane  27
Clipboard task pane  27
closed Web Parts  119
Code view  20, 21, 25

adding CSS rules to  359–362
configuring with Page Editor Options dialog 

box  21–25
XSLT  165–168

Collaborative Application Markup Language 
(CAML)  188–190

Collect Data from a User action  267, 488
Collect Feedback template  251
Collect Feedback workflow  296
collections  9

administrators  32
content types

creating  98–100
creating  506–507
creating child sites  45–48
owners  32–33
publishing  40
Publishing feature (SharePoint Server)  431
root sites

creating globally reusable Approval work-
flows  296–298

creating globally reusable workflows  298–301
Site Collection Images library  434

Collect Signatures template  251
Collect Signatures workflow  296
Color Coding tab (Page Editor Options dialog 

box)  330
Color dialog box  413
colors

accessibility  411
testing  412–414

hexadecimal notation  412
themes  39

Column Editor dialog box  79, 80
columns  56

Association
creating  293–294

calculated
XPath expressions  165–168

calculated columns  80–81
external data  234
formula  163–165
list columns  77–79

deleting  105–106
lookup  472
metadata  77
site

adding to page layout content types  449–451
creating  94–96

site columns  96–98
adding to content types  100–101
creating  94–96

types
Pages library  438
publishing sites  443

validation  81–83
Columns Editor page  106
Column Settings dialog box  266, 303
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combining related data
Join option  197
Merge option  197

commands
Action  261
Advance Mode  25
Blank Master Page  377
Check For Errors  267
Create Profile Page  234
Custom Action  93
Data View  145
Data View Preview  149
Edit Document Template  58
From Content Type  377
Hyperlink  112
Initiation Form Parameters  258
Insert group (Workflow tab)  256
Manage group (Workflow tab)  256
Modify group (Workflow tab)  256
Move Down  264
Move Up  264
Quick Publish

publishing InfoPath forms  313–316
Reset To Site Definition  397
Save group (Workflow tab)  256
Style Application group  353–355
Variables group (Workflow tab)  256
Visual Aids  374
XML File Connection  183

comments
core actions  259

Common AdRotator Tasks panel  465
Common Content Task list  339
Common Content Tasks list  390
Common TextBox Tasks panel  467–469
Communications category  70
CompareValidator control  468
compatibility

browsers  405–406
testing  406–407

Compatibility Checker dialog box  406
compatibility requirements

UCD methodology  404–407
Compatibility task pane  27

testing site compatibility  406–407
compliance

accessibility legislation  423–426
third-party tools  425–426

Compliance Sheriff  425
components

BCS  210
characters  11

components, navigating  56
concat function  161

concept prototypes
creating  409

conditional blocks  260
conditional formatting

Data Views  154–157
hiding content  157–160
showing content  157–160
XLV Web Parts  154–157

Conditional Formatting task pane  26
Condition Criteria dialog box  155–156, 158
Condition dialog box  312, 321
conditions  481–482

Created By a Specific Person  482
Created in a Specific Date Span  482
If Any Value Equals Value  481
If Current Item Field Equals Value  481
If Task Outcome Equals Value  482
Modified by a Specific Person  482
Modified in a Specific Date Span  482
Person Is a Valid SharePoint User  482
The File Size in a Specific Range Kilobytes  482
The File Type Is a Specific Type  482
Title Field Contains Keywords  482

conditions (workflows)  258–264
creating  260–262
steps  273
Visio Premium 2010  283

Configuration Successful page  506
Configure Database Connection dialog box  194, 

195
Configure Editors tab (Application Options dialog 

box)  16
Configure External Content Type Profile Page Host 

dialog box  511
configuring

Code view
Page Editor Options dialog box  21–25

Design view
Page Editor Options dialog box  21–25

permissions
ECTs  510–511

settings
site collections  32–33

SharePoint Foundation 2010  504–507
Confirm Delete dialog box  105, 286
Confirm dialog box  390
Connection Properties dialog box  243
connections

creating  177–180
data

external systems  211
database  175, 192–198
data sources  5, 175–176

databases  175



526    connections

connections (continued)
ECTs

modifying  242–244
external data sources

Outlook  229–231
modifying  177–180
REST services  190–192
server-side scripts

RSS feeds  185–186
SOAP services  188–190
Web Parts  5, 202–205
XML files

RSS feeds  183–184
Connectivity area (BCS)  209
Connect To Outlook option  229
consumers

connecting Web Parts  202–205
Contact Office item type

mapping ECTs to  222–225
content

formula columns  163–165
hiding  157–160
showing  157–160

content approval processes  433
content creators  435
Content Editor Web Part (CEWP)

resetting  49
content pages

Approval workflow  429
content placeholders  387–391
creating  130–132
identifying styles on  339–341
linking with master pages  391–395

ContentPlaceHolder controls  367
managing  387–391

content placeholders
managing  387–391
master page controls  372
PlaceHolderBodyAreaClass  395
PlaceHolderQuickLaunchBottom  394
PlaceHolderQuickLaunchTop  394
PlaceHolderTitleAreaClass  395

content types  56, 438
adding document templates to  101–103
adding site columns to

  100–101
adding site columns to page layout  449–451
associating  103–104
creating  98–100
creating Association columns  293–294
defaults  56
Document  56, 57
ECTs

configuring permissions  510–511

external  56
page layouts  442–443
saving  103

Content Types gallery page  100
Content Types (list settings page)  71
Content Types Picker dialog box  104
[Content_Types].xml  278
Contribute level  41
controls  24, 459

AdRotator  464, 465
ASP.NET  460, 464–466

IDs  467
validating user data entry  466–468
validation  468–470

compared to Web Parts  459
CompareValidator  468
ContentPlaceHolder  367

managing  387–391
Controls group  460–463
CustomValidator  469
DataFormWebPart  148, 467
Data source  460, 464
Data View  472–475
EmbeddedFormField  24, 145

Data Views  144
field  434, 438, 439

adding to page layouts  447–449
Page Content  438
properties  447–449

HTML  460
Log In As  15
Login group  464
master pages  372–375

content placeholders  372
delegate  372
icons  372
links  372
menus  372
navigation components  372
scripts  372

namespaces  461
Navigation group  464
PlaceHolderMain (Custom)  454
properties  461
RangeValidator  469
RegularExpressionValidator  469
RequiredFieldValidator  466, 468, 469
server  476–479
SharePoint  460
SPDataSource  472, 473
SPDataSource SharePoint  152
Tag Properties task pane  460–463
validating user data entry  466–468
Validation group  464
ValidationSummary  469
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View  464
WebPartPages:DataFormWebPart  380
XsltListViewWebPart  145

Controls group
inserting controls  460–463
server controls  476–479

contros
WebPartPages:DataFormWebPart  382

converting
images  110

copying
libraries  74
lists  74
master pages  377–379

Copy List Item action  486
copyrights

sites  424
core actions  259, 483–484

Add a comment  483
Add Time to Date  483
Do Calculation  483
Log to History List  483
Pause for Duration  484
Pause Until Date  484
Send an Email  484
Send Document to Repository  484
Set Time Portion of Date/Time Field  484
Set Workflow Status  484
Set Workflow Variable  484
Stop Workflow  484

corev4.css  334
CSS inheritance  356–360
customizing  356, 356–360

Create a Content Type dialog box  99, 100
Create A Link To Data Services dialog box  232, 233
Create All Operations option  217
Create A Site Column dialog box  95
Create Column dialog box  235
Create Custom Action dialog box  91, 93
Create Custom Content link  339
Created By a Specific Person condition  482
Created in a Specific Date Span condition  482
Create External List dialog box  226
Create List Item action  486
Create List Or Document Library dialog box  72, 75
Create List Workflow_Shared Documents dialog 

box  255
Create New List Form dialog box  128
Create New List View dialog box  124, 226
Create Profile Page command  234
create, read, update, and display (CRUD)  216
Create Reusable Workflow dialog box  290, 297
Create Site Collection page  507
Create Site Workflow dialog box  276–277

Create Subsites rights  41
criteria

hiding content  157–160
showing content  157–160

CRUD (create, read, update, and display)  216
CSS  15

adding to Code view  359–362
classes  331
declaration blocks  331
files

attaching  340–343
creating  340–343

HTML tags  331
IDs  331
inheritance  356–360
properties  331
selectors  331
setting options  329–333
styles  331, 332–333

creating  346–349
deleting  349–353
identifying  333–338
identifying on content pages  339–341
inline  340–341
Manage Styles task pane  335
modifying  349–353
rules  335

testing usability  415–418
themes  40
value pairs  332

CssLink control  477
CSS Properties task pane  26, 339, 350, 351, 357
CSS reports  362–364
CSS Reports task pane  27, 364
CSS tab (Page Editor Options dialog box)  329
_cts folder

troubleshooting  102
Current Item link (Start Approval Process 

action)  493–494
Custom Action command  93
custom actions  89–96

LIM (list item menu)  89, 90–93
Rights Mask  90
sequence numbers  89–91
server ribbon  89, 93–95
uploading images to Site Assets library  90–93

Custom Actions (list settings page)  72, 91
custom activities  260
Customization area

creating approval process  497–499
Customization area (files settings page)  137
Customization area (Workflow Settings page)  257
Customization (list settings page)  71
customized files

resetting  49–52
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customized pages  21
customized sites

upgrading  51–52
customizing. See also modifying

corev4.css  356, 356–360
Data Views  149–152
libraries  4
lists  4
master pages  377, 379–385
sites  3

solutions  6
workflows

Start Approval Process action  493–494
XLV (XSLT List View) Web Part  86–87

Custom Lists category  70
CustomValidator control  469

D
dashes

URLs (Uniform Resource Locators)  13
data

combining related data
Join option  197
Merge option  197

connecting from external systems  211
grouping in Data View  149–152
importing  76–77
linked sources  197–201
retrieving

from external systems  211
sorting in Data View  149–152
XML

retrieving with server-script connections  185–
187

database
connecting to  192–198
connections  175

Database Interface Wizard  8
databases  5

external data sources
creating  211–215

SQL Server
BCS components  210
creating external data sources  212–215

SQL Server Compact Edition  229
tables

relationships  238
data connections  174. See connections
data entry

Data Views  152–154
validating  466–468

data entry forms
creating  469–471

Data Form Web Part  5
DataFormWebPart control  148, 467
Data Form Web Part (DFWP)  115

creating list form pages  126
Data group

controls  464
data integrity

column validation  81–83
Data Protection Act  424
data providers

connecting Web Parts  202–205
Data Retrieval Service  149
Data source controls  460, 464
Data Source Details task pane  26, 182, 467

error messages  192
viewing XML file content  180–182

Data Source Discovery Confirmation dialog 
box  243

Data Source Library task pane  173
Data Source Picker dialog box  146–147
Data Source Properties dialog box  178, 180–182, 

183, 184, 185–186, 188–190, 196, 198
data sources  174–179

connections  5, 175–176
databases  175

Consignments.xml  199
creating  173
creating data connections  177–180
database connections  192–198
ECTs

managing  242–244
external

authentication  212
connecting to Outlook  229–231
creating  211–215
exporting BDC models  230–233

external lists  176
libraries  175
linked sources  176, 197–201
lists  175
managing  173
modifying data connections  177–180
Products  199
REST services  176

connecting to  190–192
ExcelRest.aspx  190
ListData.svc  190

server-side scripts  176
SOAP services  176

connecting to  188–190
types  211
Web Parts

connecting  202–205
XML files  176
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Data Sources gallery page  173, 183–184, 186, 193, 
198

creating data connections  177–180
database connections  193
dynamically created definitions  177
modifying data connections  177–180

Data Sources Picker dialog box  173, 381
DataSourceTest.aspx page  183–184, 186, 193, 198
Data View command  145
Data View controls  472–475
Data View Preview command  149
Data Views  143

conditional formatting  154–157
creating  144–149
customizing  149–152
database connections  192–198
data entry  152–154
filtering  176
formula columns  163–165
grouping data in  149–152
hiding content  157–160
inline editing  152–154
linked sources  197–201
master pages  369
modifying text in  149–152
reusing  168–170
showing content  157–160
sorting data in  149–152
XSLT  144

Data View Web Part  5
Data View Web Part (DVWP). See also Data Views

adding to master pages  379–385
Date Source Details task pane  160
DDA (Disability Discrimination Act)  411
declaration blocks  331
Declare Record action  486
default master pages  367, 370–371

changing  385–386
global  370–371
global meeting workspace  370–371
minimal.master  370–371
publishing sites  371
v4.master page  370–371

default page  20
defaults

content types  56
Define E-mail Message dialog box  263
Define Workflow Lookup dialog box  273, 274, 305
definition pages

resetting  49–52
definitions (site)  9, 61
delegate controls  372
Delegate Task action  489
Delete Drafts action  486
Delete Item action  486

Delete Items rights  41
Delete Previous Versions action  486
deleting

CSS styles  349–353
ECTs  242–244
files  138–140
objects  105–106
practice sites  xxx
sites  48–49
Web Parts  115–119
workflows  285–287
Workflows library files  268

deploying
Web Parts  168–170
workflows  267–273, 269–274

descriptions (sites)
changing  38–40

Design Checker task pane  314
designers  435
Designers site group  32
Design level  41
Design view  20, 25

configuring with Page Editor Options dialog 
box  21–25

detaching
page layouts  454–456

DFWP (Data Form Web Part)  115
creating list form pages  126

dialog boxes
Accessibility Checker  421–422
Accessibility Properties  157
Add Column  293
Add Field  265, 303, 495
Add File To Import List  102, 360
Add Permissions  42
Advanced Grouping  150
Advance Sort  161, 162
All Operations  218, 220, 224
Application Options  16
Association And Initiation Form Parameters  304, 

316, 320
Association Columns  293, 294
Borders And Shading  323
Calculated Value  320
Calculated Value Properties  320
Change Data Bindings  473, 474
Check In  139, 446, 452
Choose File to Upload  76
Choose SPD SBS Customers—Webpage 

Dialog  236
Color  413
Column Editor  79, 80
Column Settings  266, 303
Compatibility Checker  406
Condition  312, 321
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dialog boxes (continued)
Condition Criteria  155–156, 158
Configure Database Connection  194, 195
Configure External Content Type Profile Page 

Host  511
Confirm  390
Confirm Delete  105, 286
Connection Properties  243
Content Types Picker  104
Create a Content Type  99, 100
Create A Link To Data Services  232, 233
Create A Site Column  95
Create Column  235
Create Custom Action  91, 93
Create External List  226
Create List Or Document Library  72, 75
Create List Workflow—Shared Documents  255
Create New List Form  128
Create New List View  124, 226
Create Reusable Workflow  290, 297
Create Site Workflow  276–277
Data Source Discovery Confirmation  243
Data Source Picker  146–147
Data Source Properties  178, 180–182, 183, 184, 

185–186, 188–190, 196, 198
Data Sources Picker  173, 381
Define E-mail Message  263
Define Workflow Lookup  273, 274, 305
Downloading Data  255
Edit  164
Edit Hyperlink  416, 475
Edit URL  181–183
Edit Variable  266
Export BDC Model  231
Export Select As  396
Export Workflow  281
External Content Type Rename Confirmation  217
External Content Type Selection  239
External Data Source Type Selection  214
File Save  231
Filter Configuration  220, 243
Filter Criteria  384
Find And Replace  28, 29, 375
Form Actions  474
Form Actions Settings  475
Import  181–183, 360, 416
Import Workflow From Visio Drawing  282
Included Fields  178
Insert Formula  164, 165, 166–168
Insert Formula And Condition  312
Insert Hyperlink  91, 113
Insert Picture  310
JobApplication—New Item  269–270
Join Subview  201

Lookup For Integer  274
Lookup For Person Or Group  262, 266
Lookup For String  262, 291
Manage Content Regions  388, 389
Match Content Regions  135–136, 478
Message From Webpage  448
Microsoft InfoPath  314
Microsoft Office Customization Installer  229
Microsoft SharePoint Designer  42, 43, 44, 113, 

396, 453
publishing process  269

Microsoft Visio  281
Modify Field  316
Modify Style  155, 157, 352
More Colors  412, 413
More Fields  383
New  46, 63, 386
New Link—Webpage Dialog  437
New List View  124
New Page  435
New Publishing Site  432
New Style  341, 347
New Web Part Page  392–396
Options  19, 22
Page Editor Options  20, 22, 111

Authoring tab  330
Color Coding tab  330
configuring Code view  21–25
configuring Design view  21–25
CSS tab  329
setting CSS options  329–333

Picture  157
Picture Properties  423
Please Wait  433
Problem Details  422
Profile Page Creation  235
Reset To Site Definition  50
Save As  314
Save Web Part To Site Gallery  169
Select A Connection Definition File  232
Select A Field Or Group  321
Select a Master Page  392
Select A Master Page  135
Select Style Sheet  342, 347
Select Task Process Participants  493
Select Users  262, 266
Select XML File  465
Server Error  195
Set Hyperlink ScreenTip  112
Shared Documents  118
Silverlight Web Part  116
Site Columns Picker  97, 101, 450
Site Definition Page Warning  390, 397
Site Settings  8
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Site To Load Templates From  432
Solutions Gallery: Upload Solution  xxviii
Sort And Group  124, 149, 161, 228
Split Cells  128
SQL Server Connection  214
String Builder  291, 306, 307
Text Box Properties  311, 319
User Account Control  507, 509, 510
Verify Hyperlinks  417
View  94
Web Part Zone Properties  133
Windows  461
Windows Security  44
Workflow Error  512
Workflow Errors Found  267–273
Workflow Form Update Required  317
Workflow Settings  513
Workflow Task  271
XPath Expression Builder  164

DIP (document information panel) settings  56
dirty pages  112
Disability Discrimination Act (DDA)  411
disabling

user-defined workflows  511–512
Discard Check Out Item action  486
DispForm.aspx  72, 126
displaying

settings page  54
Disposition Approval template  251
<div> tag  337

inserting Web Part zones  131
<div> regions

creating  344–345
DLLs  461
Do Calculation action  483
Document content type  56, 57
document information panel (DIP) settings  56
document set actions  259

Capture a Version of the Document Set  485
Send Document Set to Repository  485
Set Content Approval Status for the Document 

Set  485
Start Document Set Approval Process  485, 491

document templates
adding to content types  101–103

Don’t Attempt To Authenticate option (Data 
Source Properties dialog box)  185

Downloading Data dialog box  255
Dragon voice recognition software  420
drawings (Visio Premium 2010)

exporting workflows to  283–284
DVWP (Data View Web Part). See also Data Views

adding to master pages  379–385
dynamic-link libraries. See DLLs
dynamic Web Parts  115

E
ECM. See Enterprise Content Management
ECTs  5, 56, 176

associations  237–242
referential integrity  238

configuring permissions  510–511
connecting data  211
connections

modifying  242–244
creating  216–221

Microsoft Office applications  222–225
deleting  242–244
managing  242–244
Office applications  228–231
profile page host, configuring  511–512
profile pages

creating  233–237
retrieving data  211
saving  222
Summary view  216

ECTs (external content types)  209
Edit Browser List

expanding browsers  405
Edit dialog box  164
Edit Document Template command  58
EditForm.aspx  72, 126
Edit Hyperlink dialog box  416, 475
editing

inline editing
Data Views  152–154

pages
safe mode  21

site groups  43
editing links

adding to Data Views  152–153
editor page  20
editors  15
Edit template

inline editing  152–154
Edit URL dialog box  181–183
Edit Variable dialog box  266
Else branch (workflows)  273
e-mail

links  13
EmbeddedFormField control  24, 145

Data Views  144
enabling

site templates on server sites  507
user-defined workflows  511–512

End Task Process action  489
Enterprise Content Management  429
Enterprise Search Center site template  431
enterprise searches  38
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Enterprise Wiki Page content type  442
error messages

Data Source Details task pane  192
errors

reusable workflows  319
Escalate Task action  489
European Commission Directive on Data 

Protection  424
events

requesting publishing pages  439–440
Task Process Behaviors page  499–501

Excel
creating lists  72–74
importing data to create lists  76–77

exercises
practice files  xxvii–xxviii

Expense Approval association form  300
Expense Approval initiation form  301
Expenses settings page  101
Export BDC Model dialog box  231
exporting

BDC models  230–233
master pages  395–396
workflows to Visio drawings  283–284

Export Select As dialog box  396
Export Workflow dialog box  281
expressions

XPath expressions  165–168
Expression Web  8
eXtensible Stylesheet Language Transformations. 

See XSLT
External Content Type gallery page  213
External Content Type Information area  229
External Content Type Rename Confirmation 

dialog box  217
external content types. See ECTs
External Content Type Selection dialog box  239
External Content Type settings page  213
External Content Types gallery page  231

creating external lists  226–228
external data columns  234
external data sources

authentication  212
BDC models

exporting  230–233
connecting to Outlook  229–231
creating  211–215

External Data Source Type Selection dialog 
box  214

external lists  5, 176, 209
creating  225–228
managing  225–228

Outlook  229
SharePoint Workspace  228

external systems
associations  237–242
connecting data  211
retrieving data  211

Extract Substring from End of String  action  490
Extract Substring from Index of String action  490
Extract Substring from Start of String action  490
Extract Substring of String from Index with Length 

action  490

F
FAST Search Server

licenses  424
features  431

definition  40
SharePoint Server Publishing  40
SharePoint Server Publishing Infrastructure  40

field controls  434, 438, 439
adding to page layouts  447–449
Page Content  438
properties  447–449

fields
associations  237–238

adding to initiation forms  319–322
list columns  77–79
primary key  237

file formats
images  110

File Information area (files settings page)  137
files

Accessibility Report.htm  426
ADRotator.xml  464
AnnouncementsTitleBody.xml  178
.aspx  268
checking in/out  138–140
Consignments.xml  198
ConsolidatedMessenger.png  464
[Content_Types].xml  278
corev4.css  334
CreateDVWP.aspx  149, 161, 166–168
CSS

attaching  340–343
creating  340–343

customized
resetting  49–52

deleting  105–106, 138–140
LucernePublishing.png  464
practice  xxiii–xxiv

exercises  xxvii–xxviii
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restoring versions of  138–140
SBSSPDPracticeSite_Starter.wsp  177–180, 254–258, 

373
Shipments.xml  180–182
SilverlightSPDSBS.xap  115
SPDSBSPracticeSite_Starter.wsp

creating Data Views  145–149
Stock.aspx  154–155, 157–159, 164–165, 169–170
.vwi  278

exporting workflows  283–284
WebUIValidation.js  469
WideWorldImporter.png  464
workflow.vdx  278
workflow.xoml  278
workflow.xoml.rules  278
.wsp  60, 61

moving workflows between sites  283–284
saving reusable workflows as  294–295

WSP solution
creating sites from  xxix
removing  xxix–xxx
uploading  xxviii–xxix

XML  176
adding to Site Assets library  180–182
RSS feed connections  183–184

.xoml  268

.xoml.rules  268

.xoml.wfconfig.xml  268

.xsn  268
File Save dialog box  231
file settings page  137–138
Filter Configuration dialog box  220, 243
Filter Criteria dialog box  384
Filter Parameters page (Operations Wizard)  216
filters

Data Views  176
Find 1 task pane  26
Find 2 task pane  26
Find And Replace dialog box  28, 29, 375
Find Interval Between Dates action  490
Folder List task pane. See Navigation pane
folders

_cts
troubleshooting  102

_styles  358
TEMPLATE  9–10
Workflows library  268

fonts
Times New Roman  22

foreign key  238
Form Actions dialog box  474
Form Actions Settings dialog box  475

formatting
conditional

Data Views  154–157
hiding content  157–160
showing content  157–160

form pages
creating  125–129
modifying  125–129

forms
Approval.xsn  491
Approvers sections  302
ASP.NET

testing  475–476
association  301–305

modifying  318–319
collecting information from users on workflow 

startup  258
data entry

creating  469–471
Data Views  152–154
DispForm.aspx  72, 126
EditForm.aspx  72, 126
Expense Approval association  300
Expense Approval initiation  301
InfoPath  258

modifying  308–312
publishing  313–316
saving  313–316

initiation
adding association fields to  319–322
creating  301–305
modifying parameters  316–318
questions  302
retrieving values from  305–308

NewForm.aspx  72, 126
task

collecting information  495
modifying  322–323

Forms area  126
Forms area (Workflow Settings page)  257, 272
Forms (list settings page)  72
formula columns  163–165
Forward Task action  489
Foundation sites

searches  38
frame styles

Web Part zones  132
From Content Type command  377
Full Control level  41
functionalities

rating
SharePoint Server 2010  449–451

functions
concat  161
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G
galleries

All Files  121–123
List Template  70
Master Page  443
Mini  15
Page Layout  444
Site Assets

file settings page  137–138
Site Pages

file settings page  137–138
Theme  38
Web Part  5
Workflows  299

Gallery page  15
General tab (Application Options dialog box)  16
globally reusable workflows  253, 295–298

Approval workflow  296
Collect Feedback  296
Collect Signatures  296
creating  298–301
errors  319
WideWorldImporters Expense Approval

modifying task forms  322–323
global master pages  370–371
global meeting workspace master pages  370–371
graphics

Web Parts
inserting  110–114

Group Approval template  251
grouping

data in Data View  149–152
groups

Controls
inserting controls  460–463
server controls  476–479

Data
controls  464

Designers site  32
editing  43
Login

controls  464
Navigation

controls  464
Ribbon  14
Site Owners  32
Standard

controls  464
Validation

controls  464
Viewers site

preventing access to sites  41–43
Workflow tab  256

Group Work Site template  70

H
hexadecimal notation  412
Hide Content condition  159
hiding

content  157–160
hierarchies (sites)

creating  45–48
HiSoftware

accessibility/compliance tools  425
Home.aspx page

CSS Properties task pane  339
Manage Styles task pane  339

home pages
modifying  119–121

HTML
controls  460

HTML pages
creating  344–345

HTML tags
CSS  331
CSS styles  334
<div>  337
<p> tag  351

Hyperlink command  112
hyperlinks

Web Parts
inserting  110–114

Hyperlinks option  8
Hyperlinks task pane  27

testing usability  415–417
hyphens

URLs (Uniform Resource Locators)  13

I
IA (information architecture)

designing prototypes  408–411
testing usability  415–417

icons
hiding content  157–160
master page controls  372
showing content  157–160

identifying
CSS styles  333–338
styles on content pages  339–341

IDs
ASP.NET controls  467
CSS  331

If Any Value Equals Value condition  481
If Current Item Field Equals Value condition  481
If Task Outcome Equals Value condition  482
illegal characters

components  11
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images
converting  110
thumbnails  110
uploading to Site Assets library  90–93
Web Parts

inserting  110–114
Impersonate Custom Identity authenticaton mode 

(BCS)  212
Impersonate Windows Identity authenticaton 

mode (BCS)  212
impersonation steps

workflows  256
implementing

UCD (user-centered design) 
methodology  402–403

Import dialog box  181–183, 360, 416
importing

data  76–77
workflows from Visio Premium 2010  281–283

Import Visio workflows  254
Import Workflow From Visio Drawing dialog 

box  282
Included Fields dialog box  178
InfoPath 2010

applications  309
InfoPath Designer 2010  309

adding association fields to initiation 
forms  319–322

modifying InfoPath forms  309–312
InfoPath Filler 2010  309
InfoPath forms  258

modifying  308–312
publishing  313–316
saving  313–316

information architecture. See IA
inheritance

CSS  356–360
Inherit List Item Parent Permissions action  487
Initiation Form Parameters command  258
initiation forms

adding association fields to  319–322
creating  301–305
modifying parameters  316–318
questions  302
retrieving values from  305–308

inline editing
Data Views  152–154

inline styles  340–341
Insert Formula And Condition dialog box  312
Insert Formula dialog box  164, 165, 166–168
Insert group (Workflow tab)  256
Insert Hyperlink dialog box  91, 113
Insert Picture dialog box  310
Insert Task action  489

installing
SharePoint Foundation 2010  504–507

instances
removing  285–287
workflows  252, 252–253

IntelliSense
adding CSS to Code view  359–362

Internet Explorer
security settings  18

Internet Explorer Developer toolbar  334
Internet sites

themes
cascading style sheets  40

Issue Tracking list
creating  72–74, 74–76

J
JavaScript

master pages  369
JobApplication list settings page  269
JobApplication_New Item dialog box  269–270
JobApplicationWorkflow

creating workflows  260–262
Join option

combining related data  197
Join Subview dialog box  201

K
keyboards

testing user accessibility  419
keyboard shortcuts

switching between tabs  23

L
labels

MyPage.aspx  343
PlaceHolderSiteName (Master)  339

Layers task pane  26
layouts

Web Part zones  132
layout tables  8
legislation

accessibility  418–423
maintaining compliance  423–426

copyright  424
Data Protection Act  424
European Commission Directive on Data 

Protection  424
licensing  424
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legislation (continued)
Personal Information Protection and Electronic 

Documents Act (PIPEDA)  424
privacy laws  424
regulations  424

length
URLs (Uniform Resource Locators)  12

levels (permissions)
Approve  41
Contribute  41
Design  41
Full Control  41
Manage Hierarchy  41
Read  41
Restricted Read  41
View Only  41

LFWP (List Form Web Part)  126–130
libraries  4, 5, 14, 69. See also lists

associating workflows with  254–258
calculated columns  80–81

XPath expressions  165–168
content types

adding document templates to  101–103
adding site columns to  100–101
associating  103–104
creating  98–100

copying  74
creating  70–74

Wiki Page library  72–74
creating Association columns  293–294
data integrity

column validation  81–83
data sources  175
default settings, changing  76–77
formula columns  163–165
Pages  137, 438, 440–443

column types  438
removing workflows  285
security  88–89
Site Assets  137

adding XML files to  180–182
uploading images to  90–93

Site Collection Images  434
site columns  96–98

adding to content types  100–101
creating  94–96

Site Pages  137
All Pages view  386

tasks  71–75
wfpub

globally reusable workflows  296
workflows  5
Workflows  268–269

folders  268

XSLT List View (XLV) Web Part
creating  83–86

Libraries category  70
licensing  424
life cycles

user-centered design. See UCD methodology  402
LIM. See list item menu
Link Data Sources Wizard  199
linked sources  176, 197–201
links

Create Custom Content  339
Customization area  497–499
editing

adding to Data Views  152–153
e-mail  13
IA (information architecture)

testing usability  415–417
master page controls  372
Start Approval Process action  493

list actions  259
Add List Item Permissions  486
Check In Item  486
Check Out Item  486
Copy List Item  486
Create List Item  486
Declare Record  486
Delete Drafts  486
Delete Item  486
Delete Previous Versions  486
Discard Check Out Item  486
Inherit List Item Parent Permissions  487
Remove List Item Permissions  487
Replace List Item Permissions  487
Set Content Approval Status  487
Set Field in Current Item  487
Undeclare Record  487
Update List Item  487
Wait for Change in Document Check-Out 

Status  487
Wait for Field Change in Current Item  487

list columns  77–79
deleting  105–106

ListData.svc  190
List Form Web Part (LFWP)  126–130
List Information (list settings page)  71
list item menu

custom actions  89–93
lists  4, 5, 14, 69. See also libraries

associating reusable workflows with  290–292
calculated columns  80–81

XPath expressions  165–168
Common Content Tasks  390
content types

adding document templates to  101–103
adding site columns to  100–101
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associating  103–104
creating  98–100

copying  74
creating  70–74

importing data from Excel  76–77
Issue Tracking list  72–74, 74–76

creating Association columns  293–294
creating connections  177–180
data integrity

column validation  81–83
data sources  175
default settings, changing  76–77
deleting  105–106
external  176, 209

creating  225–228
managing  225–228
SharePoint Workspace  228

form pages
creating  125–129
modifying  125–129

formula columns  163–165
modifying connections  177–180
permissions

remapping  88–89
removing workflows  285
security  88–89
settings

checking in browsers  75
site columns  96–98

adding to content types  100–101
creating  94–96

tasks  71–75
view pages

creating  123–125
modifying  121–123
XLV Web Parts  121–123

workflows  5
XSLT List View (XLV) Web Part

creating  83–86
Lists And Libraries gallery page  105
list settings page  71–72

Custom Actions  91
List Template gallery  70
list templates  70–74
list view page

creating  226–228
list workflows  254

deleting  285
list workflow templates  250–251
Log In As control  15
Login group

controls  464
Log to History List action  483
lookup columns  472
Lookup For Integer dialog box  274

Lookup For Person Or Group dialog box  262, 266
Lookup For String dialog box  262, 291
Lookup Manager of a User action  488
LucernePublishing.png  464

M
Main Web Part zone  121
Manage Content Regions dialog box  388, 389
Managed Metadata Service (MMS)  56
Manage group (Workflow tab)  256
Manage Hierarchy level  41
Manage Lists rights  41
Manage Styles task pane  26, 335, 339
managing

ContentPlaceHolder controls  387–391
data sources  173
ECTs  242–244
external lists  225–228
permissions  41–44
task panes  27–31
users  41–44
Web pages  137–140

mapping
ECTs to Office item types  222–225
workflows with Visio Premium 2010  277–281

Master Page gallery  443
permissions  443

master pages  14, 368–376
adding CSS to Code view  359–362
ASP.NET  368
attaching  134–136
ContentPlaceHolder controls  367

managing  387–391
controls  372–375

content placeholders  372
delegate  372
icons  372
links  372
menus  372
navigation components  372
scripts  372

copying  377–379
corev4.css  356–360
creating  130–132, 376
creating web pages from  391–395
customizing  377, 379–385
Data Views  369
default  367, 370–371

changing  385–386
global meeting workspace  370–371
minimal.master  370–371
publishing sites  371
v4.master page  370–371
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master pages (continued)
exporting  395–396
global  370–371
identifying CSS styles  334–338
JavaScript  369
resetting to site definition  396–398
saving  377–379
Search box  369
Site Actions button  369
structure  369
style sheets  369
tags  369
testing usability  415–418
upgrading  393–395
v4.master  334

changing default master pages  385–386
copying  378–379
customizing  379–385
saving  378–379

visual aids  334, 374
Match Content Regions dialog box  135–136, 478
menus

master page controls  372
Merge option

combining related data  197
Message From Webpage dialog box  448
metadata

columns  77
Microsoft Business Connectivity Services team

associations  238
Microsoft client software

licenses  424
Microsoft Download Center

.NET Framework  250
Microsoft InfoPath dialog box  314
Microsoft Office applications

Access
creating linked tables  231–234

creating ECTs  222–225
ECTs  228–231

Microsoft Office Customization Installer dialog 
box  229

Microsoft PowerPoint
defining site relationships  408–409

Microsoft SharePoint 2010 Administrator’s 
Companion  503

Microsoft SharePoint 2010 Administrator’s Pocket 
Consultant,  503

Microsoft SharePoint Designer dialog box  42, 43, 
44, 113, 396, 453

publishing process  269
Microsoft SharePoint Foundation 2010 start 

page  506
Microsoft SharePoint Foundation 2010 Step by 

Step  503

Microsoft SharePoint Foundation Data Retrieval 
Service  174

Microsoft SharePoint Workflow  277–281
Microsoft Visio  5

defining site relationships  408–409
Microsoft Visio dialog box  281
Mini gallery  15
minimal.master page  370–371
MMS (Managed Metadata Service)  56
Modified by a Specific Person condition  482
Modified in a Specific Date Span condition  482
Modify Field dialog box  316
Modify group (Workflow tab)  256
modifying. See also customizing

All Items view  121–123
CSS styles  349–353
form pages  125–129
home pages  119–121
InfoPath forms  308–312
initiation form parameters  316–318
list view pages  121–123
page layouts  447–449
task forms  322–323
text in Data Views  149–152
Web Parts  115–119
workflows  264–267

Modify Style dialog box  155, 157, 352
more-accessible mode  419
More Colors dialog box  412, 413
More Fields dialog box  383
Move Down command  264
Move Up command  264
multistep workflows

creating  273–276

N
names

URLs (Uniform Resource Locators)  11–13
namespaces  461
navigation components

master page controls  372
Navigation group

controls  464
Navigation pane  7, 14, 52–53
navigation (site)

card sorting  409
defining  408–409

.NET Framework 3.0
SharePoint Designer  250

New button
creating subsites  46–47

New dialog box  46, 63, 386
new features  6–8
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NewForm.aspx  72, 126
New group

Lists and Libraries tab  70
New Link—Webpage Dialog dialog box  437
New List View dialog box  124
New Page dialog box  435
New Publishing Site dialog box  432
New SharePoint Site  13
New Style dialog box  341, 347
New Web Part Page dialog box  392–396
Nielsen, Jakob

usability checklist for designing 
prototypes  410–411

nodes  160
no-entry icon  24, 130
nonpublishing pages  130
NorthWind Customers list settings page  227
NotificationMessage variable  494

O
objects

BCS  210
deleting  105–106

Office applications
Access

creating linked tables  231–234
creating ECTs  222–225
ECTs  228–231

Office Fluent UI  3, 6
Office Sync For External List option  229
On Approval Canceled event (Task Process 

Behaviors page)  500
On Approval Completed event (Task Process 

Behaviors page)  501
On Approval Running event (Task Process 

Behaviors page)  500
On Approval Started event (Task Process Behaviors 

page)  499
one-to-many relationships

associations  237–242
OneVoice for Accessible ICT Coalition  403–404
Only Allow Task Recipients And Process Owners To 

Read And Edit Workflow Tasks setting  496
On Stage view  14–16

workspaces  18
On Task Assigning event  497
On Task Completed event  499
On Task Pending event  498
opening

Web sites in SharePoint Designer 2010  17
Open SharePoint Site  13
Operation Completed Successfully page  62–65

Operation Properties page (Operations 
Wizard)  216

Operations Design view  212
managing ECTs  242–244

Operations Wizard  216
Options dialog box  19, 22
organization

sites  4
outcomes

approval processes  496
Outlook

external lists  229
owners  435–436

site collections  32–33
site themes  38

P
Page Content field control  438
Page content type  442
Page Editor Options dialog box  20, 21–25, 22, 111

Authoring tab  330
Color Coding tab  330
configuring Code view  21–25
configuring Design view  21–25
CSS tab  329
setting CSS options  329–333

Page Layout And Site Template Settings page  508
Page layout designers  435
Page Layout gallery  444
page layouts  130, 430, 440–443

approving  451–452
content types  442–443
creating  442–447
detaching  454–456
field controls  434, 439
modifying  447–449
reattaching  454–456
restoring  453–454
testing usability  415–418

pages  20–25
Add A Workflow  299
All Files gallery  74
ASP.NET

attaching master pages  134–136
creating  130–132
creating from master pages  391–395
inserting Web Part zones  132–135

Columns Editor  106
Configuration Successful  506
content

content placeholders  387–391
identifying styles on  339–341
linking with master pages  391–395
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pages (continued)
Content Types gallery  100
CreateDVWP  145
Create Site Collection  507
customized  21
Data Sources gallery  173, 183–184, 186, 193, 198

creating data connections  177–180
database connections  193
dynamically created definitions  177
modifying data connections  177–180

DataSourceTest.aspx  183–184, 186, 193, 198
default  20
definition

resetting  49–52
dirty pages  112
editing

safe mode  21
editor  20
Expenses settings  101
External Content Type settings  213
External Content Types gallery  213, 231

creating external lists  226–228
field controls  438
Filter Parameters (Operations Wizard)  216
HTML

creating  344–345
JobApplication list settings  269
Lists And Libraries gallery  105
list settings  71–72

Custom Actions  91
list view

creating  226–228
managing task panes  27–31
master  368–376

ASP.NET  368
ContentPlaceHolder controls  367, 387–391
controls  372–375
copying  377–379
corev4.css  356–360
creating  376
creating web pages from  391–395
customizing  377, 379–385
default  367, 370–371
exporting  395–396
global  370–371
identifying CSS styles  334–338
JavaScript  369
resetting to site definition  396–398
saving  377–379
Search box  369
Site Actions button  369
structure  369
style sheets  369
tags  369

testing usability  415–418
upgrading  393–395
v4.master  334
visual aids  334, 374

Microsoft SharePoint Foundation 2010 start  506
nonpublishing  130
NorthWind Customers list settings  227
Operation Properties (Operations Wizard)  216
Page Editor Options dialog box  21–25
Page Layout And Site Template Settings  508
Parameters Configuration  223
Parameters (Operations Wizard)  216
PlaceHolderMain  21
profile

creating  233–237
publishing  130, 430

approvers  435
rating functionality  449–451
requesting  439–440

Remove Workflows  286
Reset Page To Site Definition Version  50
Return Parameter Configuration  241
Run Configuration Wizard  506
Service Applications  510
settings

displaying  54
Site Assets gallery  476
Site Content and Structure  45
Site Master Page Settings  371
site settings

views  20
System Master Page  371
Task Process Behaviors

events  499–501
testing  114
unghosted  21
viewing task panes  27–31
web

creating from master pages  391–395
Web Part

inserting Web Part zones  132–135
Web Parts  21

inserting hyperlinks  110–114
inserting images  110–114
inserting ScreenTips  110–114
inserting text  110–114
tables  131

Welcome  119–121
Welcome to SharePoint Products  506
Wiki  21

CreateDVWP  145
tables  131

Workflow Settings  257, 290, 292, 301
creating workflows  253–258
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Pages library  137, 438, 440–443
column types  438

parallel blocks (actions)  259
creating  260–262

parameters
initiation form  316–318

Parameters Configuration page  223
Parameters page (Operations Wizard)  216
parent sites

subsites
changing permissions  41–44

Pause for Duration action  484
Pause Until Date action  484
People Picker icon  42
permissions  8

Add And Customize
creating profile pages  234

ECTs  510–511
levels

Approve  41
Contribute  41
Design  41
Full Control  41
Manage Hierarchy  41
Read  41
Restricted Read  41
View Only  41

lists
remapping  88–89

managing  41–44
Master Page gallery  443
resources  44
rights

Apply Themes and Borders  41
Create Subsites  41
Delete Items  41
Manage Lists  41

subsites
changing  41–44

workflow impersonation steps  256
Permissions area (files settings page)  137
Permissions column  42
personal health information (PHI)  425
Personal Information Protection and Electronic 

Documents Act (PIPEDA)  424
personally identifiable information (PII)  425
personas

user requirement documents  404–405
Person Is a Valid SharePoint User condition  482
PHI (personal health information)  425
Picture dialog box  157
Picture Properties dialog box  423
PII (personally identifiable information)  425
PIPEDA (Personal Information Protection and 

Electronic Documents Act)  424

PlaceHolderBodyAreaClass content 
placeholder  395

PlaceHolderMain  21
PlaceHolderMain (Custom) control  454
PlaceHolderQuickLaunchBottom content 

placeholder  394
PlaceHolderQuickLaunchTop content 

placeholder  394
placeholders (content)

managing  387–391
PlaceHolderBodyAreaClass  395
PlaceHolderQuickLaunchBottom  394
PlaceHolderQuickLaunchTop  394
PlaceHolderTitleAreaClass  395

PlaceHolderSiteName (Master) label  339
PlaceHolderTitleAreaClass content 

placeholder  395
Please Wait dialog box  433
portal sites

themes
cascading style sheets  40

practice files  xxiii–xxiv
exercises  xxvii–xxviii

practice sites
deleting  xxx

Presentation area (BCS)  209
presentation layer

creating  460–463
preview functionality (SharePoint Designer)  406
Preview In Multiple Browsers option  347
primary key field  237
privacy laws

sites  424
Problem Details dialog box  422
processes

solutions  5
workflows  252

Products data source  199
Profile Page Creation dialog box  235
profile pages

creating  233–237
ECT host, configuring  511–512

Project Page content type  442
properties

controls  461
CSS  331

prototypes
designing  408–411

checklist  410–411
prototyping

solutions  5
<p> tag  351
publishing  40

InfoPath forms  313–316
workflows  267–273, 269–274



542    Publishing Approval template 

Publishing Approval template  251
Publishing feature (SharePoint Server)  431
publishing pages  130, 430

approvers  435
rating functionality  449–451
requesting  439–440

Publishing Portal site template  431
publishing sites

column types  443
creating  431–434
Page library  137
Pages library  438

Publishing site template
creating subsites  431–433

Q
questions

initiation forms  302
Quick Access Toolbar  14
Quick Publish command

publishing InfoPath forms  313–316
Quick Tag Selector  23

R
RangeValidator control  469
ranking content (searches)  38
rating functionality

SharePoint Server 2010  449–451
readability

URLs (Uniform Resource Locators)  12
Read level  41
Read List operation

changing filter criteria  242–244
Read List Wizard  243
Really Simple Syndication (RSS) feeds  176
Reassignment setting  497
Reassign Task action  489
Recent Sites  13
Redirect Page content type  442
referential integrity

associations  238
RegularExpressionValidator control  469
regulations  424
relational actions  260

Lookup Manager of a User  488
relationships

one-to-many
associations  237–242

tables  238

Remove List Item Permissions action  487
Remove Workflows page  286
removing

workflows  285–287
WSP solution file  xxix–xxx

Replace List Item Permissions action  487
reports

CSS  362–364
Reports, Navigation option  8
Representational State Transfer (REST)  190–192
Request a Change action  489
RequiredFieldValidator control  466, 468, 469
requirements

compatibility
UCD methodology  404–407

system requirements
client computer  xxv
client software  xxvi
server computer  xxvi–xxvii

user
personas  404–405
UCD methodology  404–407
usage cases  404
usage scenarios  404

Rescind Task action  489
Reset Page To Site Definition Version page  50
Reset To Site Definition command  397
Reset To Site Definition dialog box  50
resources

permissions  44
restoring

files  138–140
page layouts  453–454

REST (Representational State Transfer)  190–192
Restricted Read level  41
restrictions  8

SharePoint Designer 2010
at Web application level  508–509

REST services  176
connecting to  190–192
ExcelRest.aspx  190
ListData.svc  190

retrieving
data

from external systems  211
values from initiation forms  305–308

Return Parameter Configuration page  241
Return To The Workflow link  497
reusable workflows  254

associating with lists  290–292
creating  290–292
creating Association columns  293–294
errors  319
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globally reusable workflows  295–298
Approval workflow  296
Collect Feedback  296
Collect Signatures  296
creating  298–301

saving as .wsp files  294–295
ribbon  14

creating subsites  46–47
Ribbon group  14
rights

Apply Themes and Borders  41
Create Subsites  41
Delete Items  41
Manage Lists  41

Rights Mask
custom actions  90

root sites
creating globally reusable Approval 

workflows  296–298
creating globally reusable workflows  298–301

RSS feeds
connecting to XML files  183–184
server-side scripts  185–187

RSSLink control  477
RSS (Really Simple Syndication) feeds  176
rules

CSS
adding to Code view  359–362

CSS styles  335
HTML tags  334

workflows  258
Rules task pane  312
Run Configuration Wizard page  506

S
safe mode  21
Save As dialog box  314
Save group (Workflow tab)  256
Save This Username And Password In The Data 

Connection option (Data Source Properties 
dialog box)  185

Save Web Part To Site Gallery dialog box  169
saving

content types  103
ECTs  222
InfoPath forms  313–316
master pages  377–379
reusable workflows as .wsp files  294–295
sites  8
site templates  60–64

SBSSPDPracticeSite_Starter.wsp  177–180, 254–258, 
373

Schedule Web Analytics Alerts template  251
Schedule Web Analytics Reports template  251
screen-reader software

testing user accessibility  420
ScreenTips

Web Parts
inserting  110–114

ScriptLink control  477
scripts

master page controls  372
server-side

RSS feeds  185–187
Search box

master pages  369
searches

enterprise  38
ranking content  38

Section 508, Voluntary Product Accessibility 
Templates (VPATs)  418

secure sensitive information (SSI)  425
Secure Store Service (SSS)  211
security

Internet Explorer  18
libraries  88–89
lists  88–89
sites  41

Select A Connection Definition File dialog box  232
Select A Field Or Group dialog box  321
Select a Master Page dialog box  392
Select A Master Page dialog box  135
selectors

CSS  331
Select Style Sheet dialog box  342, 347
Select Task Process Participants dialog box  493
Select Users dialog box  262, 266
Select XML File dialog box  465
Send an Email action  484
Send a Task Notification Email action  489
Send Document Set to Repository action  485
Send Document to Repository action  484
Send Document to Repository category (core 

actions)  259
sequence numbers  89–91
serial actions (workflows)  259
server computer

requirements  xxvi–xxvii
server controls  476–479

AspMenu  477
ASP.NET  460, 464–466
CssLink  477
RSSLink  477
ScriptLink  477
SPCalendarNavigation  477
Theme  477
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Server Error dialog box  195
server ribbon custom actions  89, 93–95
server-side scripts  176

RSS feeds  185–187
server sites

enabling site templates  507
Service Applications page  510
services

REST  176
connecting to  190–192
ExcelRest.aspx  190
ListData.svc  190

SOAP  176
connecting to  188–190

Web
BCS  212

Set Content Approval Status action  487
Set Content Approval Status (as author) action  489
Set Content Approval Status for the Document Set 

action  485
Set Field in Current Item action  487
Set Hyperlink ScreenTip dialog box  112
Set Task Field action  489
Set Time Portion of Date/Time Field action  484
Settings area

creating approval processes  496–497
Settings area (Workflow Settings page)  257
settings page

displaying  54
Settings page  15
Set Workflow Status action  484
Set Workflow Status category (core actions)  259
Set Workflow Variable action  484
shapes

Visio Premium 2010  283
Shapes pane (Visio)  279
Shared Documents  54
Shared Documents dialog box  118
SharePoint 2010 Central Administration Web 

site  209
creating profile pages  233

SharePoint controls  460
SharePoint Designer

creating profile pages  233
SharePoint Designer 2010  1

cascading style sheet task panes  328
Compatibility task pane

testing site compatibility  406–407
creating workflows  253–258
Hyperlinks task pane

testing usability  415–417
.NET Framework 3.0  250
new features  6–8
preview functionality  406
restrictions at Web application level  508–509

versions  3
Web safe color palette

testing color accessibility  412–414
SharePoint Designer windows  47
SharePoint Foundation

permission levels  41
versioning  377

SharePoint Foundation 2010  1, 7
Authentication section  195
configuring  504–507
installing  504–507
libraries  70
lists  70

SharePoint Products and Technologies  3
SharePoint Products Configuration 

Wizard  506–507
SharePoint Server

permission levels  41
versioning  377

SharePoint Server 2010  1
creating profile pages  233–237
ECM  429
libraries  70
lists  70
Publishing feature  431
rating functionality  449–451
WCM  429
Web content management  430, 433–437

creating publishing sites  431–434
SharePoint Server Publishing feature  40
SharePoint Server Publishing Infrastructure 

feature  40
SharePoint Workflow Actions  277–281
SharePoint Workflow Conditions  277–281
SharePoint Workflow Terminators  277–281
SharePoint Workspace

external lists  228
Shipments.xml  180–182
shortcut keys

switching between tabs  23
Show Column Totals Per Group option  150
Show Content condition  159
showing

content  157–160
SilverlightSPDSBS.xap file  115
Silverlight Web Part dialog box  116
Site Actions button

master pages  369
Site Assets gallery

file settings page  137–138
Site Assets gallery page  476
Site Assets library  137

adding XML files to  180–182
uploading images to  90–93

Site Collection Administration section  33–34
Site Collection Images library  434
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site collections  9
administrators  32
content types

creating  98–100
creating  506–507
opening subsites  444
owners  32–33
publishing  40
Publishing feature (SharePoint Server)  431
root sites

creating globally reusable Approval work-
flows  296–298

creating globally reusable workflows  298–301
Site Collection Images library  434

site columns  56, 96–98
adding to content types  100–101
adding to page layout content types  449–451
content types

creating  98–100
creating  94–96

Site Columns Picker dialog box  97, 101, 450
Site Content and Structure page  45
site definition

resetting master pages to  396–398
site definition pages

resetting  49–52
Site Definition Page Warning dialog box  390, 397
site definitions  9, 61
Site Master Page Settings page  371
Site Owners group  32
Site Pages gallery

file settings page  137–138
Site Pages library  137

All Pages view  386
sites

accessibility legislation  418–421
accessing  52
branding  327

adding CSS to Code view  359–362
attaching CSS files  340–343
creating CSS files  340–343
creating HTML pages  344–345
creating styles  346–349
CSS inheritance  356–360
CSS reports  362–364
deleting styles  349–353
designing for accessibility  411–414
identifying CSS styles  333–338
identifying styles on content pages  339–342
modifying styles  349–353
Style Application group commands  353–355
text  328

child  9, 431
site columns  94
style inheritance  356

collections
creating child sites  45–48

components
navigating  56

controls  24
copyrights  424
creating  8–12

from site templates  61–64
from WSP solution file  xxix

customized
upgrading  51–52

customizing  3
solutions  6

deleting  48–49
descriptions  38–40
exploring  52–55
Foundation

searches  38
groups

editing  43
hierarchies

creating  45–48
home pages

modifying  119–121
IA (information architecture)

designing prototypes  408–411
licensing  424
maintaining  435–436
navigation

card sorting  409
defining  408–409

organizing  4
owners  435–436

themes  38
page layouts  430, 440–443

approving  451–452
content types  442–443
creating  442–447
detaching  454–456
modifying  447–449
reattaching  454–456
restoring  453–454

pages  20–25
practice

deleting  xxx
presentation layer

creating  460–463
privacy laws  424
publishing  40

column types  443
creating  431–434
default master pages  371
Pages library  438

regulations  424
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sites (continued)
root

creating globally reusable Approval work-
flows  296–298

creating globally reusable workflows  298–301
saving  8
searches

ranking content  38
security  41
server

enabling site templates  507
SharePoint sites compared to non-Sharepoint 

sites  3
subsites  9

changing permissions  41–43
creating  431–434
creating with Team Site template  9–10
opening in site collections  444

team. See team sites
templates  8

resetting  49–52
testing accessibility  418–421

Accessibility task pane  421–423
checklist  420–421
maintaining compliance  423–426

testing compatibility  406–407
themes

cascading style sheets  40
changing  38–40
colors  39
fonts  39

titles  38–40, 47
top level  9

Team Site template  45
URLs (Uniform Resource Locators)

modifying  39
variations  430
wideworldimporters  10

Site Settings dialog box  8
site settings page

views  20
site templates

ceating  61–64
creating child sites  45–48
enabling on SharePoint server sites  507
Enterprise Search Center  431
Publishing

creating subsites  431–433
Publishing Portal  431
saving  60–64
solutions  60
SPDSBS_Sites  63
Visio Process Repository  70

Site Templates  13
Site To Load Templates From dialog box  432

site workflows  254
creating  275–277

site workflow templates  251–252
SOAP services  176

connecting to  188–190
solutions  4, 5

creating sites  8–12
customizing sites  6
prototyping  5
saving sites  8
site templates  60
.wsp files  60

Solutions Gallery: Upload Solution dialog 
box  xxviii

solution WSP file
creating sites from  xxix
removing  xxix–xxx
uploading  xxviii–xxix

Sort And Group dialog box  124, 149, 161, 228
sort expressions

adding  161–163
sorting

data in Data View  149–152
SPCalendarNavigation control  477
SPDataSource control  152, 472, 473
SPD SBS Job Application workflow

creating initiation forms  303–305
modifying association forms  318–319
modifying initiation form parameters  316–318
retrieving values from initiation forms  305–308

SPDSBSPracticeSite_Starter.wsp
creating Data Views  145–149

SPDSBS_Sites site template  63
Split Cells dialog box  128
Split view  20
SQL Server

authentication  176
BCS components  210
creating external data sources  212–215
database connections  192–198
licenses  424

SQL Server Compact Edition  229
SQL Server Connection dialog box  214
SSI (secure sensitive information)  425
SSS (Secure Store Service)  211
Standard group

controls  464
Start Approval Process action  488, 491

customizing workflows  493–494
Start Custom Task Process action  260, 488
Start Document Set Approval Process action  485, 

491
Start Feedback Process action  488, 494
Start Options area (Workflow Settings page)  257, 

272
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static Web Parts  115
status bar  15, 23
statuses

visual aids  23
stencils

Shapes pane (Visio)  279
steps (workflows)  273
Stock.aspx  154–155, 157–159, 164–165, 169–170
Stop Workflow action  484
String Builder dialog box  291, 306, 307
Style Application group commands  353–355
styles

CSS  331, 332–333
creating  346–349
deleting  349–353
identifying  333–338
identifying on content pages  339–341
inline  340–341
Manage Styles task pane  335
modifying  349–353
rules  334, 335

_styles folder  358
style sheets

master pages  369
Style tab  341
subsites  9

creating  431–433
creating with Team Site template  9–10
opening in site collections  444
permissions

changing  41–44
Summary view

ECTs  216
managing ECTs  242–244

switching
between tabs  23

symbols
no-entry  130

System Master Page  371
system requirements

client computer  xxv
client software  xxvi
server computer  xxvi–xxvii

T
tables

layout tables  8
relationships  238
Web Part pages  131
Wiki pages  131

tabs
switching between  23

Tag Properties task pane  26, 468
inserting controls  460–463

tags
<div>

inserting Web Part zones  131
master pages  369
WebPartPagesSilverlightWebPart  116
XML  159–160

tags (HTML)
CSS  331
HTML

CSS styles  334
<div>  337

<p> tag  351
task actions  260

Assign a Form to a Group  488
Assign a To-do Item  488
Collect Data from a User  488
Start Approval Process  488, 491

customizing workflows  493–494
Start Custom Task Process  488
Start Feedback Process  488, 494

task behavior actions
Append Task  489
Delegate Task  489
End Task Process  489
Escalate Task  489
Extract Substring from End of String  490
Extract Substring from Index of String  490
Extract Substring from Start of String  490
Extract Substring of String from Index with 

Length  490
Find Interval Between Dates  490
Forward Task  489
Insert Task  489
Reassign Task  489
Request a Change  489
Rescind Task  489
Send a Task Notification Email  489
Set Content Approval Status (as author)  489
Set Task Field  489
Wait for Change in Task Process Item  489
Wait for Deletion in Task Process Item  489

Task Form Fields area
creating approval processes  495

task forms
collecting information  495
modifying  322–323

Task Outcomes area
creating approval processes  496

task panes  15, 26–31. See also individual names of
Accessibility  26
Apply Styles  26
Behaviors  26
Clip Art  27
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task panes (continued)
Clipboard  27
Compatibility  27
Conditional Formatting  26
CSS Properties  26
CSS Reports  27
Data Source Details  26
Find 1  26
Find 2  26
Hyperlinks  27
Layers  26
Manage Styles  26
managing  27–31
Tag Properties  26
Toolbox  26
viewing  27–31

Task Process Behaviors page
events  499–501

tasks
workflows  253

tasks lists
All Items view

modifying  121–123
Tasks section  270
team sites

adding editing links to Data Views  153–154
adding Web Parts  115–119
attaching master pages  135–137
changing home page  120–121
conditional formatting  154–155
creating ASP.NET pages  131–134
creating list form pages  126–129
creating list view pages  123–125
creating new pages  111–114
deleting Web Parts  115–119
hiding content  157–159
managing files  138–140
modifying All Items view  121–123
modifying Web Parts  115–119
showing content  157–159
XPath expressions  166–168

Team Site template  13, 45
creating subsites  9–10

Telerik
accessibility/compliance tools  425

TEMPLATE folder  9–10
templates  8

Blank Site, Blog  13
document

adding to content types  101–103

Edit
inline editing  152–154

Enterprise Search Center site  431
Group Work Site  70
list  70–74
Publishing Portal  431
Publishing site

creating subsites  431–433
resetting  49–52
site

ceating  61–64
creating child sites  45–48
enabling on SharePoint server sites  507
saving  60–64
solutions  60
Visio Process Repository  70

Team Site  13, 45
creating subsites  9–10

workflow  250–252, 252, 294–295
Approval  491, 493–494
list  250–251
site  251–252

testing
accessibility  418–423

Accessibility task pane  421–423
checklist  420–421
maintaining compliance  423–426

ASP.NET forms  475–476
color accessibility  412–414
pages  114
site compatibility  406–407
usability  414–417
workflows  269–274

text
branding sites  328
modifying in Data Views  149–152
Web Parts

inserting  110–114
Text Box Properties dialog box  311, 319
TheByCountry.aspx page  227
The File Size in a Specific Range Kilobytes 

condition  482
The File Type Is a Specific Type condition  482
Theme control  477
Theme gallery  38
themes

cascading style sheets  40
changing  38–40
colors  39
fonts  39

These Users link (Start Approval Process 
action)  493–494
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Untitled_1.aspx  461
Update List Item action  487
upgrading

customized sites  51–52
master pages  393–395

uploading
WSP solution file  xxviii–xxix

URLs (Uniform Resource Locators)  9
dashes  13
hyphens  13
length  12
modifying  39
names  11–13
readability  12
wideworldimporters  10

usability  401
best practices  403
checklist for designing prototypes  410–411
testing  414–417
UCD methodology

implementing  402–403
usage scenarios

user requirement documents  404
use cases

user requirement documents  404
User Account Control dialog box  507, 509, 510
user-centered design. See UCD methodology
user data entry

validating  466–468
user-defined workflows  249

disabling  511–512
enabling  511–512

user interfaces (UI)
accessing sites  52
Office Fluent  3, 6

user requirements
personas  404–405
UCD methodology  404–407
usage cases

  404
usage scenarios  404

users
managing  41–44

User’s Identity authenticaton mode (BCS)  212
Use Single Sign-On Authentication option  195
Use Single Sign-On Authentication option (Data 

Source Properties dialog box)  185
Use Windows Authentication option (Data Source 

Properties dialog box)  185
utility actions  260

third-party tools
accessibility  425–426
compliance  425–426

thumbnails  110
Times New Roman  22
title bar  13
Title Field Contains Keywords condition  482
titles

sites  47
Web Part zones  132

titles (sites)
changing  38–40

toolbars
Internet Explorer Developer  334

Toolbox task pane  26
server controls  476–479

Tools area (BCS)  209
top level sites  9

Team Site template  45
Tracking category  70
Translation Management template  251

U
UCD methodology

  402
accessibility legislation  418–421
compatibility requirements  404–407
designing prototypes  408–411
implementing  402–403
testing accessibility  418–421
testing usability  414–417
user requirements  404–407

UDC (Universal Data Connection)  177
UIs (user interfaces)

accessing sites  52
Office Fluent  3, 6

Undeclare Record action  487
unghosted pages  21
Unicode (UTF-8) language  22
Uniform Resource Locators (URL)

modifying  39
Uniform Resource Locators (URLs)  9

dashes  13
hyphens  13
length  12
names  11–13
readability  12
wideworldimporters  10

Universal Data Connection (UDC)  177
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V
v4.master  334, 370–371

changing default master pages  385–386
copying  378–379
customizing master pages  379–385
saving  378–379

validating
columns  81–83
user data entry  466–468
workflows  269–274

validation controls
ASP.NET  468–470

CompareValidator  468
Validation group

controls  464
ValidationSummary control  469
value pairs  332
values

retrieving from initiation forms  305–308
variables

Approval workflow template  493–494
Approvers  494
CancelonChange  494
DueDateforAllTasks  494
NotificationMessage  494

Variables group (Workflow tab)  256
variations  430
Verify Hyperlinks dialog box  417
Version History area (files settings page)  137
versioning

SharePoint Foundation  377
SharePoint Server  377

versions  3
View controls  464
View dialog box  94
Viewers site group

preventing access to sites  41–43
viewing

task panes  27–31
XML file content with Data Source Details task 

pane  180–182
View Only level  41
view pages

list
creating  123–125
modifying  121–123
XLV Web Parts  121–123

views
All Items

modifying  121–123
All Pages

Site Pages library  386
Approval.xsn form  491
Code  20, 21, 25

adding CSS rules to  359–362
configuring with Page Editor Options dialog 

box  21–25
XSLT  165–168

Data  143
conditional formatting  154–157
creating  144–149
customizing  149–152
database connections  192–198
data entry  152–154
filtering  176
formula columns  163–165
grouping data in  149–152
hiding content  157–160
inline editing  152–154
master pages  369
modifying text in  149–152
reusing  168–170
showing content  157–160
sorting data in  149–152
XSLT  144

Design  20, 25
configuring with Page Editor Options dialog 

box  21–25
On Stage  14–16

workspaces  18
Operations Design  212

managing ECTs  242–244
Split  20
Summary

ECTs  216
managing ECTs  242–244

Views (list settings page)  71
Visio 2010

workflows  7
Visio Premium 2010

actions  283
conditions  283
exporting workflows to drawings  283–284
importing workflows from  281–283
mapping workflows  277–281
shapes  283

Visio Process Repository site template  70
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visitors  435
visual aids  334

master pages  334, 374
status  23

Visual Aids command  374
voice recognition software

testing user accessibility  420
VPATs (Section 508, Voluntary Product Accessibility 

Templates)  418
.vwi file  278

exporting workflows  283–284

W
W3C (World Wide Web Consortium)  22, 403

colors  412, 418
WCAG (Web Content Accessibility Guidelines)  418

Wait for Change in Document Check-Out Status 
action  487

Wait for Change in Task Process Item action  489
Wait for Deletion in Task Process Item action  489
Wait for Field Change in Current Item action  487
WCAG (Web Content Accessibility Guidelines)  418
WCM. See Web Content Management
Web applications  9

restrictions of SharePoint Designer 2010  508–509
WebBots  8
Web browsers  4

accessing sites  52
compatibility  405–406
deleting workflows  285–287
editing Web content  110
inline editing  152–154
Internet Explorer

security settings  18
library tasks  71–75
list definitions  70
list settings  75
list tasks  71–75
settings

Web Part zones  132
starting site workflows  276–277
testing pages  114

Web Content Accessibility Guidelines (WCAG). 
See WCAG

Web Content Management  430, 433–437
creating publishing sites  431–434

Web pages
managing  137–140

Web Part Connections Wizard  202
Web Part gallery  5
WebPartPages:DataFormWebPart control  380, 382
WebPartPagesSilverlightWebPart tag  116
Web Parts

Business Data Related List
associations  237

closed Web Parts  119
compared to controls  459
connecting  5, 202–205
Content Editor Web Part (CEWP)

resetting  49
creating pages

inserting Web Part zones  132–135
Data

master pages  369
Data Form  5
Data Views  5, 143

conditional formatting  154–157
creating  144–149
customizing  149–152
database connections  192–198
data entry  152–154
filtering  176
formula columns  163–165
grouping data in  149–152
hiding content  157–160
inline editing  152–154
modifying text in  149–152
reusing  168–170
showing content  157–160
sorting data in  149–152
XSLT  144

deleting  115–119
deploying  168–170
DFWP (Data Form Web Part)  115

creating list form pages  126
DVWP (Data View Web Part). See also Data Views

adding to master pages  379–385
dynamic  115
hyperlinks

inserting  110–114
images

inserting  110–114
LFWP (List Form Web Part)  126–130
modifying  115–119
pages  21

tables  131
ScreenTips

inserting  110–114
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Web Parts (continued)
static  115
text

inserting  110–114
XLV  114

adding editing links to  152–153
conditional formatting  154–157
list view pages  121–123
reusing  168–170

XSLT List View (XLV)  83–88
creating  83–86
customizing  86–87

zones
Data Views  144
<div>  131
frame styles  132
inserting  132–135
inserting Web Parts into  132–135
layouts  132
Main  121
settings  132
titles  132

Web Part Zone Properties dialog box  133
Web safe color palette

testing color accessibility  412–414
Web Service Description Language (WSDL)  188
Web services

BCS  212
XML Web services  5

Web sites
Central Administration  8
Channel 9  313
opening in SharePoint Designer 2010  17
SharePoint 2010 Central Administration  209

creating profile pages  233
WebUIValidation.js  469
Welcome page  119–121
Welcome Page content type  443
Welcome to SharePoint Products page  506
wfpub library

globally reusable workflows  296
WF (Windows Workflow Foundation)  250
WideWorldImporter.png  464
WideWorldImporters Expense Approval globally 

reusable workflow
modifying task forms  322–323

wideworldimporters site  10
Wiki Page library

creating  72–74
Wiki pages  21

CreateDVWP  145
tables  131

windows
SharePoint Designer  47

Windows dialog box  461
Windows Security dialog box  44
Windows Server

licenses  424
Windows Workflow Foundation (WF)  250
wizards

Association  239–243
Database Interface  8
Link Data Sources  199
Operations  216
Read List  243
SharePoint Products Configuration  506–507
Web Part Connections  202

workflow
SPD SBS Job Application

modifying association forms  318–319
workflow editor  5

creating workflows  253–258
Workflow editor page

modifying workflows  264–267
Workflow Error dialog box  512
Workflow Errors Found dialog box  267–273
Workflow Form Update Required dialog box  317
Workflow Foundation (WF)  250
Workflow History section  270
Workflow Information area (Workflow Settings 

page)  257
workflows  5, 7, 14

actions  258–264
Collect Data from a User  267
core  259, 483–484
creating  260–262
Document Set Actions  259
List Actions  259
parallel blocks  259, 260–262
Relational Actions  260
serial  259
Start Custom Task Process  260
Task Actions  260
Utility Actions  260
Visio Premium 2010  283

activities  258
Approval

content pages  429
associating with libraries  254–258
collecting information from users on startup  258
conditions  258–264

creating  260–262
steps  273
Visio Premium 2010  283
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creating association forms  301–305
creating initiation forms  301–305
creating with SharePoint Designer  253–258
custom actions  89–93
custom activities  260
customizing

Start Approval Process action  493–494
deleting  285–287
deploying  267–273, 269–274
Else branch  273
exporting to Visio drawings  283–284
globally reusable workflows  253

  295–298
creating  298–301

impersonation steps  256
importing from Visio Premium 2010  281–283
Import Visio  254
instances  252, 252–253

removing  285–287
list  254

deleting  285
mapping with Visio Premium 2010  277–281
modifying  264–267
multistep

creating  273–276
processes  252
publishing  267–273, 269–274
removing  285–287
reusable  254

associating with lists  290–292
creating  290–292
creating Association columns  293–294
errors  319
saving as .wsp files  294–295

rules  258
shapes

Visio Premium 2010  283
site  254

creating  275–277
steps  273
tasks  253
templates  250–252, 252

list  250–251
site  251–252

testing  269–274
user-defined  249

disabling  511–512
enabling  511–512

validating  269–274
Workflow Settings dialog box  513

Workflow Settings page  257, 290, 292, 301
creating workflows  253–258
Forms area  272
modifying workflows  264–267
Start Options area  272

Workflows gallery  299
Workflows library  268–269

folders  268
Workflows (list settings page)  72
Workflow tab  256

Check For Errors command  267
Workflow Task dialog box  271
workflow templates  294–295

Approval  491
variables  493–494

workflow.vdx  278
Workflow Visualization section  270
workflow.xoml  278
workflow.xoml.rules  278
worksheets (Excel)

creating lists  72–74
importing data to create lists  76–77

workspaces  15
Code view  25
Design view  25
global meeting workspace master pages  370–371
On Stage view  18
Shared Documents  54
site settings page  20

workstations
conditions  481–482

Created By a Specific Person  482
Created in a Specific Date Span  482
If Any Value Equals Value  481–482
If Current Item Field Equals Value  481
If Task Outcome Equals Value  482
Modified by a Specific Person  482
Modified in a Specific Date Span  482
Person Is a Valid SharePoint User  482
The File Size in a Specific Range Kilobytes  482
The File Type Is a Specific Type  482
Title Field Contains Keywords  482

World Wide Web Consortium (W3C)  22, 403
colors  412
Web Content Accessibility Guidelines (WCAG)  418

WSDL (Web Service Description Language)  188
.wsp files  60, 61

moving workflows between sites  283–284
saving reusable workflows as  294–295

WSP solution file
creating sites from  xxix
removing  xxix–xxx
uploading  xxviii–xxix
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XPath expressions  165–168
XPath (XML Path Language)  160
XSLT  143, 160–163

adding sort expressions  161–163
Code view  165–168
Data Views  144
XML  160–163

XSLT editor
adding sort expressions  161–163

XsltListViewWebPart control  145
XSLT List View (XLV) Web Part  83–88

creating  83–86
customizing  86–87

.xsn  268

Z
zones (Web Parts)

browser settings  132
Data Views  144
<div>  131
frame styles

  132
inserting  132–135
inserting Web Parts into  132–135
layouts  132
Main  121
titles  132

X
XLV Web Parts  83–88, 114

adding editing links to  152–153
conditional formatting  154–157
creating  83–86
customizing  86–87
list view pages  121–123
reusing  168–170

XML  159–160
data

retrieving with server-script connections  185–
187

files  176
RSS feed connections  183–184

tags  159–160
XSLT  160–163

XML File Connection command  183
XML files

adding to Site Assets library  180–182
XML Path Language (XPath)  160
XML Web services  5

connecting to SOAP services  188–190
.xoml file  268
.xoml.rules file  268
.xoml.wfconfig.xml file  268
XPath Expression Builder

formula columns  163–165
XPath Expression Builder dialog box  164
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